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Becoming Familiar with Trimble® Business Center – Heavy 
Construction Edition (HCE) 

Welcome 
Welcome to the Trimble® Business Center – Heavy Construction Edition (HCE) Becoming Familiar with Business 
Center - HCE Module.  This module will walk you through the Business Center – HCE user interface, basic 
operations, and common settings. 
This guide was developed by Trimble Navigation’s Global Services Training and Support staff to support classroom 
instruction delivered by a Trimble Certified Trainer.  The Trimble Certified Trainer will use this guide to lead you 
through getting started with Business Center – HCE using real world exercises.  Please use this guide in conjunction 
with the Business Center - HCE help files and other product resources available. 

Overview 
Business Center - HCE is a powerful software tool used by professionals to make better project decisions, decrease 
costly mistakes, and increase efficiency in the office and on the job site.  The software is composed of different 
modules  that are purchased individually or as bundles, depending upon the needs of the user. 
Business Center - HCE is structured in projects that are equivalent to construction projects in the real world.  From 
bidding projects to planning construction throughout the construction phases, and  it is all handled in Business 
Center - HCE.  
You can prepare professional site earthworks and construction material quantity takeoffs quickly and accurately 
with expanded detail.  You can also convert digital CAD cross-sections, rapidly extract cross-section information 
from Adobe PDF vector files, and quickly see locations and quantities of materials for road take-offs.  Once the 
project has been awarded Buiness Center - HCE has tools which are used to create accurate, integrated 3D models 
for sites and corridors quickly and easily.  You can then effectively and seamlessly manage data between the 
office, Trimble® SCS900 Site Controller Software, and Trimble machine control systems.  All of these functions will 
be explained in more detail in later chapters.   
Using the mass-haul functionality, contractors now have powerful tools to analyze sites and define the optimal 
way to complete the work with the user-defined machine resources available.  Business Center - HCE also offers 
you the ability to generate reports and publish information to external applications for collaboration with the 
entire project team. 

Learning Objectives 
• Getting Started in Business Center 
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• Understanding the User-Interface 

• Setting up a New Project 

• Project-Specific Settings 

• System Settings 

• Importing Data 

Files Needed 
For the training exercises, you should save the following files provided by your Certified Trainer onto your PC and 
note the location.  

• Training Sample Data.dxf 

• Training Sample Points.csv 

Getting Started in Business Center - HCE 
Let’s get started, double-click the Business Center - HCE Icon  to launch the program. 

Start Page 
Upon launching Business Center - HCE you will by default be brought to the Start Page.   Alternatively, this screen 
is accessed via the Support tab on the ribbon.  Let’s observe the Start page and get familiar with the components 
of its user-interface.    

 

Ribbon Customization Options – the buttons allow you to 
quickly adjust the layout of the Ribbon for the operation you 
want to preform. 
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Business Center - HCE User Interface 

 

Quick Links – these buttons quickly allow you to get to 
useful information or preform quick operations. 

Documentation – allows you to get to some 
documentation quickly and easily; like the Read Me file, 
Release Notes, and Help System. 

Tours and Tutorials – will open an internet browser 
window with the links to all of the Training Videos, 
Tutorials, and Data Sets. 

Workflow Guides – allows you to get to all the workflow 
guides and workflow wizards quickly. 

YouTube – will take you to all the Business Center – HCE 
videos located on YouTube. 

Community Forum – will open an internet browser 
window to the Business Center – HCE Forum. 

Check for Updates – allows you to quickly check for 
updates. 
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Ribbon - this holds the commands relative to the workflow 
selected. 

 

Quick Access Toolbar - this toolbar holds the most 
commonly used commands, for one-click access. 

Note:  The Quick Access Toolbar can be shown above or 
below the Ribbon.  

 

Graphical View Window - data can be viewed in multiple 
view styles. 
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Ribbon Menu Layout  
The ribbon layout makes related commands more visible and convenient to use on theme-based or workflow-
based tabs.  Notice the tabs and the associated commands in the ribbon below.   In our case, we will be starting a 
new project.  By selecting the Project tab, we now have numerous commands at our disposal.  Each of these 
commands are associated with getting a project started.  Generally, users should complete commands from left to 
right within a ribbon to complete that workflow and this holds true here.  

 
Note:  You can right-click anywere on the ribbon to customize your ribbon and quick access toolbar, or to move 
the location of the quick access toolbar. 

Quick Access Toolbar 
The Quick Access Toolbar is located directly above the Ribbon by default.  It contains a collection of the most 
commonly used commands and is independent of the ribbon tab that is currently selected.  Users are urged to  

Pane View - selected commands are presented in pane 
views, allowing users to enter necessary values. 

 

Status Bar - vital project information is always displayed 
here. 
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customize the Quick Access Toolbar commands to suit their organizations needs.   In addition to customizing the 
command short-cuts, users also have the option of placing it above or below the ribbon. 

 

Customizing the Ribbon and Quick Access Toolbar 
The Ribbon and Quick Access Toolbar customization is easily accomplished.   The following exercise will 
demonstrate the flexibility that users have and how this function is completed. 

1. Right-click in the ribbon or the quick access toolbar. 

Note:  You will see the available options for ribbon and 
quick access toolbar customization. 

2.  Select Customize the Ribbon… 

 

3. Make sure the Customize Ribbon tab is selected at the 
top of the Options window. 

Note:  By selecting the appropriate tab in the upper left-
hand corner of the window you can customize both the 
ribbon and the quick access toolbar from this window.   

 

4. Select the  icon next to Reports to expand the 
Reports group. 

Note:  If the Project tab is not expanded under the Main 
Tabs list you can expand it by Double-clicking on it and 
all the groups of commands associated with that tab are 
displayed.  If you would like to create a new group this 
option is available as well.   
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5. Find Earthwork Report in the list of commands and 
left-click on it to select it. 

Note:  You will have to scroll-down the list to find the 
Earthwork Report but they are in alphabetical order.  
You may noticed two Earthwork Reports, select the 
upper one. 

6. Make sure Reports is selected in the Main Tabs. 

Note:  It should already be selected from left-clicking on 

the  icon from step 4 but if you have left-clicked on 
any other items under the Main Tabs list it may not be. 

7. Select the arrow button to move Earthwork Report 
into the Reports  group on the right. 

Note:  The Earthwork Report command is now added 
under Reports in the Project Tab. 

 

8. Select the Modify Item icon on the Earthwork 
Report (Custom). 

Note:  To further customize the newly added command 
you can use the following options. 

     Modify the Command 

 The Command is Visible 

   The Command is Invisible but still present 

    Deletes the Command from the Ribbon 
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9. After reviewing the options in the Modify the Tool 

window, select . 

Note:  You  can easily change the names of any 
commands  here.  You also have the option to add or 
change an image and its size. 

 

10. Select OK in the Options window. 

Note:  At the bottom of this window you have the ablity 
to Import, Export and Reset commands.   
Export - allows you to export your ribbon and quick 
access toolbar. 
Import - allows you to import a exported ribbon and 
quick access toolbar for your use. 
Reset - allows you to reset a select Ribbon or All 
Custimizations. 

 

11. Select the Project tab on the Ribbon. 

Note:  You will notice a small icon in the Reports area 
under the Project Tab.  If you put your curser over the 
icon, I box will popup explaining the icon.  You will notice 
that this is the Earthwork Report that we just added in 
the Options window. 
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Starting a New Project 
Now that we have familiarized ourselves with the layout of the user interface and the commands used in Business 
Center – HCE, let’s start a new project. 

1. Select the File tab on the Ribbon. 

Note:  The following menu becomes available.  Let’s 
briefly explain these options before proceeding. 

Save – saves the current project to the specified location 
with the current name. 
Save Project As – saves the current project to a new 
location and/or with a new name. 
Save Project As Template – saves the current project 
with all associated settings as a project template.  Layer 
names, styles, coordinate systems, and more are all 
saved as a template for future projects.   
Note:  You are urged to use this command, it is a big 
time saver! 
Open – brings up an Open File window so that you can 
navigate to an existing project to open it. 
Close – closes the currently opened project. 
Info – used to view the currently opened project’s  
properties.  Such as creation date, date last modified, 
description, and coordinate system summary. 
Recent – allows users to quickly navigate to recently 
opened projects. 

New – open a new project in Business Center – HCE. 
Print – print the current contents of the view window.  
You can also access print preview and page setup as 
well. 
Reports – access an array of reporting options for the 
current  opened project. 
Help – access numerous Business Center - HCE 
resources. 
Options – access the system setting options menu. 
Tools – access Business Center - HCE plug-ins and 
external tools. 
TCC – access the Trimble Connected Community cloud 
environment.   

Note:  Users must have a TCC subscription. 
Exit – Exit Business Center – HCE. 
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Understanding the Status Bar 
The status bar includes important project  information like the current units, an error flag indicator (indicating 
computation errors), the number of currently selected objects, and a coordinate display are always readily 
available in the lower right corner of the Business Center - HCE window. The Status bar has shortcuts to commonly 
used features 

2. Select New under the File tab. 

Note:  By default Business Center - HCE is installed with 
five templates and four of them are based on units.  You 
can add more Templates by using the Save Project as 
Template discussed earlier.  You can also select which 
Template is your default Template. 

3. Left-click on US Survey Foot to highlight it and select 
OK. 

Note:  A new project is opened using the units that were 
specified.  By default the Plan View window appears. 

 
 

1. Select the Toggle Background Color    icon to 
change the background color between black and 
white.  

Note:  Many find the black background easier on the 
eyes.  While the white background is useful to see how 
lines and colors will display in the field when exported to 
data collectors. 
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2. Select   to open the Running Snap Mode 
Options. 

Note:  This allows users to define how points and lines 
are selected with the cursor in the graphical view 
windows. 

Point - If a point object is inside the pick aperture, the 
coordinate of the point is used. 
End point -  If the end point of a line or arc segment is 
inside the pick aperture, the coordinate of the end point 
is used. 
Insertion point - If any part of a text or block object is 
inside the pick aperture, the insertion point of the object 
is used. 
Surface vertex - If the surface vertex is inside the pick 
aperture, the coordinate of the vertex is used. 
Free - The coordinate at the intersection of the cross 
hairs will be used.  

3. Select all but Insertion Point by left-clicking in the 
boxes to add or remove the checkmarks. 

4. Select . 

 

5. Select   on the status bar. 

Note:  The following Project Settings window now 
appears.  This allows you to change the units of the 
project, the unit formatting, and how units are displayed 
graphically.   

6. Select  . 

 
 

7. Select   on the Status Bar. 

Note:  The same Project Settings window opens but this 
time defaults to the Coordinate System. 

8. Select  . 
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9. Select the Compute Project Needed  icon if it is 
visible on the status bar. 

Note:  The Compute Project Button indicates that 
changes were made to the project that have not yet 
been recalculated and also appears if changes made to 
the data require that final coordinates for points be 
recalculated.  

Note:  The computation applies the changes made to all 
affected observations and determines the coordinates 
for points in the chronological sequence a surveyor 
would typically expect. If conflicting data is available for 
the computation of a coordinate, the software gives 
preference to higher quality data over lower quality 
data. 

10. The number to the right of the Compute Project 
Command indicates to the user how many objects are 
currently selected in the project. 

11. The Plan View Dimensions  icon indicates what 
coordinates are being displayed. 

Note:  When the icon is present it indicates that the 
coordinates displayed in the status bar are in reference 
to the XY dimensions of the current view window and if 
it is not present the coordinates displayed represent the 
true northing and easting of the current cursor location. 

 

12. Left-click on the box on the far right of the status bar. 

Note:  This opens the coordinate display window, that 
can be docked or remain floating. 

13. Right-click on the Coordinates box. 

Note:  These settings allow the user to indicate what 
values will be visible when the coordinate display 
checkbox is seleted.  The values relate to the current 
location of the cursor and must be used within the plan 
view. 

14. Left-click on the  icon in the Coordinates box or 
uncheck the far right box on the status bar to close the 
Coordinates box. 
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Project Options 
Project Options are system settings which means that changes made here take effect within all projects in 
Business Center-HCE.  Project Options are accessible via the File tab and selecting Options as shown earlier, or via 
the Project tab and selecting Options on the ribbon. 

1. Select  the Options  icon in the Option area 
under the Project Tab. 

Note: You can also get to options by selecting File 
and then .  

2. If not already selected, left-click on Startup and Display 
under the General folder to select it.   

Note:   Descriptions of each of the options under Startup and 
Display are outlined below. 

Starting State – Defines the state that Business Center - HCE 
opens in upon starting and your options are: 

No project 
Open last project 
Open project command 
Display start page 

Open a new default project 
Start Page – Defines what the start page will be if this was the option selected as the starting state. 
Recently-used file list – Number of recent project files that will be listed at the bottom of the File menu, 
allowing quick access. 
Close start pages on project startup checkbox -  Check this box to direct the start page to automatically close 
each time a new project is created or an existing project is opened. 
Display data tips – Describes entities under the cursor in the graphical view. 

Background color – Toggle the background color between black and white. 
Highlight color – Color that selected objects are displayed in. 
Cursor color  - Color that the cursor is displayed in. 
Line Marking Color – Color of line markers and labels so they are visible when shown over an image or 
surface. 
Pick Aperture – Determines the size of the cursor. 

Highlight Line Width – Determines the size of selected lines. 
Reverse Zoom Mouse Wheel – Determines how the mouse wheel zooms in and out. 
Fonts – Determines the type of font set utilized by Business Center – HCE. 
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3. Left-click on File Locations under the General Folder to 
select it. 

Note:  You can set the following folder locations to suit 
your organization’s needs.  The different folder location 
settings are explained below. 

Project Management Folder – Defines the folder 
location on the PC to be used as the default for saving 
new project files. 
Use Project Subfolders – Select this to automatically 
have the program organize project data in subfolders. 
Export Folder – This specifys where exported files are 
sent to from  Business Center - HCE .   
Download and Import Folder – This specifys where 
imported project files and imported field data is stored. 
Copy Imported Files to Import Folder – Select this 
checkbox to direct  Business Center - HCE to copy all files 
imported and store them in the appropriate project sub-
folder for easy reference. 
Template Folder – Specifies the folder location for 
project templates. 
Format Definition Folder – Specifies the folder location 
for exported format definitions. 

Note – A Format Definintion is used to create 
custom export format definitions that is utilized to 
export project data into text files.  The format 
definition defines the record type and the fields to 
be included in the export. 

Data Synchronization Area – This specifies the folder 
location that is used to synchronize data between field 
devices and the PC.  Office Synchronizer accesses this file 
and synchronizes files based on time stamps or file size 
(TCC).   

Note:  The default location is C:\Trimble 
Synchronizer Data\ 
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4. Left-click on Context Menu under the General Folder to 
select it. 

Note:   If you change this to five.  You will now see the 
five most recently used commands we have utilized 
when right-clicking anywhere in  Business Center - HCE. 

 

5. Left-click on External Services under the General Folder 
to select it. 

Note:  Business Center - HCE has the ability to integrate 
with external services such as Trimble Connected 
Community (TCC) and Bentley Project Wise.  Multiple 
profiles can be created in  Business Center - HCE .  User 
login data, server location, and folder locations are set 
in the External Services options.  Once set, users can 
open files remotely and save files remotely.  This allows 
for seamless collaboration with users anywhere in the 
world. 

• Service Profiles – Users select the TCC or Bentley 
Project Wise profile they have previously set up or 
elect to create a New profile. 

• New Profiles - Upon subscription to the TCC, 
ProjectWise, VisionLink, or other services available.  
Users are provided with a server address, user 
name, password, and a folder structure within the 
cloud service.  Enter this information after naming 
the new profile.  Upon completion, users can select 
Test Connection to verify they have a valid 
connection. 
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6. Left-click on Photogrammetry under the General 
Folder to select it. 

Maximum number of station views – This specifies 
the maximum number of station views  Business 
Center - HCE  will allow to be opened at the same 
time.  If this value is set high and multiple station 
views are opened at once, the users PC may 
experience memory usage issues. 
Pixel Picker Aperture – This value determines the 
size of the mouse cursor when measuring photo 
points on photo images. 
Display Pixel Picker in Grayscale – If checked,  
Business Center - HCE  will display the pixel picker in 
grayscale only. 
Dynamic Pixel Picker – If checked, the pixel picker is 
in dynamic mode.  This means the pixel picker is a 
magnifier with a reticle.  This enables users to 
dynamically select the precise location for a 
measurement.  If unchecked, the pixel picker is in 
static mode.  This means the user must left-click to 
open a magnified view of the slection and then 
select the precise location for a photogrammatery 
measurement. 
Station View Field of Vision Indicator – If checked, 
in the plan view a graphical indicator of the field of 
vision for each station view is displayed.  As the field 
of vision parameters are changed, these changes 
are indicated in the plan view. 

Indicator Color – Sets the color to use for 
the field of vision indicator in the plan view. 
Indicator Length – This value determines 
the projection distance the field of vision 
indicator is extended in the plan view.  It is 
set as a percentage of the projection 
distance. 
Indicator Transparency – This value sets the 
transparency of the field of vision indicator. 
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7. Left-click Point Clouds under the General Folder to 
select it.  

Note:  You can control the maximum number of points 
allowable for surface and volume applications.  More 
allowable points results in a more precise surface or 
volume, but at the expense of slower performance.  
Depending on the PC being utilized, these settings can 
be raised or lowered to find the optimal balance 
between preciseness and PC performance. 

 

8. Left-click on Images under the General Folder to select 
it. 

Note:  These options control how station view and 
georeferenced images are displayed in  Business Center - 
HCE .  These options are customizable to allow users to 
balance image resolutions with system performance. 

 

9. Left-click on Process Monitoring under the General 
Folder to select it.  

Note:  When processes such as surface creation, project 
clean-up, mass-haul analysis, etc. are being computed; 
these options specify various setttings that control the 
display of the process view tab. 
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10. Left-click on Network Device Port under the General 
Folder to select it. 

Note:  These controls allow the you to specify the port 
that you want to use to connect to a Trimble® Tablet.  
The port chosen needs to match the Trimble Tablet’s 
port settings.  The default port is 8000.  By checking the 
option for Keep TabletSnyc Always On, you can specify 
Business Center to always be listening for a connection 
request from a Trimble Tablet. 

 

11. Left-click on the Field Data folder in the Option 
window to select it. 

Note:  These settings direct Business Center were to look 
for field data file locations. 

Work Order Report Template - When viewing the work 
order results imported from a data collector, Business 
Center requires a report template to use in conjuction 

with the field data.  Select the  icon to open the 
Browse For File window, to select your Work order 
report template. 

Machine Control Configuration Files – You can Import 
measure-up(.mch) and display(.dsp) files into your data 
synchronization area to make them available for your 

machines using grade control systems.   Select the  
icon to open the Browse For Folder window, to select the 
folder for your Machine Control Configuration files. 
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Importing Data 
There are two ways that you can import data: 

• Using the Importer that is accessible on the Quick Access Toolbar or on the ribbon under the Project tab. 

• Dragging and dropping the file from the PC into the graphical view window of Business Center - HCE. 
Note:  You get full access to an array of settings by using the importer.  When dragging and dropping you lose 
access to these settings.  It is recommended that you utilize the Importer until you are familiar with different 
file types and how they can be manipulated.  These options will be described in more detail. 

1. Select the Import  icon in the Data area under the 
Project tab. 

Note: You can also select the Import  icon from the 
Quick Access Toolbar. 

 

 

12. Left-click on Takeoff folder in the Option window to 
select it. 

Note:  Settings here allow you to set preferences for a 
digitizer.  These settings enable you to customize the 
digitizer button profiles and specify auto-pan settings. 
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2. Left-click on Training Sample Data.dxf to highlight it. 

Note: You may have to use the   button to select the 
folder where the Training Sample Data.dxf file is saved on 
your PC. 

Note:  You can hide any files the importer does not 
recognize by selecting the Show only know file types   
icon.  Unknown file types are labeled as Unknown in the 
File Type column of the importer. 

Note:  CAD files import using the current project units. 

3. Ensure the box in front of the Close command after 
import is unchecked. 

 

4. Select  in the Import pane. 

Note:  You will now see the  icon in from of the file 
name, which shows that this file has been imported. 

 

5. Using Windows Explorer go to the folder where you 
have stored the Training Sample Points.csv file. 

 



Page | 26  
 

6. Drag-and-drop the Training Sample Points.csv into the 
Graphical View Window in Business Center - HCE. 

Note:  The Import Format Editor displays because the file 
is recognized as a points file.  You must now define the 
format of the points file so Business Center - HCE can 
properly import the data. 

Note: The file name is shown in the middle of the Import 
Format Editor. 

7. Select P, N, E, elev, Code (Control) in the Definition 
Name column. 
Note:  This is because we know our point file is defined in 
the order of  point id, northing, easting, elevation and 
then feature code.   

 

8. Select Import in the Import Format Editor. 

9. Select Close in the Import pane. 
10. Close the Windows Explorer window. 

 

Viewing imported data 
You can review imported data in one of the following ways: 

• Using the Project Explorer, which displays your data organized in a hierarchical tree structure.  

• Using the Properties pane, which lets you review and edit some of the attributes of objects.  

• Using a Spreadsheet view, which helps you check data by sorting and filtering on different criteria. 

• Graphically, by zooming and panning in the Plan View or 3D View.  

Utilizing the Project Explorer to View Data 
The Project Explorer is a great way to view your data in a organized hierarchical tree structure. 
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1. If the Project Explorer pane is not already displayed, 
you can left-click on Project Explorer in the Panes area 
on the Project tab. 

Note: You can also press [F9] on the keyboard. The 
project explorer displays docked on the left side of the 
screen.   

Note:  If required, click the  icon at the top of the pane 
to pin the explorer open. 

2. Left-click the  icon next to the Imported Files to 
expand the Imported Files. 

Note:  If you expand the Training Sample Points.csv, the 
list is very long.  So you will want to keep its list collapsed  
until you need to see it. 

Note:  You can click-and-drag the right edge of the 
Project Explorer pane to narrow or widen it. 

 

3. Right-click on Training Sample Data.dxf under Imported 
Files in the Project Explorer and select Select Members.    

Note:  All the members that comprise that file are now 
highlighted in the Plan View.  

 

Using the Properties Pane to View Data 
The properties pane is a great way to view all the data associated with a selected object, in an organized and 
logical fashion.  In addition to viewing data you can change the appearance of objects, the layer that an object 
resides on, the geometry of objects, and other pertinent information. 
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1. Right-click in the Graphical View Window and select 
Properties. 

Note:  You can also press F11 on the keyboard to display 
the Properties pane.   

2. Left-click on the Building Pad line in the plan view. 

Note:  The attributes with blue text are editable and the 
attributes that are greyed out are not.   

3. Double-click in the Name box and change the name of 
the object to Building Pad. 

 

4. Right-click the pane's title bar and select Floating.  

Note:  The pane becomes undocked, enabling you to 
move it anywhere on the screen or even onto a second 
monitor.  This is helpful when you have so much data in 
your project that you need more room for the graphical 
views.  

5. Right-click the title bar and select Floating to re-dock 
the pane. 
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Using the Spreadsheet View  

1. Select New Points Spreadsheet  icon in the 
Spreadsheets area under the View Tab. 

Note:  You can sort the points by clicking on the column 
heading that you would like to sort by. 

 

2. Find the Point ID 1093 and double-click in the box to the 
left of the Point ID column next to it.   

Note:  The row is selected and the properties for the point 
display in the properties pane. 

Note:  If you try editing the elevation in the Grid 
Coordinate group, you will discover that you cannot edit 
a point's elevation directly. You actually have to edit the 
coordinate object for the point.  
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3. Select the Add Coordinate  icon on the Property 
pane's toolbar . 

Note:  This allows you to add a new coordinate record for 
the point. 

4. Enter 462.25 in the Elevation box on the Add 
Coordinate pane. 

5. Select OK on the Add Coordinate pane. 
6. With the Point Spreadsheet selected in the graphical 

view, Left-click on the  icon to close it. 

 

 

Using the Plan View  
The Plan view is the default view for your project data.  It displays a graphical view from above, as in a map 
display.  Multiple plan views can be opened at the same time and the data that is visible is controlled by the View 
Filter Manager.   

1. Left-click on the View Filter Manager    icon to  
highlight it in the Panes area on the Project tab. 

Note:  You can also select the View Filter Manager  icon 
on the quick access toolbar to highlighting it.  If it is 
already highlighted you may have to click on the View 
Filter Manager tab at the bottom of the Pane view.   

Note:  If you close your plan view you can open a new one 
by selecting the New Plan View  icon on the Quick 
Access Toolbar. 
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2. Change the View Filter from All to My Filter.   

Note:  By default the All filter is locked and cannot be 
edited.  Once changed to My Filter you can edit layers 
and toggle them on and off. 

3. Left-click on the Points check box to remove the check 
mark and notice that the points disappear in the plan 
view. 

Note:  If the Layers group is collapsed, you can expand 
the Layers group by left-clicking on the  icon in front of 
Layers. 

4. Left-click on the Points check box to add the check mark 
and notice that the point data reappears. 

 

5. Zoom and Pan in the Plan View into a small area that 
includes points so that you can see individual points 
and their labels. 

6. Left-click on the Point tab near the bottom of the View 
Filter Manager.  

7. Left-click on the check box next to Show point labels to 
add a check mark. 

Note:  You can now see all the point IDs (names). You can 
also choose to see other information by the points by 
checking other boxes. 

Note:  None of the points are connected to surveyed 
baselines or vectors (processed baselines), so when you 
clear the Show disconnected points check box, all the 
points are hidden. 

8. Left-click on the check box next to Show point labels to 
remove the check mark. 

 

9. After exploring your data, left-click the Zoom Extents 

 icon in the Quick Access Toolbar to zoom back to 
the extents of the data. 

Note:  You can also left-click on the Zoom Extents  
icon in the Zoom area under the View tab. 

10. Left-click on the Points check box to remove the check 
mark.  
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Changing Layer Properties 
Notice that the building pad and parking lot are both blue.  We will need to change the colors of these to make it 
easier to visualy reconizes the different components of the Plan. 

1. Right-click the layer name OG_CON  in the View Filter 
Manager select Layer Options.  

Note:  The Layer Options pane opens with the selected 
layer being the OG_CON. 

Note:  The icons at the top of the Layer Options window 
allows you to create new layers, delete the current layer, 
and select all the members of the selected layer. 

Note: To prevent a layer from being deleted or renamed, 
change the Protected box to yes.  If you ever need to 
delete or rename the layer you can unprotect it in the 
future. 

2. Left-click the Layer color in the Layer Properties section 
and select Blue for the color. 

3. Left-click the Line Weight in the Layer Properties 
section and change it to .50 mm. 

4. Select  in the Layer Option pane. 

Note:   Notice that the line weight has now changed but 
not the color.   

 

5. Left-click the Zoom Extents  icon in the Quick 
Access Toolbar to zoom back to the extents of the 
data. 

6. Drag a box around all the data in the plan view to 
select it. 

7. Right-click in the graphical view and select properties. 
8. Double-click in the Color cell under Appearance in the 

Properties pane, and select By Layer at the top of the 
drop-down list. 

9. Select  in the Properties pane. 
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10. Left-click in an open area the graphical view to deselect 
all the items. 

Note:  The color has now changed to blue.  You can 
preform steps 5 through 9 at the beginning of a project 
so that the changes made to a layer or items added to a 
layer update instantly in the graphical view. 

 

Project Settings 
Use the Project Settings to set various parameters for your projects.  These include setting coordinate systems, 
units, computations, and views.  The setting are local to the specific project that is open and it is urged to save 
them into your organizations template.  At the start of a new project, it is recommended that you review project 
settings to ensure they match your real-world project.   

1. Select  in the Panes area under the 
Project tab. 

 

2. Left-click on General Information folder and enter 
information about your Project.   

3. Left-click on Company Information under the General 
Information folder and enter information about your 
company. 

4. Left-click on User Information under the General 
Information folder and enter information about the 
User. 

Note:  By completing this information, it is stored in the 
project and visible on future reports. 
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5. Left-click on Coordinate System in the left pane and 
review the defaults.  

6. Select  in the Project Setting window. 

 

7. Select  in the Change Coordinate 
System window. 

Note:  The Coordinate System Manager window will open 
and you can navigate through a series of options.  

8. Close the Coordinate System Manager window.   

9. Select  in the Change Coordinate System 
window. 

Note:  You should be back at the Project Settings window 
now.  

10. Left-click on the Units folder in the left pane. 

Note - Set these according to project specifications.  The 
following options are available: 
Coordinate - The order in which coordinates are 
displayed. 
Distance - The unit used to display distance. 
Angular - The type of angular units in the project. 
Azimuth - Whether the project is in the North or South 
Azimuth. 
Vertical Angle - Location of the slope ratio type. 
Pressure - The atmospheric pressure used. 
Temperature - Fahrenheit, Celsius, or Kelvin. 
GPS Time - Used to set the time zone for the project. 
Station - Specifies the style for Station formatting; 2 
digits, 3 digits, or none. 
Area / Volume - The assumed unit when displaying and 
evaluating areas or volumes. 

Note:  If you have time, explore the rest of the project 
settings folders on your own.  They are commonly used 
for more advanced projects. 
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11. Select  in the Project Settings window. 

 

 

Saving the Project as a Template 
A template can be used for future projects, to ensure that they follow customer specifications.  To do this, follow 
the workflow below. 

1. Left-click on the File tab and select Save Project as 
Template. 
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2. Enter a descriptive name in the Name field for the 
template.  

Note:  If you plan on using this project template as the 
default template for your company, select 

.  

3. Select  in the Save Project As Template 
window. 

Note:  The units and display format you set will be used in 
every project created with this template, and your user 
information can be included in every report you run using 
this template.  

4. Left-click on the File tab and select Close. 

Note:  You you save a project as a template you need to 
close or start a new project to avoid accidentally saving 
data in your template.  
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Data Preparation 

Welcome 
Welcome to the Trimble® Business Center – Heavy Construction Edition (HCE) Data Preparation Module.  This 
module incorporates tools to create high-accuracy linework and surfaces for stakeout, machine control, or takeoff 
calculations. The following procedures will teach you useful ways to clean up and prepare your data and create 
surfaces. 
This guide was developed by Trimble Navigation’s Global Services Training and Support staff to support classroom 
instruction delivered by a Trimble Certified Trainer.  The Trimble Certified Trainer will use this guide to lead you 
through the Data Preparation Module using real world exercises.  Please use this guide in conjunction with the 
Business Center - HCE help files and other product resources available. 

Overview 
This module will teach you how to import CAD data and how to clean up this data using both automatic and 
manual tools. It will also show you how to create surfaces from this data, and how to import a PDF and drape it 
over a surface for added context.  

Learning Objectives 
• Import CAD File 

• Automated Project Cleanup 

• Create and Edit CAD Data 

• Elevate Data  

• Create Surfaces 

• Edit Surfaces 

• Import PDFs 

• Add Images to Surfaces 

Data Preparation Commands Defined 
Project Cleanup – used during data preparation to automatically clean up your project data by removing 
unneeded objects, converting CAD lines into linestrings, joining lines, setting elevations on objects, and more. 
These optimizations can be done to selected objects or all of the objects in your project, but cleanup is most useful 
on imported CAD data. 
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Explode - Use the Explode command to break apart any objects that contain component objects that you want to 
move, modify, delete, or export individually. For example, you can explode a corridor to access the CAD points and 
polylines created from its corridor templates. 
Set Line Elevation - Apply a single constant elevation to a 2D line to make it a 3D linestring. You can also specify a 
vertical offset from the elevation that you enter and a surface to which the linestring will be added. 
Contour (Elevate) - Elevate a series of 2D lines representing surface contours by clicking one line at a time. The 
lines are elevated based on a specified starting elevation, increment direction, and contour interval. Typically, it is 
most efficient to elevate contour lines by their labels, and then elevate other contour lines by crossing before 
using this command. 
Contours by Crossing (Elevate)  - If your project contains zero-elevation or 2D lines that represent surface 
contours, you can quickly elevate them by crossing them with a line that applies elevations based on a specified 
starting elevation, increment direction, and contour interval.  
Contours by Label (Elevate)  - Use in-line elevation labels to quickly elevate 2D lines that represent topographic 
contours. The elevation is derived from the text of the label, not the elevation of the label. Lines with existing 
elevations are also elevated based on the label text. 
Lines (Elevate) - Elevate 2D and 3D lines using a variety of objects that either intersect or lay nearby them. The 
elevations of text labels and their leader lines, points, and intersecting lines can be used to create and elevate 
vertical points of intersection (VPIs) along the lines. 
Spot (Elevate) - To prepare for the Elevate Lines command, create 3D points near the lines you want to elevate 
from a variety of elevation spot indicators types and their label text. The points are created at the locations of the 
indicators and inherit the elevations of the text. 
Create Surface – Create a TIN (Triangulated Irregular Network) surface from the data created or imported in the 
project. 
Edit a Surface by Adding and Removing Members - Members are objects that are not part of a surface; they are 
simply used to define the surface. Edit a surface by adding to and removing from the set of members. As a result, 
the surface updates to reflect the changes. 
Drape an Image on a Surface - Use to overlay one or more georeferenced images onto a surface to visualize how a 
job site's features relate to its topography. Draping an image on a surface enables you to correlate image details 
with surface elevations. To do this, simply add a georeferenced image to a surface as a member. 
Create Breakline - Breaklines are simplified linestrings that help to define the shape of a surface as do other 3D 
line types that act as breaklines, by controlling how triangles in the surface mesh are formed. Triangles forming a 
surface never cross a breakline. Use breaklines of any type to more accurately reflect where surface topography 
changes. 
Trim Surface Edge - Clean-up the edges of surfaces in your project so that you can accurately calculate volumes 
when comparing surfaces. 
Surface Edge Breakline - Create a breakline on the outer edge of a surface when you want to prevent trimming or 
recalculated triangles on the current surface's edge. The edge breakline is added to the set of members that 
define the surface, and can subsequently be edited as a linestring. 
Surface Boundaries - Define the extents of a surface by adding or removing one or more boundaries. You can also 
create holes and islands within or outside of a surface by adding additional boundaries. 
Create a Linestring - Create linestrings (versatile single,multi-segmented linear, or curvilinear objects) to represent 
2D or 3D linear objects. 3D lines can be defined and queried entirely from within the Plan View, and they provide a 
unique and versatile way of establishing the line's elevation or its vertical alignment. You can create linestrings in 
this software, or you can convert imported lines such as CAD polylines into linestrings as you edit them. In creating 
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a linestring, you specify the location of each point along the line, and how the segments between them are 
formed. 
Create a Polyline - Create a multi-segment line at a constant elevation by either picking each segment's start and 
end points, or by streaming points (picking the polyline's start point, adding points as you hold down the button 
and move the cursor, and releasing the button at the end point). Polylines can only be created in the Plan View. To 
create or digitize a linestring that has multiple elevations, see Create and Edit a Linestring or Digitize a Linestring. 
Drape Objects - Use the Drape Objects command to vertically project points, and 2D or 3D lines onto a surface to 
create new 3D line geometry lying on the surface. For draped lines, the geometry is dependent on the location 
and shape of the originating line and the surface's topography. Draped points are dependent on the location of 
the originating points and the surface's topography. 
Markers are symbols that distinguish between horizontal segment end points, arc mid points, VPIs, and the overall 
line's start and end points.  

− Filled circles denote linestring start points 

− Filled triangles denote VPIs 

− Smaller square dots denote "point on curve" mid points on arcs 

− Smaller round dots denote segment end points 

− Hollow circles denote linestring end points 
Labels are annotations that indicate the elevation of vertical control points. 
You can also display or hide markers and labels for horizontal and vertical values along lines in 2D views to make 
viewing, understanding, and editing them easier. Select Project / Project Settings / View / Display Options / 
Marking and then set Line marking to Show.  

Files Needed 
For the training exercises, you should save the following files provided by your Certified Trainer onto your PC and 
note the location. 

• Data Prep.dxf 

• Office Park.pdf  

Importing CAD Files 
In this section, we will import a CAD file and prepare the data for further processing. This section covers import, 
data cleanup and CAD editing. 
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1. Open Business Center – HCE and Start a new project 
2. Select the template for US Survey Foot. 

3. Select the Import  icon in the Data area under the 
Project Tab. 

Note: You can also select the Import  icon from the 
Quick Access Toolbar. 

4. Left-click on Data Prep.dxf to highlight it. 

Note:  You may have to use the  button to select the 
folder where the Data Prep.dxf file is saved on your PC. 

Note:  You can also drag and drop the Data Prep.dxf into 
the graphics window to import the CAD data. 

 

5. Select  in the Import pane. 

6. Select  in the Import Pane. 

 

Automatic Data Cleanup 
1. Zoom and pan around your drawing to see what the 

data looks like. 

Note:  In this exercise the mistakes have been labelled so 
that you can find and examine them quickly. It is 
important to look carefully at each of the errors, so that 
you can find them in a real project in future. 

Note:  Many of these errors can be fixed using the 
automatic Project Cleanup tool in Business Center - HCE.  
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2. Select  in the CAD Data area on the Data 
Prep tab.  

Note:  The following menu becomes available.  Let’s briefly 
explain these options before proceeding. 

Objects to Process – Specify whether you want to clean up 
objects that are currently selected or all of you project data 

Entire project – Select this option to clean up the entire 
project. 

Include all Sheet Views -  Select this option to clean 
up all Sheet Views 

Current selection – Select this option to clean up just 
what is selected . 

Remove unused block definitions – Select this to delete all 
block definitions that no objects are referencing. 

Remove unused line styles - Select this to delete all line styles that are not assigned to lines. 
Remove unused text styles - Select this to delete all styles that are not being used by CAD text objects. 
Remove zero length and fragment lines - Select this to delete all lines that have a length less than the 
specified tolerance. 

Length tolerance - Specify the shortest allowable line length in the Length Tolerance box. 
Remove duplicate lines - Select this to delete redundant lines. One line out of each set of duplicates is 
retained. 
Remove overlapping line loops - Select this to break lines that overlap themselves into two separate 
linestrings. 
Remove unprotected layers with no objects - Select this to delete all empty unprotected layers. 
Join lines with small gaps, overlaps, and misalignments - Select this to merge two (and only two) lines that 
share an end point into one linestring. The lines must be on the same layer to be joined. 

Misconnection correction tolerance - Specify the distance within which the end points are considered to 
be the same point. 

Remove blank text objects - Select this to delete CAD text objects that contain no characters. 
Remove hatch objects - Select this to remove hatch objects used by other software programs. 
Filter line vertices - Select this to delete redundant points between two line segments where the point does 
not deviate from the previous segment's tangent by more than the specified tolerance. 

Include CAD splines - Select this to filter not only polylines, but also splines. 
Circle filtering radius - Specify the horizontal/radial distance that a node must deviate from the previous 
segment's tangent in order to be retained in the Cylindrical tolerance box. 

Elevation Range 
Set elevation outside range to undefined - Select this to set the elevation on all objects that fall outside 
of the specified elevation range to undefined (?) elevation. 

Minimum Elevation – Set the Minimum Elevation for your elevation range. 
Maximum Elevation –Set the Maximum Elevation for your elevation range. 
Scan for Elevation Range - Select this to find the elevation range of your data, the results appear in 
the Minimum elevation and Maximum elevation boxes. 



Page | 42  
 

3. Left-click on the Entire Project option under Object to 
Process to select it. 

Note:  The Objects to Process selection is useful if you 
are importing CAD data into a pre-existing projects. 

4. Select the following items: 
  Remove unused block definitions 
  Remove unused line styles 
  Remove unused text styles 

  Remove zero length and fragment lines 
  Remove duplicate lines 
  Remove overlapping line loops 
  Remove unprotected layers with no objects 
  Join lines with small gaps, overlaps, and 
misalignments 

  Remove blank text objects 
  Remove hatch objects 
  Filter line vertices 
 Set elevation outside range to undefined 

Note:  The tolerance settings should be kept small 
because if they are set too large they can change your 
correct data. 

5. Select  under the Elevation 
Range.  
Note:  This is a handy tool to see the range of your data.  

6. Double-click on the Maximum Elevation cell and 
change it to 600.  
Note:  This will change the elevation of the line labelled 
as Elevation Outside Range in the drawing.  

7. Select  to run the Project Cleanup. 
 Note:  Almost all of the mistakes could be fixed 
automatically by changing the Project Cleanup tool’s 
parameters.  However, this is not a good idea from a 
data integrity point of view. 
Note:  A status report will be shown on the right side of 
the window. This explains which data has been changed 
by the Project Cleanup tool. 
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8. Select  on the Project Cleanup window. 
9. Pan and zoom around the data to see what has 

changed.  
10. Delete the error label from any of the fixed errors. 

Note:  To delete the label, select it using either a box or 
left-click on an item to select it: 

a. Right click and select Delete.  
b. Browse to the Data Prep tab and choose delete. 
c. Select  from the Quick Access Toolbar 

Note:  The corrected errors in this example are: 

• Fragment Line 
• Duplicate 
• Small Gap 
• Too Many Vertices 
• Elevation Outside Range (check this one by 

looking at it in a 3D view) 
• Line Not Joined 

 

11. Left-click on File and select Save Project As. 
12. Enter a File Name and select the location you would 

likd to save the file. 

 

Manual Data Cleanup  
Now we will work through the remaining errors in the data using manual CAD editing. 

1. Pan and zoom until you can see the ??s at the top of 
plan view.  

2. Select the ??s and delete them. 
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3. Pan and zoom until you can see the Big Gap at the top 
of plan view.  

4. Select  in the Lines area under the Data 
Prep tab. 

 

5. Left-click on the Two lines option under Join to select 
it. 

6. With the curser in the Base Line cell, left-click on the 
line on one side of the gap to select it. 

7. With the curser in the Line to Join cell, left-click on the 
line on other side of the gap to select it. 

Note:  A warning box will appear once the second line is 
selected.  The warning will give you the distance 
between the end points of the lines and let you know 
that a segment will be added to join the lines.  

 

8. Select  to create the joining segment. 

Note:  You will now see that the two lines have been 
joint, eliminating the gap. 

9. Select  on the Join Lines pain. 

Note:  Do not delete the error text for now, we will do 
this in a future step. 

 

10. Repeat steps 3 through 9 for the Small Overlap Error. 

Note:  The line will look like a solid line when you zoom 
in on it, but when selecting it you will notice that it is 
two separate lines. 
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11. Select the Zoom Extents  icon in the Zoom area 
under the View tab. 

Note:  This will Zoom you out or in so that you have the 
entire project visible on the screen.  You can also select 
this from the Quick Access Toolbar by selecting the 
icon. 

13. Left-click on the yellow outer box around the project 
to select it. 

14. Right-click and select Properties. 

Note:  You can see that it is a CAD Polyline object. This is 
because it has been imported but not edited. Once any 
edits are performed it will change to a native Business 
Center Linestring object.  

15. Left-click on AOI in the Name cell and change it from 
AOI to Boundary.  

Note:  This will help us to identify the correct linework in 
the next error. 

16. Select  to exit the Properties pane. 

 

17. Pan and zoom into the Overlapping Line Loop error in 
the plan view. 

18. Left-click on the line near the point of the arrow. 

Note:  You will see that two options come up for the 
selection. Business Center – HCE does this when there is 
more than one object in the graphics area that was 
selected. Since we renamed the correct boundary, it is 
easy to see which is an overlapping line. 

 

19. Select the CAD Polyline [AOI]. 
20. Right-Click and select Delete. 

Note:  Do not delete the error text for now, we will do 
this in a future step. 
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21. Pan and zoom into the Missing Line error in the plan 
view. 

Note:  We can see that this is part of a building pad 
when you zoom-out. So not only do we have to fill in the 
missing piece, we also must join it into one shape for 
future processes.   

22. Select  in the Lines are under the 
Data Prep tab.  

23. Enter Building Pad in the name cell on the Create 
Linestring pane.   

24. Click the  icon at the end of the Layer cell and select        
<<New Layer>>.  

25. Enter the below values for the new layer.  
Layer name:  FD Building Pad  
Color:  Orange 
Line style:  Solid 
Line weight:  0.50mm  
Protect Layer:   

26. Then select   in the New Layer window. 

27. Select  in the Create Linestring pane. 

Note:  The Edit Linestring dialog now appears. This is 
where you can enter the geometry for the empty 
linestring that you have just created.  

 

28. Leave the Start Point Type as Coordinate and left-click 
in the Coordinate box. 

29. Right-click in the graphics view to display the snap 
options. 

30. Select End Snap. 
Note: If you were creating linestrings by joining 
imported survey points the start point type would be set 
to Point ID, allowing you to click between points to 
create your line. 
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31. Left-click on the line for the East side of the Building 
Pad. 

Note:  Once your curser is close to the line a red snap 
circle will be visible.  

Note:  Once you have selected the start point you will 
see a red line extending from the starting point of your 
linestring to your curser. 

Note:  If multiple lines are available when you click, 
check to see if two lines intersect at that point. If they do 
click either option, if not zoom in further until there is 
only one line shown.  

32. Right-click in the graphics view to display the snap 
options. 

33. Select End Snap. 
34. Left-click on the line for the North side of the Building 

Pad. 

Note:  There is now a line created between the two end 
points.  

35. Select  in the Edit Linestring pane. 

 

36. Select  in the Lines area under the Data 
Prep tab. 

37. If the new linestring you created is not already 
selected, make sure your curser is in the Base line cell 
and left-click on your newly created line.  

38. With the Curser in the Line to join cell, left-click on the 
other two lines of the building pad. 

39. Select  on the Join Lines pane. 

Note:  Do not delete the error text for now, we will do 
this in a future step. 
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40. Pan and zoom to the Boundary in the plan view. 

Note:  You can use the Zoom Extents to bring the whole 
project into view. 

41. Left-click on the boundary line to select it. 

42. Right-click in the graphical view and choose Offset 
Line. 

43. Enter Boundary Offset for Name of the Offset Line. 
44. Create a new layer for the Boundary Offset by entering 

the below values.  
Layer name:  Boundary  
Color:  Brown 
Line style:  Solid 
Line weight:  0.50mm  
Protect Layer:   

45. Select  . 

46. Enter 1 for the Offset distance. 
47. Select Left for the Side to Offset. 

48. Select  in the Offset Line pane. 

49. Select  in the Offset Line pane. 

 

 

50. Pan and zoom to the Trim Line error in the plan view. 

51. Select  in the Lines area under the 
Data Prep tab. 

52. Left-click on One Line to Bounding Line under Method 
to select it. 

53. Left-click on Trim under One Line to Bounding Line to 
select it. 

54. With the curser in the Bounding line cell, left-click on 
the inner yellow boundary to select it. 
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55. With the curser in the Line to trim or extend cell, left-
click on the line that sticks out past the boundary. 

Note:  As soon as you click the line it will be trimmed to 
the boundary line. 

56. Select  in the Trim/Extend Lines pane. 

Note:  Do not delete the error text for now, we will do 
this in a future step. 

 

57. Pan and zoom to the Block error in the plan view. 
58. Left-click on one of the two inner contour lines. 

Note:  Both contours will select, this indicates that it is a 
Block Reference. 

59. Right-click in the graphical view and select Properties. 

Note:  The Properties pane shows the selected contour 
lines as a CAD Block Reference. 

 

60. Select  in CAD Data area under Data Prep 
tab.  

Note:  You can also Right-click in the graphical view with 
the CAD Block Reference selected and select Explode. 

61. Make sure the Delete blocks after exploding is 
selected. 

62. Select  in the Explode pane. 

Note:  The contour lines are now two separate contour 
lines and the Explode pane has closed. 

63. Select  in the Properties pane. 
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64. Select the Advanced Select   icon in the Selection 
area, under the Edit tab. 

65. Unselect any currently selected lines by left-clicking in 
a open area in the graphical view. 

Note:  You can see how many items are currently 
selected under the Current Status in the Advanced 
Selection pane. 

66. Left-click on All data, and replace the current selection 
under Apply This Selection To to select it. 

67. Select CAD Multiline Text under the Data type drop-
down list in the Select section. 

68. Select Data with the following property in the Select 
section. 

69. Select Color in the Select Section. 
70. Select <> Not equals under That is in the Select section. 

71. Select  under This value in the Select 
section. 

72. Select  in the Advanced Selection pane. 

73. Select Current selection for Apply This Selection To. 

74. Repeat steps 62 through 69 for . 

75. Select  in the Advanced Selection pane. 

76. Select  in the Advanced Selection pane. 
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77. Right-click in the graphical view and select delete. 

78. Select Advanced Select  icon in the Selection 
area, under the Edit tab. 

79. Left-click on All Data and Replace the Current Selection 
under Apply This Selection To to select it. 

80. Select Linestring under the Data Type drop-down list. 
81. Select Data with the following property under the 

Select. 

82. Select Color under Select. 
83. Select = Equals under That is. 

84. Select By Layer under This value. 

85. Select  in the Advanced Selection pane. 

Note:   You will notice that all the Arrows Lines,Boundary 
Offset, and Building Pad are highlighted. 

 

86. Select  in the Advanced Selection pane.  

87. Hold down Control on the keyboard and left-click on 
the Boundary Offset and Building Pad to deselect 
them. 

88. Right-click in the graphical view and select delete. 

Note:  You will see all the arrow lines have been deleted 
but the arrow heads still remain. 

89. Hold down Control on the keyboard and left-click on 
each of the arrow heads to select them. 

90. Right-click in the graphical view and select delete. 
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Data Layering 
Now that we have cleaned up the geometry in our data we will now clean up the layer structure of the project. 

1. In the View Filter Manager check and uncheck the 
boxes in front of the individual layers to see where the 
data is stored. 

Note:   As you can see currently the data is not very well 
organized, this will make elevating lines and creating 
surfaces difficult.  

2. Right-click on any layer in the View Filter Manager and 
select Layer Options. 

3. Select the Create New Layer  icon to create a new 
layers.  

4. Create a new layer for the Original Ground by entering 
the below values. 

Layer name:  Original Ground  
Color:  Blue 
Line style:  Solid 
Line weight:  0.50mm  
Protect Layer:   

5. Select  . 

 

5. Create a new layer for the Finish Design Contours by 
entering the below values.  

Layer name:  FD Contour  
Color:  Red 
Line style:  Solid 
Line weight:  0.50mm  
Protect Layer:   

6. Select  . 

 



Page | 53  
 

6. Create a new layer for the Parking Lot by entering the 
below values.  

Layer name:  FD Parking Lot  
Color:  Green 
Line style:  Solid 
Line weight:  0.50mm  
Protect Layer:   

7. Select  . 

 

7. Create a new layer for the Sidewalk by entering the 
below values.  

Layer name:  FD Sidewalk  
Color:  Purple 
Line style:  Solid 
Line weight:  0.50mm  
Protect Layer:   

8. Select . 

9. Select  on the Layer Options pane.  

10. Select all the brown and magenta contours by holding 
down the control key and left-clicking on them.  

Note:  There are 17 original ground contour lines to 
select, and a couple of them on the far left side are small 
and easy to miss. 

11. Right-click in the graphical view and select Properties. 

12. Left-click in the Color cell and select By Layer from the 
drop-down list. 

13. Left-click in the Layer drop down and select Original 
Ground from the drop-down list. 

14. Select  in the Properties Pane. 
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15. Left-click in an open area in the graphical view to 
unselect the Original Ground Contours. 

Note:  You will now notice that all of the Original Ground 
Contours lines have change color and size. 

16. Uncheck the box in front of the Original Ground Layer 
in the View Filter Manager.  

Note:  You can now see that there is still some data such 
as contour labels which has not been moved.  

17. Select the remaining magenta labels by holding down 
the control key and left-clicking on them.  

18. Repeat Steps 10 through 13 for the Original Ground 
Contour Lables. 

 

19. Select the original Boundary and the Boundary Offset 
by holding down the control key and left-clicking on 
them. 

20. Right-click in the graphical view and select Properties. 
21. Left-click in the Color cell and select By Layer from the 

drop-down list. 

22. Left-click in the Layer drop down and select Boundary 
from the drop-down list. 

23. Select  in the Properties Pane. 
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24. Uncheck the box in front of the Boundary Layer in the 
View Filter Manager.  

25. Uncheck the box in front of the Building Pad in the 
View Filter Manager.  

26. Repeat steps 18 through 23 for the Finish Design 
Contours and Finish Design Contour Labels. 

27. Repeat steps 18 through 23 for the Finish Design 
Contours Labels. 

28. Repeat steps 18 through 23 for the Parking Lot. 
29. Repeat steps 18 through 23 for the Sidewalk. 

Note:  Now when looking at the pane view you will see 
some points.   

30. Select all of the points by dragging a box around them. 

31. Right-click in the graphical view and select Properties. 

32. Change the Layer to Points and select . 

33. Left-click on the check box next to Layers in the View 
Filter Manager to turn on all layers. 

Note:  You will know see that all the data has been 
colored and sized by the layers that they have been 
assigned to. 

 

 

34. Select  in the CAD Data area on the 
Data Prep tab. 

35. Select  in the Project Cleanup window. 

Note:  We are preforming the Project Cleanup to get rid 
of any layers that have no data and any errors from the 
manual cleanup.  The errors are from the CAD block that 
we exploded earlier.  

36. Select  in the Project Cleanup window. 
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Elevating Data 
In this section we will elevate the data and then create surfaces from the elevated data. This section covers 
contour elevation, line elevation, surface creation, surface editing, PDF import, and image draping. Using the 
information provide in the data, we can now elevate the data so that it can be used to create surfaces. 

1. In the View Filter Manager turn off all the layers 
except for the Original Ground layer. 

Note:  The Major Contours are labeled with an elevation 
and they are in 5’ increments. 

Note:  There are four Minor Contours between the 
majors, so the contours are on a 1’ spacing. 

 

2. Select the Elevate Contour  icon, in the 
Elevate area under the Data Prep tab. 

 

3. Enter 5 for the Contour interval in the Elevate Contour 
pane. 

Note:  We are going to elevate the Major Contours first 
so we inter the interval between majors, which is 5’. 

4. Select Up for the Increment direction. 

Note:  We are going to start on the left side of the plan 
and work to the right, so the elevation numbers go Up 
from left to right. 

Note:  It is good practice to start at one side of the site 
and work across when elevating contours. 

5. Select Increment after each selection by placing a 
check mark in its box. 

6. Enter 460 in the Current elevation box in the Elevate 
Contour pane. 
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7. With the curser in the Contour line cell, left-click on 
the 460 Contour line the the graphical view. 

Note:  You will notice after clicking on the 460 contour 
line that the Current elevation will read 465 and there is 
a note that says The contour was elevated to 460.000 ft. 

8. Left-click on the 465 Contour line in the graphical view. 

9. Left-click on the 470 Contour line in the graphical view. 

10. Select  in the Elevate Contour pane.  

11. Select the Display Options tab in the View Filter 
Manager. 

12. Select Display in alternate color under Zero Elevation 
Display Options and select  for the 
Alternate color. 

Note:  You will now notice that the only blue lines are 
the Major Contours that you have just elevated. 

 

13. Select the Elevate Contours by Crossing icon 

 in the Elevate area under the 
Data Prep tab. 
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14. Select Automatic for the Elevate Method by putting a 
check mark in its box. 

Note:  You have to have at least two elevated contours 
to use the Automatic Elevation Method. 

15. With the curser in From: cell, left click in the graphical 
view just to the left of the 460 contour line. 

16. Left-click just to the right of the 465 contour line in the 
graphical view. 

Note:  You have to cross at least two elevated lines to 
beable to elevate the unelevated lines. 

Note:  You will now see four contours have been 
elevated and will turn blue. 

 

17. Elevate the rest of the contour lines using steps 15 and 
16. 

Note:  You have to cross at least two elevated lines.  
They can either be right next to each other or have 
unelvated lines between them. 

18. Select  in the Elevate Contours by 
Crossing pane. 

19. Select one of the elevated contours by left-clicking on 
it in the graphical view. 

20. Right-click in the graphical view and choose Properties. 

Note:  You can check that you elevated the contours 
correctly by looking at their Elevation.  Left-click on 
other lines to check their elevations also. 

Note:  On larger plans you may want to check your 
elevations occasionaly while elevating so that you do 
not get off on the elevations. 
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21. Left-click on the 460 text in the graphical view. 
Note:  You will notice that none of the Major Contour 
Text is elevated. 

22. Left-click in the Elevation cell and enter 460 and hit 
enter on the keyboard. 

Note:  You have now elevated the 460 text item. 

23. Repeat steps 21 and 22 for the other two Major 
Contour Text. 

24. Select  in the Properties pane. 

 

25. Select the New 3D View  icon in the Graphic Views 
area on the View tab. 

Note:  You can also select the New 3D View  icon in 
the Quick Access Toolbar to bring up a 3D View. 

 

26. Turn on all the layers in the View Filter Manager. 

27. Pan and Zoom around in 3D View. 

Note:  You can see that all the Original Ground Contours, 
Contour Labels, and the Parking Lot have been elevated. 
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28. Turn off layers except for FD Contour in the View Filter 
Manager. 

29. Select the Plan View tab at the top of the Graphical 
view. 

 

30. Elevate the FD Contours in the same way as you did 
with the Original Ground Contours. 

Note:  The interval distance between contours are 
different on the FD Contours.  As you can see from the 
Contour Labels, there is 2’ between contours. 

Note:  Becareful when using Contours by Crossing 
around the retention pond.  You will either want to cross 
going into the bottom or cross from the bottom out. 

Note:  Once all FD Contours are elevated you can check 
them by using properties like we did with the Original 
Ground contours or by viewing them in 3D View. 

 

31. Turn on the FD Building Pad and FD Sidewalk in the 
View Filter Manager. 

32. Select  in the Elevate area under the Data Prep 
tab. 

 

33. With the curser in the Line: cell under Elevation in the 
Set Line Elevation pane, left-click on the Building Pad.  

34. Enter 467’ in the Elevation cell and hit enter on the 
keyboard. 

Note: As there is no text showing the elevation inside the 
building pads, we cannot use the Elevate Pads 
command.  

35. Left-click on the Sidewalk. 

36. Enter 467’ in the Elevation cell and hit enter on the 
keyboard. 

37. Select  in the Set Line Elevation pane. 
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38. Turn on all the layers in the View Filter Manager. 
39. Pan and Zoom around in Plan View and 3D View. 

Note:  Everything except for the Boundary should be 
elevated.  If there is something not elevated, you will 
need to repeat the steps from earlier to elevate it. 

Note:  The Boundary does not need to be elevated. 

 

 

Creating and Editing Surfaces  
Now that the data in our project is elevated, we can now create surfaces. 

1. Turn off all the layers except Original Ground in the 
View Filter Manager. 

2. Select  in the Surfaced area under 
the Data Prep tab. 

 

3. Enter Original Ground in the Name cell. 

4. Select Original as the Surface classification. 
5. Select all of the Original Ground Contours by dragging 

a box around them in the graphical view. 

Note:  You should only have 17 items selected.  If you 
have more it is because you have selected the Contour 
Labels.  You can hold down control on the keyboard and 
left-click on each of the Contour labels to unselect them. 

Note:  You could create and move the labels to an 
Original Ground Text layer.  That way you will not 
accentually use them in the creation of a surface.  
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6. Select  to create the surface and exit the 
Create Surface pane. 

Note:  As you can see, the surface has not been created 
all the way to the edge of the project. We will need to 
add a boundary to create a clean surface edge. 

 

7. Turn off all the layers and surfaces except for the FD 
Contour in the View Filter Manager. 

8. Select  in the Surfaces area under 
the Data Prep tab. 

 

9. Enter Design in the Name cell. 
10. Select Design in the Surface classification drop-down. 
11. With the curser in the Members to form surface cell, 

select all the Finish Design Contours in the graphical 
view. 

Note:  Make sure not to select the two Finish Design 
Contour Labels. 

  

12. Select  in the Create Surface pane. 

Note:  The Surface was created using the FD Contours 
but did not include the FD Parking Lot, FD Building Pad, 
or FD Sidewalk. 
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13. Turn on the FD Building Pad, FD Sidewalk, and FD 
Parking Lot layers in the View Filter Manager. 

14. Select  in the Surface area under 
the Data Prep tab. 

15. Select Design in the Surface cell. 

16. With the Curser in the Members to add or Remove cell, 
left-click on the Building Pad, Parking Lot, and 
Sidewalk.  

17. Select in the Add/Remove Surface 
Members pane. 

Note:  After selecting the Design Surface is 
updated using these new surface members. 

Note:  You have some yellow flags on the surface which 
indicates an error. 

18. Select  in the Add/Remove Surface 
Members pane. 

19. Select  in the Create Surface pane. 

20. Select the  icon in the Status Bar in the bottom 
right of the screen. 

Note:  The Flags Pane opens to give more information 
about the errors.  The errors in this surface are 
Breaklines Intersect. 

 

21. Pan and Zoom in to the uppermost flag.  

Note:  We can see that the contour line extends through 
the edge of the parking lot. 
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22. Select  in the Lines area under the Data 
Prep tab. 

23. With the Curser in the Line cell, select the contour line. 

Note:  There is a line that extends from the curser to the 
contour line.  This is the point where the line will be 
broken when you left-click again. 

24. With the Break line just outside the Parking Lot line, 
left-click to break the Contour line. 

Note:  The contour line is now broken at this point and is 
two seprate lines. 

 

25. Select  in the Break Line pane. 

26. Left-click on the small piece of the Contour line that is 
inside the Parking Lot. 

27. Right-click in the graphical view and select Delete. 

Note:  The line is deleted and the Flag has disappeared. 

 

28. Pan and zoom to the next two flags. 

29. Select  in the Lines area under the Data 
Prep tab. 

30. With the curser in the Line cell, left-click on one of the 
contour lines with the Flag to select it. 

31. With the Break line just out side the Parking Lot left-
click. 

Note:  You may have to pan and zoom in on the location 
to make sure you are just outside the Parking Lot line 
before you left-click. 

32. With the curser in the Line cell, left-click on the same 
contour line on the side of the break that is in the 
Parking Lot. 

33. With the Break line just outside the other side of the 
Parking Lot, left-click to break the contour line. 
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34. Select  in the Break Line pane. 
35. Left-click on the section in the Parking Lot that you just 

Broke into 3 lines. 

 

36. Right-click in the graphical view and select delete. 

Note:  The flag should disappear as soon as the line is 
deleted.  If the flag is still visible, zoom and pan in close 
to make sure the contour does not still overlap the 
Parking Lot. 

37. Repeat steps 36 through 43 for the other contour line. 

 

Importing and Draping a PDF  
In this exercise we will import a pdf and drape it onto the surface to provide more context for the project. 

1. Select the Measure  icon in the quick access 
toolbar. 

 

2. With the curser in the From cell, left-click on one of the 
upper corners of the Building Pad. 

Note:  If you turn on the Building Pad layer, you can 
snap to the end points for the From and To points to get 
the most accurate measurement. 

3. With the curser in the To cell, left-click on the other 
upper corning of the Building Pad. 

Note: The distance shown should be 150ft. We will use 
this edge to scale the imported PDF. 

4. Select  in the Measure Distance pane. 

 

 



Page | 66  
 

5. Select  in the CAD Data area under the Data Prep 
tab. 

6. Left-click on Office Park.pdf  to highlight it and select 

 in the Import pane. 

Note:  This will open the place image command. 

7. Select Known distance for the Method. 

8. Enter 150 in the Distance cell under Know Distance. 

9. With the curser in the From pixel cell, left-click on one 
of the upper corner of the Building Pad on the PDF 
image. 

Note:  It may be slightly difficult to see the data if the 
program automatically puts the PDF over the linework. 
The building pad on the PDF  is red. 

10. With the curser in the To pixel cell, left-click on the 
other upper corner of the Building Pad on the PDF 
image. 

11. Select  in the Place Image pane. 

Note:  The PDF has now been scaled, but is still not in 
the correct position. 

 

12. Select the Georeference Image  icon at the top of the 
Place Image pane. 

Note:  The Georeference Image is used to place the PDF 
image in the correct location. 

13. Select Office Park.pdf as the image. 

14. Select  under Points on the Georeference 
Image pane. 

15. With the curser in the Pixel cell, left-click on a corner of 
the Building Pad in the PDF. 

16. With the curser in the Location cell, left-click on the 
corresponding corner in the drawing. 
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17. Select  under Points on the Georeference 
Image pane. 

18. With the curser in the Pixel cell, left-click on another 
corner of the Building Pad in the PDF. 

19. With the curser in the Location cell, left-click on the 
corresponding corner in the drawing. 

 

 

20. Select  in the Georeference Image pane. 

Note: You will notice that there are slight discrepancies 
between the PDF and the drawing. This is due to 
different accuracies of the imported files. As the PDF is 
only being used to add context, it is ok that it is not a 
perfect match. 

21. Select  in the Georeference Image pane. 

22. Select  in the Place Image pane. 

23. Select  in the Import pane. 

 

24. Expand the Imported Files folder in the Project 
Explorer and left-click on the Office Park.pdf to 
highlight it. 

25. Right-click and select Add/Remove Surface Members. 

 

26. Select Design in the Surface cell. 

27. Select  in the Add/Remove Surface 
Members pane. 

28. Select  in the Add/Remove Surface 
Members pane. 
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29. Turn off everything except for the Design surface and 
Georeferenced Images in the View Filter Manager. 

30. Select the 3D view tab at the top of the graphical view 
window and examine your surface. 

Note:  If you do not have a 3D View tab, you can open 

one by selecting the New 3D View  icon from the 
Quick Access Toolbar. 

Note: If the PDF data is not visible on your surface in the 
3D view just close the 3D view and open it again. 

Note:  You can turn off the Wireframe in the Surface 
Properties to get a cleaner view. 
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Corridor Takeoff 

Welcome 
Welcome to the Trimble® Business Center – Heavy Construction Edition (HCE) Corridor Takeoff Module.  The 
corridor takeoff module incorporates tools that enable you to perform a corridor takeoff quickly and with 
accuracy.  This is typically for pre-construction estimating purposes.  Business Center - HCE allows for the import 
of multiple file types that are used to create original ground and finished design surfaces.   
This guide was developed by Trimble Navigation’s Global Services Training and Support staff to support classroom 
instruction delivered by a Trimble Certified Trainer.  The Trimble Certified Trainer will use this guide to lead you 
through the Data Preparation Module using real world exercises.  Please use this guide in conjunction with the 
Business Center - HCE help files and other product resources available. 

Overview 
The goal in performing a corridor takeoff is to calculate cut/fill and material volumes needed for a roadway.  This is 
usually for the purpose of bidding on a construction project. This module will guide you through creating finish 
grade and subgrade surfaces, specifying materials for each course in the corridor, and running a report to 
determine the volumes of cut and fill needed along the corridor. 

Learning Objectives 
• Create Horizontal and Vertical Alignments 

• Creating Corridors 

• Create Corridor Templates 

• Managing Material Layers 

• Define Strata on a Site 

• Review Surfaces to check for Accuracy 

• Generate Reports 

Files Needed 
For the training exercises, you should save the following files provided by your Certified Trainer onto your PC and 
note the location. 

• Corridor Takeoff Training Module.vcl  
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Creating Alignments 
An alignment defines a linear feature, such as a road centerline.  Alignments consist of horizontal geometry as 
seen in the plan view and optional vertical geometry as seen in the profile view. Alignments have associated 
stationing, and can also include station equations.   
Each vertical alignment is associated with a horizontal alignment, and there can be multiple vertical alignments for 
each horizontal alignment. The values you can enter depend on the alignment settings for the project. 
Alignments can be imported, created using the Alignment Editor, or by appending linestrings to an alignment.  The 
alignment editor and the appending method will be explored in this module. 

1. Open Business Center - HCE and start a new project.   

2. Select the template for US Survey Foot. 

3. Select the  icon in the Data area under the Project 
Tab. 

Note: You can also select the Import  icon from the 
Quick Access Toolbar. 

4. Left-click on the Corridor Takeoff Training Module.vcl 
to highlight it. 

Note:  You may have to use the  button to select the 
folder where the Data Prep.dxf file is saved on your PC. 

Note:  You can also drag and drop the Data Prep.dxf into 
the graphics window to import the CAD data. 

 

5. Select  in the Import pane. 

6. Select  to close the Import pane. 
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7. Turn off the OG_CON and OG_ICON Layers in the View 
Filter Manager. 

8. Turn off the OG Surface in the View Filter Manager. 

 

9. Select the Create Alignment  icon in the 
Alignment area on the Corridor tab. 

10. Enter Training Road in the Name cell. 
11. Select the drop-down arrow in the Layer cell and 

create a new layer with the following settings.   

Layer name:  Training Road CL  
Color:  Red 
Line style:  Solid 
Line weight:  0.50mm  
Protect Layer:   

12. Select  . 

13. Left-click on Define Individual Segments for the 
Horizontal Geometry Definition to select it. 

Inscribe curves at PI’s – This method is used to build an 
alignment from data with values for curves at 
consecutive Points of Intersection (PI’s). 
Define individual segments – This method is used to 
build an alignment from data with values for 
consecutive line, arc, and spiral segments.   
Use an existing line – If an existing line’s geometry is to 
be used to define the alignment, check this box and 
select the reference line.  If the line is in 3D, a vertical 
alignment (VAL) will be created. 

14. Select Clothoid in the Spiral type drop-down list. 

Note:  This setting defines the spiral definition in the 
Business Center - HCE project.  Simply ensure that the 
spiral type defined here matches the spiral definition of 
the engineer’s design. 
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15. Select   in the Create Alignment pane. 

Note:  The Alignment Editor will appear and the focus 
will be on the Horizontal Alignment editor. 

 

16. Enter 857 for the Northing and 665 for the Easting, and hit Enter on the keyboard. 

Note:  The first type of segment is the Point of Beginning (POB).  By default the stationing starts at 0+00.   

Note:  Using the tab key easily allows users to progress to the next cell during the data entry process. 

17. Select Line for the next segment type.   
18. Enter a North Azimuth of  180°00'00" and a Length of 60’, and hit Enter on the keyboard. 

Note:  The POB and the first segment is now visible in the plan view.  You may have to Pan and Zoom-in to 
see the POB and first segment. 
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19. Select Arc for the next segment type. 

Note:  By default the North Azimuth is now set to tangent so as to match the azimuth of the last segment.   

20. Enter 180 for the North Azimuth and hit tab on the keyboard. 

Note:  Notice that the minutes and seconds were automatically populated.   

21. Enter 200’ for the Radius and hit tab on the keyboard. 
22. Select Left to turn the arc towards the left and hit tab on the keyboard. 

23.  Enter 200’ for the length and hit enter on the keyboard.   

Note:  The arc segment is now visible in the plan view. 

24. Select Line for the final segment type. 
25. Select tangent in the North Azimuth cell. 
26. Enter 587’ for the length and hit enter on the keyboard. 

Note:  The Horizontal Alignment is now complete and should look simiar to the alignment in the plan view 
below. 
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27. Left-click the Vertical tab on the left-hand side of the alignment editor to select it.   

28. Select  in the Vertical Alignment editor. 

Note:  The name is automatically populated with the same name as the HAL that was just created.  VAL’s 
must be associated with a HAL and since there is only one HAL in this project the VAL is automatically 
associated with it. 

29. Enter 461.56’ for the elevation of the POB at station 0+00 and hit tab on the keyboard. 
30. Select Grade Break for the next PI type and enter 0+16 for the station. 
31. Enter 461.24’ for the elevation and hit enter on the keyboard. 

Note:  The slope of the segment is populated and is -2.00%.   

32. Select Symmetrical Vertical Curve for the next PI type and enter 4+50.60 for the station. 

33. Enter 478.10’ for the elevation and 200’ for the curve length, and hit enter on the keyboard. 

Note:  The values for the Slope, Approach Curve Length, and the Departure Curve Length are all populated 
for the Symmetrical Vertical Curve. 

34. Select Grade Break for the next PI type.   
35. Enter 8+55.36 for the station and 477.97’ for the elevation, and hit enter on the keyboard.   

36. Select the New Profile View  icon in the View area under the Corridor tab.   

Note:  The profile of the road should look the profile view shown below.   

Note:  When selecting New Profile View it will appear over the Alignment Editor.  If you want it in another 
area, you can just click and drag it into another window. 
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Creating Alignment Labels 
You can easily create horizontal alignment labels to display values for stations, station equations, horizontal 
alignment points, and abbreviations for other key points along an alignment by utilizing the Create Alignment 
Label command.  These labels will be included in outputs when you print views that show them. 

1. Select the Create Horizontal Alignment Label
 icon in the Alignment area 

under the Corridor tab. 
2. Select Training Road under the Alignment drop-down 

list. 

3. Select  on the Create Horizontal 
Alignment Label pane. 

 

4. Enter 100’ in the Spacing cell in the Tick column. 

Note:  This is how often a Major tick mark will be drawn. 

5. Select Text for the layer under the Layer drop-down list 
in the Ticks column.  

6. Enter 0.5 in the Tick Size (inch) cell in the Tick column. 

Note:  This is the length of the tick that is drawn. 

7. Select Center from the Side drop-down list in the Tick 
column. 

Note:  This determines how the tick mark will be drawn 
in relation to the alignment. 

8. Select Each tick from the Label every drop-down list in 
the Text column. 

9. Select Text for the layer under the Layer drop-down list 
in the Text column.  

10. Select Standard from the Text style drop-down list in 
the Text column. 

11. Select Right from the Side drop-down list in the Text 
column. 

12. Select Perpendicular from the Orientation drop-down 
list in the Text column. 

13. Select   in the Alignment Label Settings 
window. 
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14. Select   in the Create Horizontal 
Alignment Label pane. 

Note:  In the plan view you will notice that the ticks are 
labeled upside down.  This is because the alignment 
stationing works from the north towards the southeast 
direction. 

 

15. Select all the labels and right-click in the graphical 
view. 

16. Select properties. 
17. Select Yes in the Auto-Flip cell. 

Note:  All the labels are now displayed correctly. 

18. Select   in the Properties pane. 
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19. In the Project Explorer, expand Alignments and the 
Training Road alignment.   

Note:  There is a new category called labeling.   

20. Right-click on Labeling under the Training Road in the 
Project Explorer and select Edit. 

21. Left-click on the Minor tab in the Alignment Label 
Settings window to select it. 

22. Check the box to Label Intermediate Stations. 
23. Select 4 from the Ticks per major segment drop-down 

list in the Ticks column. 
24. Select the Text layer under the Layer drop-down in the 

Ticks column. 
25. Enter 0.15 in the Tick size (inch) cell under the Ticks 

column. 
26. Select Right from the Side drop-down list in the Ticks 

column. 
27. Select No Labels from the Label every drop-down list in 

the Text column.   

Note:  Often if the minor ticks are labeled in addition to 
the major ticks the labeling becomes too busy. 

 

28. Left-click on the HAL Points Tab in the Alignment Label 
Settings window to select it. 

29. Check the box to Label Alignment Points. 
30. Select the Text layer under the Layer drop-down list in 

the Line column. 
31. Enter 1.5 in the Line length (inch) cell in the Line 

column. 
32. Select Left from the Side drop-down list in the Line 

column. 
33. Select the Text layer in the Layer drop-down list in the 

Text column. 
34. Select Sketchflow 0.10 from the Text style drop-down 

list in the Text column. 
35. Select Centered in the Location drop-down list in the 

Text column. 
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Managing Material Layers 
Use the Manage Material Layers pane to specify the available material layers in your project by adding them to 
the Material layers list. Each material layer can represent a different surface within a corridor. For example, in 
addition to the default "Finish" layer, you might specify layers for "Base course” and "Subgrade."  

Each time you create a corridor template instruction, you can select one or more material layers from the Layers 
list on which the line segment created by that instruction appears. 

When creating or editing a corridor, you can specify its "current material layer" by selecting it from the Layers list. 
This is the layer that will display in the Plan View and 3D View. If you export the corridor, this is the layer used to 
create the exported corridor surface. The line segments appearing on the current material layer are used to build 
the corridor surface. 

For this exercise we will assume a 3” asphalt material on top of a 12” base course material on top of the subgrade 
surface.  The first step in defining the different layers that comprise a roadway is to create the material layers.  
Next, reference nodes need to be created representing the center line of the base course and subgrade 
respectively. 

36. Select  in the Alignment Label Settings 
window. 

Note:  The Major stationing text is much too large. 

 

37. In the Project Explorer, right-click on Labeling under 
the Training Road alignment and choose edit. 

38. Select Symbol 0.10 in in the Text style in the Text 
column under the Major tab. 

39. Select  in the Alignment Label Settings 
window. 

Note:  If station equations were a property of this 
alignment that could easily be labeled as well Using the 
Station Equation tab in Edit Alignment Label settings.  
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Materials and Site Improvement Manager 
When preparing for corridor takeoff calculations, it is necessary to define all the native materials that will be 
encountered during construction and materials that will be imported to complete construction.  The definition of 
materials and site improvements as used in Business Center - HCE is: 

• Material – a naturally-occurring or manufactured substance from which a site improvement can be made at a 
construction site.  Examples include soil, rock, sand, flex-base, limestone, cement concrete, asphaltic concrete, 
PVC pipe, ductile iron, etc. 

• Site Improvement – an object that is built out of materials on a construction site.  Examples include curbs, 
sidewalks, parking lots, and building pads. 

Business Center - HCE utilizes an MSI Manager to define all the materials, both native and man-made that will be 
encountered on a construction project.  Using the MSI Manager, site improvements are then defined using these 
materials. 
For this exercise, all of the materials that will be encountered during construction need to be defined in the MSI 
manager.  We will only be concerned with defining materials and not site improvements, for the purpose of 
performing a corridor take-off.  The materials that need to be defined are: 

• Ashpalt 

• Flex-Base 

• Subsoil – Earthen Clay 

1. Select the Manage Material Layers  
icon in the Corridor area under the Corridor tab. 

2. Select   and name the material Base 
Course. 

3. Select  and name this material Subgrade.  

Note:  The up and down arrows are utilized to put the 
material layers in the correct order as defined by the 
cross-section of the roadway. 

4. Select  in the Manage Material Layers 
pane. 
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1. Select the Material and Site Improvement Manager 

 icon in the Strata area under the Corridor tab. 

2. Left-click on the  icon in front of Materials to 
expand it.  

3. Right-click on the Earthen (Select) category and select 
New Earthen (Select) Material. 

 

4. Enter Flex Base for the Name. 

5. Enter 0 in the Shrinkage and Hauling bulkage cells. 

Note:  This is because flex base does not shrink or swell 
during excavation or material placement operations. 

6. Enter 15 in the Procurement unit cost cell. 

Note:  The Procurement cost is the cost per cubic yard to 
either purchase the material or to extract the material 
as cut. 

7. Select Magenta from the Color drop-down list under 
Shading. 

Note:  This is the color that will be used in the graphic 
views to represent the material. 

8. Do not specify a Texture under Shading for this 
exercise. 

Note:  If desired, an image file could be specified here so 
that the Add Surface Texture command could be applied 
to make visualization of the 3D model more realistic. 
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9. Right-click on the Earthen (Select) category and select 
New Earthen (Select) Material. 

10. Enter Asphalt for the Name. 
11. Enter 0 in the Shrinkage and Hauling bulkage cells. 
12. Enter 90 in the Procurement unit cost cell. 
13. Select Orange from the Color drop-down list under 

Shading. 
14. Do not specify a Texture under Shading for this 

exercise. 

 

15. Left-click on the   icon in front of  Earthen (Mass 
Earthworks) to expand it.  

16. Right-click on the On-Site Soil material and select re-
name. 

 



Page | 82  
 

Creating Corridors 
A corridor is a 3D model of a linear structure, such as a road or waterway. The corridor is based on a horizontal 
and a optional vertical alignment.  Business Center - HCE utilizes templates that define cross-sections  at specific 
stations along the length of the corridor.    
After completing this section you should be able to: 

• Create a corridor 

17. Enter On-Site Clay for the name of the 
material.  

18. Select Ordinary Soils from the Material 
nature drop-down list.   

Note:  There are three options available for 
Material nature and they are explained 
below. 

Ordinary Soils – Select this to identify a 
material that can potentially be utilized as fill 
on site. 
Topsoil – Select this to identify a top of 
ground material.  Topsoil materials can not be 
utilized as fill on site. 
Rock – Select this to identify a rock material 
that may need to be ripped or blasted. 

19. Select  and set the Percent usable for fill to 100%. 

Note:  If there was a portion of the material on-site that is not of the required quality to be used as fill.  You 
can enter a estimated percentage here to attain a more accurate earthwork report. 

20. Enter 8 in the Shrinkage cell and 10 in the Hauling bulkage cell.  

Note:  The hauling compaction value is calculated based on the values entered for the Shrinkage and 
Hauling bulkage.  Each of these values are defined below: 

Shrinkage = the percent by which the material will shrink when it is cut and then used as compacted fill. 
Hauling Bulkage = the percent by which the material will increase in bulk when it is cut and hauled in a 
loose state. 
Hauling Compaction = the percent by which the material will shrink when it is taken from its loose condition 
and placed into compacted fill. 

21. Enter 12.00 in the Off-site borrow unit cost cell.  

Note:  The Off-Site Borrow Unit Cost is the price to excavate, transport, and deliver the material on-site from 
a borrow source.  This cost only applies to material that must be imported (borrowed). 

22. Select Brown from the Shading Color drop-down list and do not associate a texture file. 

23. Select  in the Material and Site Improvement Manager. 
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• Create and edit corridor templates 

• Manage template nodes 

• Manage material layers 

Create a Corridor 

1. Select  in the Corridor area under the Corridor 
tab. 

2. Enter Training Road  in the Name cell. 
3. Select Training Road from the Horizontal Alignment 

and Vertical Alignment drop-down lists. 
4. Select Finish from the Current Material layer drop-

down list.  

Note:  The current material layer is user define, and is 
what surface is displayed in the graphical views and 
exported.  An example of this is if subgrade is chosen 
then the subgrade surface is displayed and exported. 

5. Select OG from the Original Ground drop-down list.  

Note:  An original ground surface is required to define 
tie slopes from the design to the original ground.  
Without defining an original ground those corridor 
definition instructions will not be available. 

6. Select On-Site Clay from the Native material drop-
down list. 

Note:  The Native material is the most representative 
earthen material of the original ground. 

7. Leave the borrow material as undefined. 

Note:  This is because the project does not require an 
import.  

Note:  The Borrow material is the material that is to be 
obtained from off-site sources should there be a deficit 
on-site. 

8. Do not select a reference line or reference surface.   

9. Select  in the Create Corridor pane. 

Note:  The Insert Corridor Template pane will now 
appear.   
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Corridor Templates 
A corridor template is a cross-section definition at a specific station along an alignment.  Template instructions are 
the tools used to specify what the template looks like.  They define the offsets and slopes necessary to accurately 
represent the road edge of pavement, edge of shoulder, lane widening, superelevations, ditches, and more. 
Corridor templates are made up of nodes and instructions.  Nodes for example are the edge of pavement point, 
centerline of road, inside of ditch line, outside of ditch, and the point where a tie slope meets existing ground.  
The instructions are the definition of how we get from one node to the next.  The centerline of road or alignment 
definition is normally the starting node from which the rest of the corridor template is built. 
When nodes are created they are typically associated with a material layer.  The material layer defines which 
surface it will be a part of.  For example, a node with the subgrade material layer definition will be a part of the 
subgrade surface and not the finish grade surface.  Multiple material layers can be assigned to a single node. 

Corridor Template Instruction Types 

With the following instruction types complex roadways and corridors can be accurately modeled.  Following are 
definitions of each of the instruction types available in Business Center - HCE. 
Offset/Slope -   This instruction type defines a node based on the offset and slope relative to one or more other 
nodes in the template.  For example, this would be used to define the edge of road in relation to the centerline. 
Offset/Elevation -  This instruction type defines a node based on the offset and elevation change relative to one or 
more other nodes in the template.  
Slope/Slope -  This instruction defines a node based on the intersection of slopes from two other nodes in the 
template. 
Slope/Elevation -  This instruction type defines a node based on the slope and elevation change relative to one or 
more other nodes in the template. 
Side Slope -  This instruction type defines a side slope node based on a cut slope and/or a fill slope.  An optional 
ditch width can be added, if required.  For example, defining the cut and fill slopes, and ditch profile to get from 
the edge of shoulder to existing ground. 
Connect Nodes -  This instruction type connects two nodes with a line segment. 
Surface instruction - This instruction type creates a corridor from an existing surface. 

10. Select Training Road from the Corridor Cell drop-down 
list. 

11. Enter 0+00 in the Begin Station cell. 
12. Select new definition from the Options drop-down list.   
13. Enter 0+00 in the Template name cell. 

14. Select  in the Insert Corridor Template 
pane. 

Note:  The Edit Corridor Template window appears as 
well as the cross-section view at station 0+00. 
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Important Corridor Template Concepts 

In Business Center – HCE, templates are always building to the next template.  For instance, if a cross-section 
template is defined at station 0+00 of an alignment, the template will be carried the length of the alignment.  If 
there is a lane widening that begins at station 2+00 and ends at 3+00 – the original template will need to be added 
at 2+00 and then a template representing the full lane width inserted at station 3+00. 
With typical complex roadways there could be dozens of templates required to build an accurate surface in this 
method.  The preferred way to build sophisticated corridors is  by using tables within a corridor template. 
In the remainder of this exercise a corridor consisting of a superelevation and lane widening; constising of an 
asphalt layer, base course layer, and subgrade layer will be constructed using one corridor template that utilizes 
the instructions and tables mentioned above. 

1. Select Offset/Slope from the Instruction Type drop-
down list. 

Note:  We will start by defining the right edge of road in 
reference to the CL.   

2. Select 1 > Training Road from the Offset/slope from 
drop-down list. 

Note:  This is the starting point or otherwise defined as 
node 1. 

3. Select Table from the Offset: drop-down list by left-

clicking on the   icon. 
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3. Left-click on the   button under Offset. 

Note:  A Station/Offset Table pane is presented and we 
will use this table to horizontal location of the edge of 
pavement for the right travel lane. 

Note:  For this exercise assume a 12’ wide travel lane 
from staton 0+00 to station 3+00.  The right lane will 
then transition from 12’ to 22’ wide, and this transition 
happens from station 3+00 to station 5+00.  From 
station 5+00 to the end of the corridor the right hand 
travel lane will remain 22’ wide. 

4. Enter 0+00 for the Station and 12 for the Offset in the 
first row. 

5. Enter 3+00 for the Station and 12 for the Offset in the 
second row. 

6. Enter 5+00 for the Station and 22 for the Offset in the 
third row. 

7. Select   in the Station/Offset Table pane. 

 

8. Select Table from the Slope: drop-down list by left-

clicking on the icon . 
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9. Left-click on the   button under Slope. 

Note:  In the Station/Slope Table pane we will define the 
superelevations and cross slope of the right travel lane.   

Note:  The training road starts out in a full 
superelevation of 6% from station 0+00 to station 2+60.  
The road transitions from full superelevation to the 
typical cross slope of -2% between station 2+60 and 
station 5+00.   

10. Enter 0+00 for the Station and 6 for the Slope in the 
first row. 

11. Enter 2+60 for the Station and 6 for the Slope in the 
second row. 

12. Enter 5+00 for the Station and -2 for the Slope in the 
third row. 

13. Select   in the Station/Slope Table pane. 

 

14. Enter EP in the Name cell.   

Note:  EP is short for edge of pavement.  The names are 
labels for the nodes and can be displayed in the cross-
section views and also are utilized by the drafting 
module when plotting cross-sections. 

15. Leave the Code cell as Undefined. 

16. Select Finish for the Material layer. 

Note:  This is the finish surface that we are defining. 

Note:  The material above option is not selectable.  This 
is because the Finish material layer is selected. 

Material Above = an Earthen (Select) material that is 
above the subgrade surface segment being defined.  

17. Select   in the Edit Corridor Template 
pane. 

Note:  You will notice that the right-hand travel lane is 
now defined and can be viewed in the plan view and 
cross-section view to check for accuracy. 
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18. Select Offset/Slope from the Instruction Type drop-
down list. 

Note:  This is to define the left edge of road in reference 
to the CL.   

19. Select 1 > Training Road in the Offset/slope from drop-
down list. 

Note:  This is the starting point or as otherwise defined 
as node 1. 

20. Enter EP in the Name cell. 

Note:  We are entering EP because we are defining the 
left travel lane edge of pavement with thess 
instructions. 

21. Select Finish for the Material layer. 

Note:   This is the finish surface that we are defining. 
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22. Left-click on the   button under Offset. 

Note:  A Station/Offset Table pane is presented and we 
will use this table to horizontal location of the edge of 
pavement for the left travel lane. 

Note:  For this exercise assume a 12’ wide travel lane 
from staton 0+00 to station 3+00.  The left lane will then 
transition from 12’ to 22’ wide, and this transition 
happens from station 3+00 to station 5+00.  From 
station 5+00 to the end of the corridor the left hand 
travel lane will remain 22’ wide. 

23. Enter 0+00 for the Station and -12 for the Offset in the 
first row. 

Note:  When setting a Offset left of a centerline you will 
use a negative number and when setting an Offset to 
the right of the centerline it is a positive value. 

24. Enter 3+00 for the Station and -12 for the Offset in the 
second row. 

25. Enter 5+00 for the Station and -22 for the Offset in the 
third row. 

26. Select   in the Station/Offset Table pane. 
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27. Left-click on the   button under Slope. 

Note:  In the Station/Slope Table pane we will define the 
superelevations and cross slope of the left travel lane.   

Note:  The training road starts out in a full 
superelevation of -6% from station 0+00 to station 2+60.  
The road transitions from full superelevation to the 
typical cross slope of -2% between station 2+60 and 
station 5+00.   

28. Enter 0+00 for the Station and -6 for the Slope in the 
first row. 

29. Enter 2+60 for the Station and -6 for the Slope in the 
second row. 

30. Enter 5+00 for the Station and -2 for the Slope in the 
third row. 

31. Select   in the Station/Slope Table pane. 

32. Select   in the Edit Corridor Template 
pane. 
Note:  You will notice that the left-hand travel lane is 
now defined and can be viewed in the plan view and 
cross-section view to check for accuracy. 
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33. Select Offset/Slope from the Instruction Type drop-
down list. 

Note:  We will be defining the edge of the shoulder for 
right travel lane.   

Note:  For this corridor the shoulder is 4’ wide and 
maintains a consistent -6% slope. 

34. Select 2 > EP in the Offset/slope from: drop-down list. 

Note:  We selected 2 > EP since this is the edge of the 
right travel lane. 

35. Select Offset from the Offset: drop-down by left-

clicking on the    icon. 

36. Enter 4 in the Offset cell. 
37. Select Slope Percent from the Slope: drop-down by 

left-clicking on the icon  . 

38. Enter -6 in the Slope cell. 
39. Enter  SHLD in the Name cell. 

Note:  SHLD is short for shoulder. 

40. Select  Finish for the Material layers. 

41. Select   in the Edit Corridor Template 
pane. 

Note:  You will notice that the right-hand shoulder is 
now defined and can be viewed in the plan view and 
cross-section view to check for accuracy. 

 



Page | 92  
 

 

42. Select Offset/Slope from the Instruction Type drop-
down list. 

Note:  We will be defining the edge of the shoulder for 
left travel lane.   

Note:  For this corridor the shoulder is 4’ wide and 
maintains a consistent -6% slope. 

43. Select 3 > EP in the Offset/slope from: drop-down list. 

Note:  We selected 3 > EP since this is the edge of the 
left travel lane. 

44. Enter -4 in the Offset cell. 
45. Enter -6% in the Slope cell. 

46. Enter SHLD in the Name cell. 

Note:  SHLD is short for shoulder. 

47. Select  Finish for the Material layers. 

48. Select   in the Edit Corridor Template 
pane. 
Note:  You will notice that the left-hand shoulder is now 
defined and can be viewed in the plan view and cross-
section view to check for accuracy.   
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49. Select Offset/Elevation from the Instruction Type drop-
down list. 

Note:  We are defining the inside of the ditch from the 
edge of the right shoulder using an offset/elevation 
instruction. 

50. Select 4 > SHLD in the Offset/slope from: drop-down 
list.  

51. Enter 6 in the Offset cell. 

Note:  This defines the horizontal location of the inside 
of the ditch as being 6’ from the edge of shoulder. 

52. Enter -2 in the Elevation cell. 

Note:  This defines the elevation of the inside of the ditch 
to be 2’ lower than the elevation of the shoulder. 

53. Enter DITCH in the Name cell. 
54. Select  Finish for the Material layer. 

55. Select   in the Edit Corridor Template 
pane. 

Note:  You will notice that the right-hand ditch is now 
defined and can be viewed in the plan view and cross-
section view to check for accuracy. 
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56. Select Side Slope in the Instruction Type drop-down 
list. 

Note:  The last definition for the finish grade surface on 
the right travel lane is to define the ditch width and tie 
the cut and fill slopes to the original ground. 

57. Select 6 > DITCH in the Side slope from: drop-down list.  
58. Select  OG in the Target surface drop-down list. 

Note:  This is the surface from which the cut and fill 
slopes tie into. 

59. Enter 3:1 in the Cut slope cell.   
60. Enter 3 in the Cut ditch width: cell. 

Note:  This defines that when in a cut to get to the finish 
grade of the road a 3’ ditch will be defined prior to 
sloping at a 3:1 to tie to existing. 

61. Enter 3:1 in the Fill slope: cell. 

Note:  This defines that when filling to get to grade on 
the road the slope from the inside ditch line to existing 
will be 3:1. 

62. Enter TIE in the Name cell. 

Note: TIE is short for the point where the side slope 
intersects the original ground. 

63. Select Finsih for the Material layer. 

64. Select   in the Edit Corridor Template 
pane. 

Note:  You will notice that the right-hand Ditch is now 
tied to the Original Ground and can be viewed in the 
plan view and cross-section view to check for accuracy. 
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65. Select Offset/Elevation in the Instruction Type drop-
down list. 

Note:  We are defining the inside of the ditch from the 
edge of the left shoulder using an offset/elevation 
instruction. 

66. Select 5 > SHLD in the Offset/slope from: drop-down 
list. 

67. Enter -6 in the Offset cell. 

Note:  This defines the horizontal location of the inside 
of the ditch as being 6’ from the edge of shoulder. 

68. Enter -2 in the Elevation cell. 

Note:  This defines the elevation of the inside of the ditch 
to be 2’ lower than the elevation of the shoulder. 

69. Enter DITCH in the Name cell. 

70. Select  Finish for the Material layer. 

71. Select   in the Edit Corridor Template 
pane. 
Note:  You will notice that the left-hand ditch is now 
defined and can be viewed in the plan view and cross-
section view to check for accuracy.  
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72. Select Side Slope in the Instruction Type drop-down 
list. 

Note:  The last definition for the finish grade surface on 
the left travel lane is to define the ditch width and tie 
the cut and fill slopes to the original ground. 

73. Select 8 > DITCH in the Side slope from: drop-down list. 
74. Select OG in the Target surface drop-down list. 

Note:  This is the surface from which the cut and fill 
slopes tie into. 

75. Enter 3:1 in the Cut slope cell.   
76. Enter 3 in the Cut ditch width: cell. 

Note:  This defines that when in a cut to get to the finish 
grade of the road a 3’ ditch will be defined prior to 
sloping at a 3:1 to tie to existing. 

77. Enter 3:1 in the Fill slope: cell. 

Note:  This defines that when filling to get to grade on 
the road the slope from the inside ditch line to existing 
will be 3:1. 

78. Enter TIE in the Name cell. 

Note: TIE is short for the point where the side slope 
intersects the original ground. 

79. Select Finish for the Material layer. 

80. Select   in the Edit Corridor Template 
pane. 

Note:  You will notice that the left-hand Ditch is now tied 
to the Original Ground and can be viewed in the plan 
view and cross-section view to check for accuracy. 
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Defining Corridor Subgrades 
So far we have defined the finish grade surface.  As indicated earlier this particular road consists of 3” of asphalt 
and 12” of base course atop the subgrade.  The next step in completing the cross-section definitions is to define 
the base course surface. The first step in this process is to create a base course centerline node. 
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1. Select  Offset/Elevation in the Instruction Type drop-
down list. 

2. Select 1 > Training Road in the Offset/elevation from: 
drop-down list. 

3. Enter 0.0  in the Offset cell. 

Note:  The centerline of the base course should be 
directly beneath the finish surface centerline. 

4. Enter -.25 in the Elevation cell. 

Note:  Entering -.25’ is the same as going beneath the 
finish surface by 3 inches. 

5. Enter  BASE CL  in the Name cell. 
6. Unselect all material layers under Material layers by 

Left-clicking on any boxes that have a checkmark to 
remove the checkmark. 

Note:  We do not want to create a segment between 
node 1 and the newly created node that becomes part of 
a surface.  The node is simply needed as a reference to 
build the segments that will make up the base course 
surface. 

7. Select   in the Edit Corridor Template 
pane. 

Note:  You will notice that the 10 > BASE CL point is now 
directly below the 1 > Training Road and can be viewed 
in the cross-section view to check for accuracy. 
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Note:  Next we need to define the right travel lane of the base course.  It should mirror the right travel lane 
of the finish surface through lane widenings and superelevations.  Instead of re-defining the superelevations 
and lane widenings again via tables, let’s direct Business Center - HCE to simply follow the finish surface 
definition. 
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8. Select Offset/Elevation in the Instruction Type drop-
down list. 

9. Select 10 > BASE CL in the Offset/elevation from: drop-
down list. 

10. Select Node to node from the Offset: drop-down list by 

left-clicking on the   icon. 
11. Select 1 > Training Road in the first node drop-down 

list and select 2 > EP in the second node drop-down 
list. 

Note:  This says that our newly created node should 
mirror the offset from 1 > Training Road to 2 > EP.  

12. Select Node to node in the Elevation: drop-down list by 

left-clicking on the   icon. 
13. Select 1 > Training Road in the first node drop-down 

list and select 2 > EP in the second node drop-down 
list. 

Note:  This defines the elevation of the newly created 
node to match the elevation  definition of node 2. 

14. Enter BASE in the Name cell. 

15. Select Base Course under Material layers. 

Note:  Since the material layer is a subgrade layer the 
Material Above option is enabled.   

16. Select Earthen (Select) > Asphalt in the Material above 
drop-down list.   

Note:  That only materials defined in the Earthen(Select) 
category are available. 

17. Select   in the Edit Corridor Template 
pane. 

Note:  You will notice that the left-hand Road Base is 
now added and can be viewed in the plan view and 
cross-section view to check for accuracy. 
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18. Select  Slope/Slope in the Instruction Type drop-down 
list. 

19. Select Node to node in the First slope node: drop-down 

list by left-clicking on the   icon. 

20. Select 11 > BASE in the First slope node drop-down list.   
21. Select 10 > BASE CL in the First slope node 1 drop-

down list and select 11 > BASE in the node 2 drop-
down list. 

22. Select Node to node from the Second slope node: 

drop-down list by left-clicking on the   icon. 
23. Select 4 > SHLD in the Second slope node drop-down 

list. 
24. Select  4 > SHLD in the Second slope node 1 drop-down 

list and select 6 > DITCH in the node 2 drop-down list. 

Note:  We just defined the new segment starts at node 
11 > BASE and maintains the same slope as node 10 > 
BASE CL to 11 > BASE until it intersects the slope defined 
from node 4 > SHLD to 6 > DITCH. 

25. Enter BASE in the Name cell. 
26. Select Base Course under Material layers. 
27. Select  Earthen (Select) > Asphalt in the Material above 

drop-down list. 

28. Select   in the Edit Corridor Template 
pane. 
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Note:  You can scroll the slider of the cross-section view 
down the length of the alignment and notice that node 
11 stays 3” beneath node 2 at all times and the slope is 
held from node 10 as expected. 

Note:  You will notice that the newly created line goes 
past the 2 > EP to 4 > SHLD line at station 0+00.00 to 
4+32.42 and then it terminates at the line 4 > SHLD to 6 
> DITCH correctly from station 4+32.42 to the end.  We 
will edit the last Slope/Slope instruction to end at the 
line 2 > EP to 4 > SHLD to make station 0+00.00 to 
station 4+32.42 correct.  We will then fix station 4+32.42 
to the end later in the excercise. 
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29. Right-click on the last Slope/Slope instruction in the list 
and select Edit. 

30. Change the Second slope node 1 to 2 > EP and change 
the node 2 to 4 > SHLD. 

31. Select  in the Edit Corridor Template 
pane. 

Note:  You will notice that the line now terminates at the 
2 > EP to 4 > SHLD line correctly from station 0+00.00 to 
station 4+32.42. 
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32. Select the Add instruction  icon at the top of the 
Edit Corridor Template to add a Instruction. 

33. Select Offset/Elevation in the Instruction Type drop-
down list. 

34. Select 10 > BASE CL in the Offset/elevation from drop-
down list. 

35. Select 1 > Training Road in the Offset node 1 drop-
down list and select 3 > EP in the node 2 drop-down 
list. 

36. Select  1 > Training Road in the Elevation node 1 drop-
down list and select 3 > EP in the node 2 drop-down 
list. 

37. Enter BASE in the Name cell. 
38. Select Base Coure under Material layers. 
39. Select  Earthen (Select) > Asphalt in the Material above 

drop-down list. 

40. Select   in the Edit Corridor Template 
pane. 

 

41. Select  Slope/Slope in the Instruction Type drop-down 
list. 

42. Select 13 > BASE in the First slope node drop-down list. 
43. Select 10 > BASE CL in the First slope node 1 drop-

down list and select 13 > BASE in the node 2 drop-
down list. 

44. Select 5 > SHLD in the Second slope node drop-down 
list. 

45. Select 5 > SHLD in the Second slope node 1 drop-down 
list and select 8 > DITCH in the node 2 drop-down list. 

46. Enter BASE in the Name cell. 
47. Select Base Course under Material layers. 
48. Select  Earthen (Select) > Asphalt in the Material above 

drop-down list. 

49. Select   in the Edit Corridor Template 
pane. 
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Note:  The last portion of the corridor that needs to be defined is the subgrade.  To get to the centerline of 
the subgrade a node needs to be created at an offset of 12” down from the centerline of the base course to 
represent the thickness of the base course. 
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50. Select Offset/Elevation in the Instruction Type drop-
down list. 

51. Select 10 > BASE CL in the Offset/elevation from drop-
down list. 

52. Select Offset in the Offset drop-down list by left-

clicking on the   icon. 

53. Enter 0.0 in the Offset cell. 
54. Select Delta elevation in the Elevation drop-down list 

by left-clicking on the   icon. 

55. Enter -1 in the Elevation cell. 
56. Enter SG CL in the Name cell. 

Note:  SG CL is short for subgrade centerline. 

57. Unselect all material layers under Material layers by 
left-clicking on any boxes that have a checkmark to 
remove the checkmark. 

Note:  Do not choose a material layer.  If a material 
layer is chosen then a segment between node 10 and 
the new node will be created and added to the surface 
and that would create an error in the surface. 

58. Select   in the Edit Corridor Template 
pane.  

Note:  You will notice that the 15 > SG CL point is now 
directly below the 10 > BASE CL and can be viewed in the 
cross-section view to check for accuracy.  
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59. Select Slope/Slope in the Instruction Type drop-down 
list. 

60. Select 15 > SG CL in the First slope node drop-down 
list. 

61. Select 10 > BASE CL in the First slope node 1 drop-
down list and select 11 > BASE in the node 2 drop-
down list. 

62. Select 4 > SHLD in the Second slope node drop-down 
list. 

63. Select 4 > SHLD in the Second slope node 1 drop-down 
list and select 6 > DITCH in the node 2 drop-down list. 

Note:  With the steps above we defined the new 
segment will start at node 15 and the segment will 
mirror the slope defined from node 10 to node 11.  The 
new segment shall terminate into the slope created 
from node 4 to node 6. 

64. Enter SG in the Name cell. 
65. Select Subgrade under the Material layers. 
66. Select Earthen (Select)>Flex Base in the Material above 

drop-down list. 

67. Select   in the Edit Corridor Template 
pane. 

Note:  You will notice that the right-hand Subgrade is 
now added and can be viewed in the plan view and 
cross-section view to check for accuracy. 
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68. Select Slope/Slope in the Instruction Type drop-down 
list. 

69. Select 15 > SG CL in the First slope node drop-down 
list.   

70. Select 10 > BASE CL in the First slope node 1 drop-
down list and select 13 > BASE in the node 2 drop-
down list. 

71. Select 14 > BASE in the Second slope node drop-down 
list. 

72. Select 14 > BASE in the Second slope node 1 drop-
down list and select 8 > DITCH in the node 2 drop-
down list. 

73. Enter SG in the Name cell. 

74. Select Subgrade under Material layers. 
75. Select Earthen (Select)>Flex Base in the Material above 

drop-down list. 

76. Select   in the Edit Corridor Template 
pane. 

Note:  You will notice that the left-hand Subgrade is now 
added and can be viewed in the plan view and cross-
section view to check for accuracy.  
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77. Scroll the slider of the cross-section view past station 
4+32.42. 

Note:  You can see the line that extends through the line 
of 4 > SHLD to 6 > DITCH.  We will have to add a Corridor 
Template to take care of station 4+32.42 to the end. 

 

78. Select the Insert Corridor Template  
icon in the Corridor area under the Corridor tab. 

79. Select Training Road in the Corridor drop-down list. 
80. Enter 4+32.42 in the Begin station cell. 

81. Select Copy definition in the Options drop-down list. 
82. Enter 4+32.42 in the Template name cell. 
83. Left-click on 0+00.00 , 0+00 in the Copy from template 

cell to highlight it. 

84. Select   in the Insert Corridor Template. 

Note:  The Edit Corridor Template pane will open for 
Station 4+32.42. 
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85. Left-click on the Slope/Slope instruction for 12 > BASE 
to 11 > BASE to select it. 

Note:  You will see the instruction in the Edit Corridor 
Template pane once the instruction is selected. 

86. Change the Second slope node 1 to 4 > SHLD and 
change the node 2 to 6 > DITCH. 

87. Select  in the Edit Corridor Template 
pane. 

Note:  You will notice that the line now terminates at the 
4 > SHLD to 6 > DITCH line correctly from station 
4+32.42 to the end. 

 

 

88. Select   in the Edit Corridor Template pane. 
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Corridor Surface Creation 
It is important to realize there are project settings that greatly impact the accuracy of the corridor surface that 
Business Center - HCE creates.  Turn on only the Training Road surface in the view filter manager and the plan 
view should look very similar to that of the image below.  Take notice of the density of the triangles that form the 
surface. 

 

1. Select  in the Panes area under the 
Project tab. 

2. Left-click on the Computations folder to expand it and 
Left-click on Corridor to select it. 

3. Enter 10 in the Maximum sampling distance cell. 

Maximum sampling distance = this represents the 
maximum distance along an alignment between 
automatically generated corridor templates.  The lesser 
the distance the more accurate the corridor surface, but 
also the larger the file. 

4. Select  in the Project Setting window. 

5. Pan and zoom in the Plan view to observe the surface.   

Note:  You will notice the triangles that form the surface 
are more dense, thus creating a more accurate surface. 
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6. Select the Corridor in the Plan view by left-clicking on 
it. 

7. Right-click in the graphical view and select Properties. 
8. Scroll-down in the Properties pane until the 

Densification section appears. 

9. Left-click in the Densify Surface cell and select Yes. 
10. Ensure that the Tolerance set to 0.010’.   

Note:  This value says that if the error between the 
surface created and the surface intended is greater than 
0.010 then more triangles are created and added to the 
surface until the surface is within this value.  

11. Select  in the Properties Pane. 

Note:  Notice the mesh of triangles forming the surface 
is more dense in this region – creating a surface that 
meets the tolerances specified in the properties. 
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Corridor Takeoff Reporting 
The Corridor Earthwork Report in Business Center - HCE is used to calculate the following  values: 

• Accumulated bank excess/deficit volume 

• Accumulated cut and fill volumes at each station 

• Subgrade Material Quantities – Asphalt, Flex Base, etc. 

1. Select the Reports  icon in the Reports area under 
the Project tab.  

2. Select Corridor Earthwork Report from the Reports 
drop-down list. 

3. Select Training Road in the Corridor drop-down list. 

4. Enter 50 in the Station increment cell. 
5. Ensure that the Only include subsection box is 

unchecked. 

Note:  If only a portion of the corridor is desired to be 
reported on then the checkbox for “only include 
subsection” should be checked.  Then a start and end 
station for the reporting parameters could be defined. 

6. Select Account for shrinkage and bulkage and Account 
for curve adjustment by placing a checkmark in their 
boxes. 

Account for shrinkage and bulkage = select this since 
we defined a native material for the corridor and 
associated material properties to the On-Site Clay in the 
MSI Manager. 

Account for curve adjustment = select this to more 
accurately account for volumes due to the larger areas 
of earthworks on the outside of curves. 

Include horizontal alignment points = select this to 
report cut/fill volumes at horizontal alignment points of 
intersection. 

Include vertical alignment points =  select this to report 
cut/fill volumes at vertical alignment points of 
intersection. 

7. Select  in the Corridor Earthwork Report 
pane. 
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8. Scoll through the report. 

Note:  The total fill supplied is 309.6 cy less than the total available bank cut available.  Remember that the 
shrinkage factor for the On-Site Clay material was 8%.  The total fill supplied is equal to 92% of the total 
available bank cut and accounts for the shrinkage property. 

Note:  The subgrade quantities table displays the total volume of Asphalt and Flex Base as defined by the 
corridor templates created. 
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Note:  At each station an area value is given that shows the total area of cut and total area of volume 
required in that station range. 

Note:  In the volume columns the following values are displayed. 

Available Bank Cut = the volume of material available in its natural or in situ state. 

Fill Supplied = this value is obtained by multiplying the usable in situ bank cut by the material’s shrinkage 
factor. 

Fill Required = this value represents the compacted fill required and is reported in its in-place density state. 

Excess/Deficit = the excess or deficit of material at this station range. 

Accumulated Excess/Deficit = The total excess or deficit of material from the beginning of the corridor to 
this station. 
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Corridor Exporting to Trimble GCS900 
 

1. Select  in the Data area under the Project tab. 
2. Left-click on the Construction tab to select it and then 

left-click on the Machine Job Site Design exporter. 

3. Select Road surface in the Model type drop-down list. 

Note:  By selecting Road surface instead of simply a 
surface you have the ability to export an alignment with 
the road surface. 

4. Select Training Road in the Surface drop-down list. 

Note:  If this surface was not densified a warning would 
be present in the form of a yellow dot. 

5. Select Training Road in the Alignment drop-down list. 
6. With the curser in the Objects to add or remove cell, 

left-click on the Corridor: Training Road in the plan 
view to select it and select  . 

Note:  The design map is the linework that gets exported 
and displayed on the CB460 for the operators reference. 

Note:  Notice that the corridor was ignored and no 
linework was added.  The corridor needs to  be exploded. 
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7. Left-click on the Project Explorer tab to bring up the 
Project Explorer pane. 

8. Ensure the Corridor: Training Road is still selected. 

9. Select  in the Edit area under the Edit tab. 

10. Select   in the Explode pane. 

Note:  Notice that all of the nodes created in the corridor 
template are now available to be selected individually in 
the plan view. 

 

11. Select   in the Explode pane. 
12. Left-click on the Export tab at the bottom of the Pane 

View, if the Export pane is not already visible. 

13. Select   under Design Map. 

Note:  You will now notice that the Selected: 22 items 
are now added in the Number of objects. 

14. Enter Training Road in the File Name cell and then 

select  . 
15. Navigate to the Project Folder location via Windows 

Explorer. 

Note:  The following machine control files are now 
present: 

Training Road.svd (surface file) 

Training Road.svl  (linework file) 
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Site Takeoff 

Welcome 
Welcome to the Trimble® Business Center – Heavy Construction Edition (HCE) Site Takeoff Module.  The site take-
off module incorporates tools that enable users to perform a site take-off quickly and with accuracy.  This is 
typically for pre-construction estimating purposes.  Business Center - HCE allows for the import of multiple file 
types that are used to create original ground and finished design surfaces.  General contractors have the ability to 
assign site improvements to the finished design to accurately estimate all material and site improvement 
quantities in addition to mass earthwork quantities.  Alternatively, an earthwork contractor whom does not have 
interest in any quantities other than mass earthworks can apply simple subgrade adjustments to the finished 
design to quickly obtain a subgrade surface.  The subgrade surface is then compared to the original ground surface 
to get the mass earthwork quantities. 

Overview 
The assortment of commands available in the site take-off module can be divided into three categories; data 
organization and layering, material and site improvement identification, and earthwork take-off. 
The first step is to organize the imported data and filter out any unnecessary data.  This is done by standardizing 
layering conventions, mapping layers from their source to the user’s standardized layering convention, and to 
categorize these standardized layers as containing objects that comprise the original ground and finished design 
surfaces. 
After the data is organization, users must build or import a Material and Site Improvement library (MSI).  This is 
where all materials “native and man-made” that will be utilized during the construction phase are defined.  These 
materials are used in the MSI to define site improvements. For an example, let us consider a building pad.  The 
building pad consists of 12” of sand, 6” of gravel and 12” of 3000 PSI concrete.  This means that the building pad 
site improvement consists of the materials sand, gravel and 3000 PSI concrete.   
Once all of the site improvements are added to the MSI library for the project, users will be able to assign them to 
the appropriate areas of the project.  
Take-off commands are then used to define topsoil stripping, topsoil replacement, and over-excavation areas.  
Take-off commands are also available to define the earthen strata that will be encountered on the site and to 
create boring logs.  We create boring logs to represent locations where core sample data exists which describe the 
existing strata of earthen materials on the job site.    
You can also generate a take-off report that quantifies mass earthwork material volumes, topsoil material volumes 
and area, site improvement volumes and area, and material quantities.  This data can be output in a number of 
different ways determined by the user’s needs. 
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Objectives 
• Import a PDF image 

• Digitize linework from a PDF 

• Understand layer categorizing 

• Understand layer protection 

• Utilize the Material and Site Improvement Manager 

• Assign site improvements 

• Understand and build takeoff surfaces 

• Utilize takeoff reporting 

Site Take-off Commands Defined 
Standardize Layers – Manually move imported objects from their source layers onto the appropriate standard 
layers that you use for every project. When using this command and picking an object, all of the data on that 
object's source layer is selected.  Then you can relayer those selected objects onto the desired standard layer.   
Map Layers – Use the Map Layers command to move imported data from its unfamiliar source layers onto your 
organization’s standard layers. These standard layers can be assigned to takeoff categories, and appropriate site 
improvements that are defined within the external material and site improvement library. When doing multiple 
projects with similar layering standards, this command automates layer mapping. 
Categorize Layers – To prepare for takeoff calculations you have to assign the layers that your objects reside on to 
different categories.  The four categories are Original, Design, Utility and Unused.  The “Contains Potential 
Boundary Lines” also resides within this command. 
Contains Potential Boundary Lines – Checking this makes the lines on the layer usable as site region boundaries in 
the Identify Site Regions command. 
MSI Manager – All materials and site improvements encountered on-site are defined here.   Native earthen 
materials (clay, rock,topsoil,etc.), earthen select materials (flex base, sand, etc.), and man-made materials 
(concrete, pvc pipe, rebar) are all defined along with their associated material properties.  Site improvements 
consisting of these materials and are defined here as well. 
Identify Site Regions – This command assigns site improvements that were defined in the MSI Manager to the 
appropriate areas of the project. 
Validate Areas – Confirm that the regions identified for site improvements are correct by uniquely shading each 
region. 
Name/Label Site Regions – Name and label the site improvement regions for reporting and plotting purposes. 
Configure Subgrade – Instead of using the MSI Manager, this is an alternative command that can be used to 
account for site improvement thicknesses to generate an accurate subgrade surface.  This is normally used by 
earthworks contractors that are only concerned with mass earthworks quantities. 
Define Areas of Interest – This command allows users to define an area of interest with a closed line.  During 
takeoff reporting, you can then generate quantities solely based on the defined area of interest as opposed to the 
entire project. 
Define Topsoil – This command is used to define areas of topsoil stripping, the material that is being stripped, and 
the thickness of the material to be stripped.   
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Use Excess Topsoil – After defining topsoil stripping areas and topsoil replacement areas, this command is used to 
define non-structural fill areas on site that excess topsoil can be utilized as fill instead of exporting at a higher cost. 
Overexcavation – Use the Overexcavation command to create a surface to represent the result of excavation 
within areas that need to be cut below an intended finished or subgrade surface (overexcavated). This is typically 
done to accommodate layered replacement and compaction of the excavated material in controlled lifts as 
needed to achieve a specified material density to a designated depth. 
Define Strata – Define the earthen material strata that exist on your job site to make the depths and thicknesses 
for each stratum definable when you create boring logs.  
Create Boring Log – Create boring logs to represent locations where you have core sample data describing the 
existing strata of earthen materials on the job site. Before you create boring logs, define the strata that was 
encountered on-site. Once you specify the top elevation, or depth and thickness of each stratum for each boring 
log location; the depth surfaces are then created which enables you to calculate subgrade material volumes in the 
Takeoff Report. 
Build Surfaces – Build or update the surfaces that are automatically created by certain takeoff commands or when 
you have made changes to layers, site improvements, boring logs, topsoil areas, or objects that affect those 
surfaces.  

Takeoff Report – Use this command to generate a concise takeoff report.   

Files Needed 
For the training exercises, each user should save the following files provided by your Certified Trainer onto their 
PC and note the location. 

• Office Park.pdf 

• Office Park.mxl  

Import a PDF Image 
A PDF image is one of many file types that Business Center - HCE accepts.  In order to perform a takeoff we need 
to build multiple surfaces that the program can then compute volumes for or between them.  A few examples of 
these surfaces are the original ground, finished design, and subgrade surface.  As opposed to starting from scratch 
building all the linework and the subsequent surfaces, we will import a PDF image into Business Center - HCE and 
utilize this data as our starting point. 
You can import data in the following ways: 

• Drag and drop the files into the graphical view of Business Center - HCE. 

• Use the Import command in the project ribbon.  
There are two types of PDF documents, which are the vector PDF and raster PDF.  A raster PDF document is simply 
an image composed of colored pixels and does not have intelligent data.  Once it is imported and placed users 
must use the Digitize commands to create the digital linework necessary to complete a site takeoff.  A vector pdf is 
an image that is composed of lines, dashed lines, and text that is intelligent.  This means that the vector pdf image 
can be imported, placed, and scaled the same as a raster PDF.  Then you can run the Import Vector PDF Data 
command and all the linework in the pdf image is converted into digital linework.    
For this exercise, we will utilize the importer to demonstrate all the settings available during the import process. 

Note:  Importing a pdf image is one way to get started performing a takeoff and is used as the example in this 
exercise because often times CAD drawings are not accessible to contractors during the estimating phase.  
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Realize that CAD files, landxml, and other file types can also be used as a starting point.  Reference the Help 
utility in Business Center - HCE to see all the supported file types. 

1. Open Business Center - HCE and start a new 
project.   

2. Select the template for US Survey Foot. 

3. Select the  icon in the Data area under the 
Project Tab. 

Note: You can also select the Import  icon from 
the Quick Access Toolbar . 

 

4. Left-click on the Office Park.pdf  file to highlight it 

and select . 

Note: You may have to use the   button to 
select the folder where the Office Park.pdf file is 
saved on your PC. 
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5. Left-click on Line with distance and bearing under 
Method to select it.  

6. Enter 650 in the Distance cell under Known 
Distance. 

Note:  The Place Image command must be 
performed in order to scale and rotate the .pdf 
properly.  There are three methods for scaling and 
rotating the data.   

Known distance – you enter the distance of a 
line and then select the beginning and ending 
pixels.  
Line with distance and bearing – The known 
distance method is utilized and the bearing of 
the line is used to rotate the data. 
Scale bar and known bearing - Utilize this to 
specify the known distance as well as a bearing 
between two pixels. 

 

 

7. With the cursor positioned in the From pixel cell, select the start point for the line dimensioning the site 
north of the building pad. 

8. With the cursor positioned in the To pixel cell, select the other end of the same line. 
9. Enter 90 in the Bearing cell under Known Bearing. 

10. Select   and the linework from the imported PDF will now be scaled and rotated correctly. 

11. Select  to close the Place Image work panel and do the same for the Import work panel. 
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Digitize the Image 
Since the Office Park.pdf is a raster PDF image we will need to digitize the linework in, that will eventually be used 
to build all of the necessary takeoff surfaces and represent material quantities such as storm sewer pipe.   It is 
important to think about what surface each line will be used to build when digitizing, so that they can be properly 
layered.  By organizing the data while digitizing, you will keep it organized and make life easier later on.  For this 
exercise, we will have an Original Ground, FD Contours, FD Building Pad, FD Parking Lot, and Utilities layer. 

Tip:  When creating the layers that the digitized data will be placed on, always enable layer protection.  This 
designation prevents the layer from being renamed or deleted. 

12. Select   under Panes in the 
Project tab. 

13. Expand the Imported Files to view the Office 
Park.pdf. 

Note:  You can tell if this PDF is a Raster PDF or 
Vector PDF by looking at the icon.   

 = Raster PDF Image 

= Vector PDF Image 

In the case of the Office Park.pdf file, it is a Raster 
PDF.  

 

1. Select the Digitize Contour   icon in 
the Digitize area under the Takeoff Tab. 

Note: Original Ground linework is shown with the 
green dashed lines in the plan view and Finished 
Design Ground linework is shown with the blue 
solid lines.  When Digitizing Contour lines it is good 
practice to start on one side of the project and 
work your way across.  
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2. Enter Contour in the Name cell.   
3. Select the drop-down arrow in the Layer cell and 

create a new layer with the following settings.   

Layer name:  Original Ground  
Color:  Blue 
Line style:  Solid 
Line weight:  0.50mm  
Protect Layer:   

4. Select  in the New Layer window. 

5. Enter 2 in the  Contour Interval cell. 

Note:  This is determined by looking at the 
elevation change between two contours on the 
plan set.   

6. Left-click on Up under Increment direction to 
select it. 

7. Left-click on Set Increment after each contour to 
add a checkmark to its box. 

8. Enter 456 in the current elevation cell. 
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9. With the cursor in the Digitize Next Points cell,  
zoom into the 456 contour in the plan view. Left-
click where it begins.   

10. Continue to trace the line and left-click where the 
contour changes directions.   

Note:  You will begin to see the blue line be created 
over the dashed green line from the image.  The 
screen will also Auto Pan when you click on the line 
close to the edge of the screen.  You can also trace 
the line by just holding down on the left-click and 
following the line. 

11. Continue to trace the line until you get to the end 
of the 456 contour line. 

12.  Select  in the Digitize Contour 
pane.   

Note:  The current elevation is now 458’ and the 
layer is still Original Ground.   

13. Repeat steps 8 through 11 until all of the Original 
Ground green-dashed contour lines have been 
digitized into the project. 

 

14. Go to the View Filter Manager and turn off the 
Georeferenced Image by unchecking the box.  

Note:  The plan view on your screen should look 
similar to this. 
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15. In the View Filter Manager turn the 
Georeferenced Image back on by checking the 
box and turn off the Original Ground layer by 
unchecking the box. 

16. Select the Digitize Contour tab at the bottom of 

the Work Pane or select   in the 
Digitize area under the Takeoff tab. 

17. Enter FD Contour in the Name cell. 
18. Select the drop-down arrow in the Layer cell and 

create a new layer with the following settings.   
Layer name:  FD Contour  
Color:  Red 
Line style:  Solid 
Line weight:  0.50mm  
Protect Layer:   

 

19. Select  in the New Layer window. 

20. Enter 2 in the  Contour Interval cell. 

Note:  This is determined by looking at the 
elevation change between two contours on the 
plan set.   

21. Left-click on Down under Increment direction to 
select it. 

22. Ensure that Increment after each controur has a 
checkmark in its box. 

23. Enter 470 in the Current elevation cell. 
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24. With the cursor in the Digitize Next Points cell,  
zoom into the 470 contour in the plan view. Left-
click where it begins.   

Note:  The 470 Contour is on the East side of the 
page. 

25. Repeat the same Digitizing process that we 
performed on the Original Ground lines with all 
of the Finish Design Ground lines. 

Note:  The Finish Design Ground lines are solid 
blue.   As you trace the line you will see a solid red 
line show up on top of the blue line on the image. 

 

26. After all FD Contours have been created, select  

. 
27. Go to the View Filter Manager and turn off the 

Georeferenced Image by unchecking the box.  

Note:  The plan view on your screen should look 
similar to this. 
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28. In the View Filter Manager turn the 
Georeferenced Image back on by checking the 
box and turn off the FD Contour layer by 
unchecking the box. 

29. Select the Digitize Pad  icon in the Digitize 
area under the Takeoff tab. 

30. Enter Building Pad in the Name cell.  
31. Select the drop-down arrow in the Layer cell and 

create a new layer with the following settings.   
Layer name:  FD Building Pad  
Color:  Orange 
Line style:  Solid 
Line weight:  0.50mm  
Protect Layer:   
   

32. Select  in the New Layer window. 

33. Leave the Vertical Offset at 0. 
34. Enter 467 in the Elevation cell. 

Note:  The elevation of 467’ is from the title in the 
building on the plans. 

35. Digitizing the building pad using the same process 
as used with the contours. 

Note:  Business Center - HCE knows that a pad is a 
closed polygon so after selecting the four corners 
of the pad it auto-closes the line for you. 

36. Once the pad is Digitized select . 
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37. Select  in the Digitize area under the 
Takeoff tab.   

Note:  This command is used when bringing in any 
line that does not have a constant elevation. 

38. Enter Parking Lot in the Name cell. 
39. Select the drop-down arrow in the Layer cell and 

create a new layer with the following settings.   

Layer name:  FD Parking Lot  
Color:  Green 
Line style:  Solid 
Line weight:  0.50mm  
Protect Layer:   

40. Select  in the New Layer window 
41. With the cursor in the Digitize Next Points cell, 

Left-click where right side driveway begins.  
42. Left Click on the driveway line next to the 460.97 

spot elevation and then enter 460.97’ in the 
Digitize Elevation Cell. 

Note: After entering the elevation you can put the 
curser back in the Next Point by hitting Tab or left 
clicking in the cell. 

43. Digitize the parking lot and driveway with the 
same process as the Contours and Building Pad. 

Note: Make sure to click on each spot elevation 
that is encountered.  Enter the elevation of the 
spot elevation right after clicking on it.  

44. After Digitizing the Parking lot is completed, 

select . 
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45. Select the Explore Object  icon from the Quick 
Access Tool Bar. 

46. Left-click the Parking Lot line to select it and 
double-check the elevations are correct by 
moving the cursor along the newly created 
linestring. 

Note:  You will want to confirm all the spot 
elevations around the Parking Lot to make sure 
they were  entered correctly. 

47. Select   once all elevation checks on 
the Parking Lot are done.  

48. In the View Filter Manager turn the 
Georeferenced Image off  by unchecking the box 
and turn on all layers by checking the box next to 
the Group Layers. 

Note:  You may have to select the box in front of 
the Layers Group twice because the first selection 
may turn off all layers. 
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49. In the View Filter Manager turn the 
Georeferenced Image back on by checking the 
box and turn off all layers by unchecking the box 
next to the Group Layers. 

50. Select the Digitize Linestring  icon in 
the Digitize area under the Takeoff tab.   

51. Enter Storm Sewer in the Name cell. 
52. Select the drop-down arrow in the Layer cell and 

create a new layer with the following settings.   
Layer name:  Utility – Storm Sewer  
Color:  Cyan 
Line style:  Solid 
Line weight:  0.50mm  
Protect Layer:   

53. Select  in the New Layer 
Window. 

54. With the cursor in the Digitize Next Points cell, 
left-click the start point of the storm sewer in the 
NE Corner. 

55. Enter 458.50’ in the Elevation cell. 

Note:  The 458.50’ elevation comes from the out 
elevation of the Storm Sewer in the NE Corner. 

56. Left-click the end point of the storm sewer to the 
West and enter 456.50’  for the elevation. 

Note:  The 465.50’ elevation comes from the IN 
elevation on the Storm Sewer to the West. 

57. Select  and repeat this process for 
all of the storm sewer lines. 

 

58. After Digitizing the Storm Sewer is completed, 

select . 

59. Select the Explore Objects   icon from the 
Quick Access Tool Bar. 

60. Select each of the Storm Sewer lines and double-
check the In and Out elevations are correct by 
moving the cursor along the linestring. 

61. Select   once all elevation checks on 
the Parking Lot are done. 
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Categorize Takeoff Layers 
The next step in preparing for takeoff calculations is to assign the layers that your objects reside on to different 
categories.  The layers should be assigned to one of the following categories:  

• Original – All layers that contain Original Ground data should be assigned to this category.  These layers 
will ultimately make up the Original Ground takeoff surface. 

• Design – All layers that contain Finish Design data should be assigned to this category.  These layers will 
make up the Finish Design takeoff surface. 

• Utilities – Assign layers that will be used to calculate utility site improvement quantities but do not 
contribute to the formation of a takeoff surface to this layer. 

• Other – Assign layers that contain data you do not want to use in forming takeoff surfaces but also do not 
want to delete to this layer. 

• Unknown – This is the default category that all layers are assigned to and layers with this category are not 
used to form any takeoff surfaces. 

• Unused – All layers that are unneeded and that you ultimately intend to delete 

For example, all the data on layers that are assigned to the Finish Design category will be utilized to build the 
Finish Design takeoff surface.  Remember that in Business Center - HCE we work with data from an array of 
sources.  Often CAD files will have multiple layers that comprise the Original Ground surface and Finish Design 
surface.  In our case, since we digitized the data in we were able to control what layers the data was assigned to. 

1. Select the Categorize Takeoff Layers  
icon under Layers on the Takeoff Tab. 

Note:  That by default all of the layers are listed 
under the category Unknown.   
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2. Left-click the box for the Original Ground layer to 
add a checkmark.  

3. Select Original in the Reassign layer drop-down 

list and then select  . 

Note:  The Original Ground layer is no longer under 
the Unknown category and has been reassigned to 
the Original category. 

4. Left-click the boxes for layers FD Building Pad, FD 
Contour and FD Parking Lot to add checkmarks. 

5. Select  Design in the Reassign layer drop-down 

list and then select  . 
6. Left-click the box for Utility – Storm Sewer to add 

a checkmark. 
7. Select  Utilities in the Reassign layer drop-down 

list and then select  . 
8. Left-click the boxes for the remaining layers to 

add checkmarks. 
9. Select  Other in the Reassign layer drop-down list 

and then select  . 

Note:  All the layers have now been categorized 
correctly, and the Original Ground and Finished 
Design takeoff surfaces were automatically 
created.  Open the Project Explorer and observe 
the surfaces that were created. 

10. Select   on the Categorize Takeoff 
Layers. 

 

11. Select the Build Takeoff Surfaces  icon in 
the Takeoff area under the Takeoff Tab. 

Note:  The Surfaces are now created but still are 
still not visible in the plan view. 
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12. Open the Project Explorer and Expand the 
Surfaces. 

13. Right-click on Finished design and select 
Properties. 

 

14. In the Properties Pane under Show in Plan View 
change the Wireframe, Vertices, and Breaklines 
to Yes. 

15. In the Properties Pane under Show in 3D View 
change the Wireframe, Vertices, and Breaklines 
to Yes. 

Note:  As soon as you change these to Yes , you will 
see the Surface appear in the Plan View. 

16. Select   on the Properties Pane. 
17. Open the Project Explorer and Expand the 

Surfaces. 
18. Right-click on Original ground and select 

Properties. 
19. Repeat Steps 14 through 16 for the Original 

Ground layer. 

Note:  The Surface Layers can be very distracting 
being visible but you can turn them off under View 
Filter Manager by unchecking them. 
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Material and Site Improvement Manager 
When preparing for takeoff calculations it is necessary to define the materials and site improvements that will be 
used in determining the earthwork volumes and the quantities of objects to construct.  These are defined in 
Business Center - HCE as: 

• Material – a naturally occurring or manufactured substance from which a site improvement can be made at a 
construction site.  Examples include soil, rock, sand, flex-base, limestone, cement concrete, asphaltic concrete, 
PVC pipe, and ductile iron. 

• Site Improvement – an object that is built out of materials on a construction site.  Examples include curbs, 
sidewalks, parking lots, and building pads. 

Now that the Original Ground and Finish Design surfaces have been created we need to assign Site Improvements 
and Materials to different regions of the site so that we can accurately account for all material quantities in the 
takeoff report.   

Business Center - HCE utilizes an MSI Manager to define all the materials that will be encountered on a 
construction project both native and manufactured.  You will use the materials to also setup site improvements. 

Based on our plans the following materials and site improvements are on-site: 

Materials 

• Ashpalt 

• Concrete 

• Flex-Base 

• 12” Storm Sewer Pipe 

• Topsoil 

• Subsoil 

• Rock 
Site Improvements 

• Parking Lot and Drive 

• Building Pad 

• Storm Sewer 

• Topsoil Replacement 

1. Select the Material and Site Improvement 

manager   icon under Site Improvements on 
the Takeoff tab.   

Note:  This will open the Material and Site 
Improvement Manager in a new window. 
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2. Select File and then Open External Library. 
3. Open the Office Park.mxl  file. 

Note:  You may have to navigate to the location on 
your PC where you saved the file.  Once Open, the 
External Library will have items loaded to it. 

4. Expand the External Library, then Materials, and 
then Asphaltic Concrete.   

5. Left-click on Type III to Highlight it. 
6. Enter 85 in the Procurement unit cost cell. 

Note: This material uses volume as its 
measurement and the units are Cubic Yard.   

7. Select Gray in the Color drop-down list.  

8. Expand the Pipe category and left-click the 12” 
PVC – C900 material to highlight it. 

Note:  The measurement for pipe is a length.  The 
units are US Survey Foot but can also be modified 
depending on the scope of the project.  Explore the 
shading options and edit the procurement cost to 
mirror your region. 

 

9. Expand the Earthen (Mass Earthworks) materials 
and left-click the Fine Sandy Clay material to 
highlight it. 

10. Left-click Soil Properties and change the Percent 
Usable for Fill value to 100%.   

Note:  This setting allows users to input what 
percentage of a native material is suitable to be 
used as fill.  You can also edit the shrinkage, 
hauling bulkage, and hauling compaction values to 
mirror a sub-soil native to their region. 
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11. Right-click the Earthen (Mass Earthworks) 
category and select New Earthen (Mass 
Earthworks) Material. 

12. Enter Topsoil for the Name of the material. 
13. Select Topsoil in the Material Nature drop-down 

list.  
14. Select Topsoil Properties and change this to 

Usable for Topsoil Replacement. 

Note:  You can specify whether or not the existing 
topsoil is suitable to be respread as topsoil after 
mass earthworks are completed. 

15. Select Green in the Color drop-down list. 
  

16. Under External Library expand the Site 
Improvements category and then Building 
Foundations. 

17. Left-click on  Commercial Slab to highlight it. 
18. Enter 13 in the Installation price cell.   

Note:  The Bid Unit Price automatically updated.   

19. Left-click on the cell next to Subgrade in the 
material column under Site improvement 
material layers. 

20. Select Earthen (Select):Flex Base from the drop-
down list. 

21. Left-click on the cell for the Subgrade Thickness 
under Site improvement material layers and 
enter 6. 

Note:  We changed the type and thickness of the 
Subgrade to match the plans which require 6” of 
Concrete and 6” of Base. 

 



Page | 141  
 

Assigning Site Improvements to Regions of the Project 

All of the necessary materials and site improvements have been added to the project and we have changed the 
display and cost parameters to meet our needs.  It is now time to assign Site Improvements to different regions of 
the project so that Business Center - HCE can accurately perform takeoff calculations. 

There are two methods for assigning Site Improvements.   

• Categorize Layers – when categorizing layers, site improvements can be assigned to apply to individual layers. 

• Identify Site Regions 

We will utilze both methods in this exercise. 

22. Expand Pavement and left-click on the Light Duty 
Parking Areas to highlight it. 

Note:  Review your plans to make sure the site 
improvements meets the specification on the plan. 

23. Left-click on the Asphaltic Concrete: Type III 
Thickness (Inch) cell under Site Improvement 
material layers and enter 2. 

Note:  If you have more Site Improvements on you 
plan you will want to check each one to make sure 
it meets the specifications on the plan. 

 

24. Right-click on Light Duty Parking Areas 
underneath the Pavement Site Improvements in 
the External Library, and select Copy from 
External Library. 

Note:  When you copy a Site Improvement from an 
External Library, you will also copy all Materials 
used in that Site Improvement. 

25. Repeat Step 36 for each of the Materials or Site 
Improvements that are utilized on this project. 

Note:   Only materials and site improvements in 
the Project Library are available to use in the 
current project.   

 

26. Select   on the Material and Site 
Improvement Manager window. 
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1. Select the Categorize Takeoff Layers  icon 
in the Layers area on the Takeoff tab. 

2. Left-click the Design Tab in the Categorize Takeoff 
Layers pane. 

3. Left-click the box for the FD Parking Lot layer to add a 
checkmark. 

4. Select . 
5. Select Pavement: Light Duty Parking Areas and select 

. 
Note:  You will not be able to see the new surface with 
the subgrades adjusted until you Build Surfaces and then 
turn on the views on under the Surface Properties by 
going to Project Explorer.  We did this process earlier in 
the Categories Takeoff Layers section. 

 

6. Left-click on the Utilities Tab in the Categorize Takeoff 
pane. 

7. Left-click on the box for the Utility – Storm Sewer to 
add a checkmark. 

8. Select . 
9. Select Storm Sewer: 12” Storm Sewer and select 

. 

Note:  An icon appears between the layer name and the 
check box once site improvements are applied.  The 
icons indicate the type of site improvement that was 
applied.  In this instance, it is a linear based site 
improvement. 

 

10. Left-click on the Design Tab in the Categorize Takeoff 
Layers pane. 

11. Left-click the box for the FD Building Pad layer to add a 
checkmark. 

12. Left-click the box for Contains Potential Boundary 
Lines.   
Note:  There is a green check mark beside the layer 
indicating that we can now manually assign site 
improvements to any boundaries on that layer. 
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13. Select  in the Site Improvements 
area on theTakeoff tab. 

14. Left-click on Design under Select Takeoff Category to 
select it.  

Note:  There are 2 potential boundary line objects. 

15. Left-click on the Highlight all potential boundaries box 
to add a checkmark. 

Note:  This is selected so that it is easy to determine 
what boundaries are available to use in the plan view. 

16. Select <<New Layer>> from the Layer drop-down list. 
17. Enter Site Improvements in the Name cell and select 

.   

Note: This will be the layer that we place the site 
improvement’s seed point on.  It is useful to keep all the 
seed points on one layer. 

18. Ensure that Identify Region is selected under the Site 
region identification. 

Note:  If we wanted to remove a site improvement then 
we would select Remove Identity here. 

19. Select the Building Foundations: Commercial Slab in 
the Site improvement drop-down list. 

20. Enter Building Pad in the Name cell under Site 
improvements. 

21. With the cursor in the Location cell, left-click within 
the building pad boundary in the plan view. 

Note:  If properly applied, the color of the building pad 
will shade in with the color of the uppermost material of 
the site improvement.  In this example, it is the color 
that was specified in the MSI for the 3000 PSI Concrete 
material. 
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Topsoil Handling 
The parking lot, building pad, and storm sewer site improvements have all been successfully added.  One last site 
improvement that we must add is the respread of 6” of topsoil in all areas of the site outside the parking lot and 
the building pad.  This is accomplished by using the Identify Site Regions command as well.  But first, let us verify 
that the 6” of topsoil respread site improvement is correctly configured in the MSI Manager.  In this exercise the 
following workflows will be covered: 

• Identifying topsoil respread area 

• Defining topsoil stripping areas 

• Using Excess Topsoil in non-structural fill areas. 

22. Notice that the Parking Lot site improvement is not 
shaded.   

Note:  You can tell that the site improvement was not 
applied because the parking lot is not shaded. 

23. Select  on the Identify Site Regions pane. 

24. Select  on the Categorize Takeoff Layers 
pane. 

25. Left-click on the boundary of the parking lot to select 
it.   

Note:  The parking lot boundary is not a closed line. This 
means that it is not a valid boundary for an area-based 
site improvement. 

26. Right-click in the graphical view and select Edit. 
27. Left-click on the Auto-close box to add a checkmark 

and select . 

Note:  The lines ends will connect and in this example it 
is at the entrance to the drive on the south portion of 
the project. 

 

28. Select  in the Site Improvements 
area on theTakeoff tab. 

29. Left-click on Design under Select Takeoff Category to 
select it. 

Note:  The parking lot site improvement has now been 
applied and is indicated as such with the associated 
material shading being applied to the plan view.   

30. Select  on the Identify Site Regions pane.  
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1. Select the Material and Site Improvement 

Manager  icon under Site Improvements on 
the Takeoff tab.   

2. Expand the Project Library, then Site 
Improvements, and then Landscaping/Topsoil.  

3. Left-click on 6” Topsoil Replacement and Sod. 
4. In the Site improvement material layers section 

ensure the material is Landscaping: Sod. 
5. Left-click in the Landscaping: Sod Thickness cell 

and enter 1. 
6. Ensure the Topsoil Replacement Requirements is 

set to Earthen (Mass Earthworks):On-Site 
Topsoil and that the thickness is 6”.  

7. Select Edge Properties.  

Note:  Business Center - HCE offers two options to 
handle the edge of topsoil replacement where it 
meets structural fill. 

Vertical – produces a vertical edge where a 
structural fill area meets a nonstructural fill 
area. 
Sloping – Produces a sloping edge where 
structural fill meets non-structural fill areas.  

Note:  This allows you to account for these 
situations during the takeoff and modeling phase 
when plans specify these scenarios. 

8. Left-click on Vertical to select it. 

9. Select  on the Topsoil Edge 
Properties window. 

10. Select  on the Material and Site 
Improvement Manager window. 
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11. Turn on all FD Layers in the View Filter Manager. 

Note:  There is no boundary around the site.  The 
topsoil respreads site improvement is an area-
based site improvement and needs a valid 
boundary to be applied. 

 

12. Select  in the Create and 
Edit area on the Surface tab. 

13. Enter FD Surface Edge in the Name cell in the 
Create Surface Edge Breakline pane. 

14. Select the FD Building Pad in the Layer drop-
down list. 

Note: The edge that is being created here is 
eventually going to be a Potential Site 
Improvement boundary.  It is important to add it 
to a layer that contains potential boundaries.  In 
this case the FD Contours layer would be 
problematic because all the contours would be 
considered boundaries in addition to the surface 
edge breakline. 

15. Select the Finish Design in the Surface drop-
down list. 

16. Select   in the Create Surface Edge 
Breakline pane. 
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17. Select  in the Site 
Improvements area on theTakeoff tab. 

18. Left-click on Design under Select Takeoff 
Category to select it. 

19. Select Site Improvement in the Layer drop-down 
list. 

20. Ensure Site region identification set to Identify 
region.   

21. Select Landscaping/Topsoil: 6” Topsoil 
Replacement & Sod in the Site improvement 
drop-down list under Site Improvements. 

22. Enter Landscaping/Topsoil: 6” Topsoil 
Replacement & Sod in the Name cell under Site 
Improvements.  

23. With the cursor in the Location cell, left-click 
inside the detention pond.   

Note:  The topsoil respread areas have now been 
identified and indicated with the color green in 
the plan view as shown here. 

24. Select  on the Identify Site Regions 
pane. 

 

25. Open the Project Explorer and expand the 
Surfaces.   
Note:  You will not be able to see the new surface 
with the subgrades adjusted until you Build 
Surfaces and then turn on the views. 

26. Select the Build Takeoff Surfaces   icon in 
the Takeoff area on the Takeoff tab. 
Note:  You will now see the FD with topsoil absent 
(& subgrades adjusted) surface under Surfaces.  It 
is still not visible in Plan or 3D views until you turn 
them on in the surface properties.   We did this 
process earlier in the Categories Takeoff Layers 
section. 
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27. Select  in the Lines area on the 
Data Prep tab. 

Note:  On this example we are stripping the 
topsoil 10’ outside of the design edge.  This means 
that we need to Offset the Boundary. 

28. Enter TS Stripping Boundary in the Name cell in 
the Offset Line pane. 

29. Select Original Ground in the Layer drop-down 
list. 

30. With the Curser in the Line to Offset cell, left-
click on the FD Surface Edge line.  

31. Enter 10 in the Offset distance cell. 
32. Left-click on the Side to offset and then left-click 

outside the FD Surface Edge Boundary. 

33. Select . 

Note:  To view the newly created offset line you 
will need to make sure the Original Ground Layer 
it turned on in the View Filter Manager. 

34. Select  in the Offset Line pane. 

 

35. Select the Define Topsoil Stripping Areas 
 icon in the Takeoff area on the 

Takeoff tab. 
36. Enter 5 in the Thickness cell. 
37. Select Earthen (Mass Earthworks) > On-Site 

Topsoil in the Native topsoil material drop-down 
list. 

38. With the curser in the Closed lines box, left-click 
on the TS Stripping Boundary in the Plan View to 
select it. 

39. Select   . 

Note:  You will now see a message saying that 1 
topsoil stripping area was added.  On complex 
construction sites multiple areas can be added. 

40. Select  on the Define Topsoil 
Stripping Areas pane.  
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Using Excess Topsoil 
Often times on construction projects there is more topsoil stripped than is specified to be respread.  Instead of 
hauling the excess off site and incurring that expense, it is more efficient to use the excess topsoil in landscaping 
areas that do not require structural fill.   

41. Open the Project Explorer and expand the 
Surfaces.   

Note:  You will not be able to see the new surface 
with the subgrades adjusted until you Build 
Surfaces and then turn on the views. 

42. Select    in the Takeoff area on the 
Takeoff tab. 

Note:  You will now see the OG with topsoil 
stripped (& subgrades adjusted) Surface under 
Surfaces.  It is still not visible in Plan or 3D views 
until you turn them on in the surface properties.   
We did this process earlier in the Categories 
Takeoff Layers section. 

 

1. Select  in the Takeoff area on the 
Takeoff tab.   

Note:  The areas that are eligible as locations to use the 
excess topsoil are shaded.  In this example there is only 
one eligible area. 
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2. With the cursor in the Site Improvement to 
Reconfigure cell, left-click anywhere in the green 
shaded area. 

3. Select Minimum Depth to Level Plane in the 
Configuration method drop-down list.  

Note: The following selections are available in the 
Configuration method drop-down list:  

Constant thickness –   select this to configure one or 
more instances of a site improvement to use a constant 
thickness of excess topsoil earth fill. When you view the 
finished design related surfaces in the Surface Slicer 
View, you will see that the total topsoil thickness is the 
topsoil replacement thickness plus this thickness. You 
will not see a surface separating the topsoil replacement 
material layer from the excess topsoil earth fill. 
Minimum depth to level plane –   select this to attempt 
to make a level plane (flat bottom) in the surface formed 
by the structural fill, at an elevation based on the lowest 
point found around the perimeter of the subject 
landscaping site improvement. This approach may allow 
you to reuse more excess topsoil, and it will simplify the 
grading in preparation for the placement of the topsoil.  
Maximum bottom elevation –  select this to specify the 
elevation at which the program will attempt to form a 
level planar bottom for the excess topsoil earth fill. As in 
the above method, this approach may allow you to 
reuse more excess topsoil, and it will simplify the 
grading in preparation for the placement of the topsoil.  

4. Enter 6 in the Depth (Inch) cell. 

5. Select  . 

Note: The color of the landscaping area in the plan view 
has changed to a darker green.  This indicates that this 
area has been designated to use excess topsoil. 

6. With the cursor in the Site Improvement to 
Reconfigure cell, left-click anywhere in the darker 
green shaded area. 

7. Select None for the Configuration method. 

8. Select  . 

Note:  For this example we are not going to use excess 
topsoil. 

9. Select  on the Use Excess Topsoil. 
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Overexcavation 
Often times engineers specify that building pads or other areas of a project must be overexcavated and layered 
replacement of structural fill be replaced.  Business Center - HCE has incorporated the Overexcavation command 
to account for these situations. 
Assume that a building pad overexcavation of 5’ below finish floor elevation has been specified. 

Defining Areas of Interest 
At times during the takeoff and site analysis phase of bidding a project, contractors are only interested in 
particular portions of the site.  Business Center - HCE allows you to define areas of interest to focus in on 
particular portions of the project. 
Let’s create an area of interest focusing in on the parking lot and one on the building pad.  As if we were an 
asphalt contractor or concrete contractor, and need to get material quantities. 

1. Select  in the Takeoff area on the 
Takeofftab. 

2. Enter 5 in the Specified overexcavation cell. 

Note:  This is the distance below the lowest finish design 
surface that you need to overexcavate, unless 
overridden by the Minimum beneath original ground, 
maximum depth beneath original ground, or Limit to top 
of stratum. 

3. Enter 2 in the Minimum beneath original ground cell. 

Note:  This specifies the minimum distance beneath the 
original ground that needs to be overexcavated. 

4. With the curser in the Closed lines box, left-click on the 
building pad to select it. 

5. Select   . 

Note:  You will now see a message saying that 1 
overexcavation area was added.  On complex 
construction sites multiple areas can be added. 

6. Enter 15 in the Maximum depth beneath orginal 
ground cell. 

Note:  This value specifies the deepest distance beneath 
the original ground surface that can be overexcavated. 

7. Select  in the Overexcavation pane. 
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1. Select  in the Site 
Improvement area on the Takeoff tab. 

2. Select . 
3. Enter Parking Lot in the Name cell and select 

. 
4. With the curser in the Closed lines to add or remove 

cell, left-click the parking lot boundary in the plan view 
to select it. 

5. Select . 

Note:  You will now see a message saying that 1 line was 
added to “Parking Lot” and the Parking Lot has changed 
to a peach color indicating that it is now defined as a 
area of interest. 
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6. Select . 
7. Enter Building Pad in the Name cell and select 

. 

8. Select  . 
9. Left-click on Design under Select Takeoff Category to 

select it. 

10. Select <<New layer>> in the Layer drop-down list. 

11. Enter AOI in the Name cell and select  . 
12. Left-click on Exterior under Horizontal offset to select 

it and enter 3 in the Horizontal offset cell. 
13. With the cursor in the Pick a shaded site improvement 

cell, left-click in the building pad in the plan view. 

14. Select . 

If you have the AOI layer checked in the View Filter 
Manager, you will now see the boundary created 3’ 
outside the building pad site improvement.  This new 
boundary can now be used to define an area of interest. 

15. Select  on the Create Boundary by Site 
Improvement. 

 

16. With the Building Pad Highlighted under Areas of 
Interest and the Curser in the Closed lines to add or 
remove cell, left-click on the outer boundary you just 
created for the building pad to select it. 

17. Select . 

Note:  An Area of Interest has just been created that is 
defined by a boundary 3’ outside the building pad site 
improvement, and is shaded a peach color. 

18. Select  on the Define Areas of Interest. 
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Validating Areas 
The validating areas command allows users to confirm that the regions identified for site improvements are 
correct by uniquely shading each region.  This is useful in offering a visual aid to users indicating where site 
improvements have been applied and essentially double-checking our work. 

1) Select the Validate Site Improvement Areas  
 icon in the Site Improvements area on 

the Takeoff tab. 

2) Left-click on Design under Takeoff Category to select it. 
3) Select Site Improvement in the Layer drop-down list. 
4) Enter 70 in the Fill transparency (%) cell. 

5) Select . 

Note:  Notice that the areas where site improvements 
have been applied are now shaded based on the upper 
most material layer of that site improvement. 

Note:  If you do not see the shaded site improvements, 
make sure you have the Site Improvements layer turned 
on in the View Filter Manager. 

Note:  This step is not necessary to perform a takeoff 
calculation but it is recommended as a way to double-
check and ensure that all areas have been accounted for 
on the project. 

 

6) Enter 30 in the Fill transparency cell. 

7) Select . 

8) Select Building Pad in the Areas of Interest. 

9) Select . 

Note:  The program now only validates the site 
improvement that is selected  in the Area of Interest 
drop-down list.   

10) Select [None] in the Areas of Interest. 

11) Select . 

12) Select  on the Validate Site Improvement 
Areas. 
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Name/Label Site Regions 
Use this command to name and optionally label site regions so you can report on their areas and cut/fill volumes 
individually in the Takeoff Report.  The types of regions you can report on include: area-based site improvements, 
landscaping/topsoil site improvements, and simple subgrade adjustments. 

Area/Length/Count Report 
You can elect to generate a Area/Length/Count report to quickly calculate: 

• Total number of objects in a selection. 

• The length of each open line in a selection. 

• The perimeter length of each closed line in a selection. 

• The area of each closed polyline in the selection, and the total of those areas. 

1) Select  in the Site 
Improvements area on the takeoff tab. 

2) Ensure the box for Label Site Improvement is checked. 
3) Select <<New layer>> in the Layer drop-down list. 
4) Enter Name_Label Site Regions in the Name cell and 

select . 

5) Select Agency 0.10 in the Text style drop-down list. 
6) Left-click on Generic area-based site improvements 

under Applicable Region Identities to select it. 
7) With the cursor in the site improvement region cell, 

left-click in the parking lot area in the plan view. 
8) Enter Parking Lot in the Name cell. 
9) With the curser in the Text insertion point cell, left-

click in the plan-view where the text should be placed. 
 

10) Label the Building Pad by repeating steps 2 through 9. 

Note: Once the Building Pad is labeled we will move 
onto labeling the Landscaping/topsoil Site 
Improvements. 

11) Left-click on Landscaping/topsoil site improvements 
under Applicable Region Identity to select it. 

12) With the curser in the Site improvement region, left-
click inside the Topsoil Replacement Site Improvement 
in the plan view. 

13) Enter Topsoil Respread in the Name cell. 
14) With the curser in the Text insertion point cell, left-

click in the plan-view where the text should be placed. 
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Takeoff Reporting 
Now that all the necessary steps have been performed in the takeoff workflow, it is now time to generate a 
Takeoff report to calculate  the following: 

• Mass earthwork material volumes 

• Topsoil material volumes and areas 

• Existing in-ground site improvement volumes and areas 

• Site improvement volumes and areas 

• Site improvement quantities 
The Takeoff Report automatically reports on the differences between the specialized takeoff-generated surfaces, 
each of which were formed in the previous exercises.  The report uses any data, including costs, that may be 
available prior to start of construction, to help in preparing for the job bidding process. 

1. In the View Filter Manager, turn on layers FD Building 
Pad, FD Parking Lot, and Utilities – Storm Sewer. 

2. Select the Area/Length/Count Report  icon in the 
Reports area on the Takeoff tab. 

3. Select  next to the Object cell and then 
Select All.   

Note:  All the objects on the layers turned on are now 
selected. 

4. Select Only Specified Categories in the Categories to 
include drop-down list. 

5. Check the boxes for areas and lengths and uncheck the 
box for Counts by left-clicking on the boxes. 

6. Left-click on the Load Data into Excel under Output 
Options to select it. 

Note:  If preferred, the data can be saved to a .csv file or 
dispayed in the report viewer. 

7. Select . 

Note:  The area/length/count report is launched in Excel.  
The report is a quick and simple way to get area 
caluclations for building pads and parking lots.  You can 
also get the length calculations for the storm sewer in 
this report. 
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1. Select  in the Takeoff area on the Takeoff tab. 

Note:  This step is to ensure that all changes and 
configurations are applied, and the surfaces are current. 

2. Select the Takeoff Report  icon in the Reports area 
on the Takeoff tab. 

3. Select all four Report Sections by left-clicking on there 
boxes to add checkmarks. 

4. Ensure that the Building Pad and Parking Lot are 
uncheck under the Consider areas of interest. 

Note:  The areas of interest created earlier in the 
exercise are now available to be selected.  If an area of 
interest was selected then the reporting would be 
confined to that area(s) only.  If the Include Remaining 
Area box is checked, the rest of the site can be reported 
on in addition to the selected Areas of Interest. 

5. Ensure the Account for shrinkage & bulkage is checked. 

Note:  If stratum is defined then the Native material is 
greyed out since all material layers are already defined 
and handled in the report as they are encountered 
during excavation. 

Note:  To account for shrinkage and bulkage, accurate 
values need to be entered for each material in the MSI 
Manager. 

6. Select Earthen (Mass Earthworks) > On-Site Soil in the 
Native Material drop-down list. 

7. Select Earthen (Mass Earthworks) > Off-Site Borrow 
Soil in the Borrow material drop-down list. 

8. Select Explanatory Report in the Content style drop-

down list and select . 
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Note:  The takeoff report appears within Business Center - HCE.  You should use the Explanatory Report format to 
assist in becoming familiar with the terminology used in the report.  For each value computed in the report there 
is a number that coincides with a definition of how that value was derived.  Explore the different pages of the 
report and familiarize yourself with the definitions of the different values given in the report as well. 

Note:  You can also go back into the MSI Manager and change the shrinkage and bulkage values for the On-Site 
Soil and see how that changes the Mass Earthworks Analysis values. 
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Site Mass Haul 

Welcome 
Welcome to the Trimble® Business Center – Heavy Construction Edition (HCE) site mass haul student guide.  The 
site mass haul module in Business Center - HCE incorporates tools and commands that enables you to determine 
the most efficient distribution of earthen materials from cut zones to fill zones on a site.  The most efficient use of 
borrow pits, waste sites, and haul roads to balance an earthworks site. 
This guide was developed by Trimble Navigation’s Global Services Training and Support staff to support classroom 
instruction delivered by a Trimble Certified Trainer.  The Trimble Certified Trainer will use this guide to lead you 
through the Site Mass Haul module using real world exercises.  Please use this guide in conjunction with the 
Business Center - HCE help files and other product resources available. 

Overview 
The assortment of commands available in the site mass haul module can be divided into four categories.   

• Cut/Fill Map 

• Analysis 

• Earthworks 

• Reporting 
A cut/fill map needs to be generated showing the cut and fill between an original ground surface and a finish 
design surface. 
An initial site mass haul analysis is computed utilizing the cut/fill map that was generated, to determine an initial 
distribution of in situ earthen material from cut zones to fill zones.  This mass haul analyses help estimate the 
earthwork costs of transforming your existing surface into the design surface.   
Earthworks commands are utilized to create borrow sites, waste sites, and haul roads to account for the inbalance 
of materials on-site, whether the site requires an import or an export.   Procurement, dumping, and transportation 
costs are then associated with the newly created sites and roads.  The mass haul analysis is then refreshed, 
updating the analysis to more accurately indicate the most efficient method of cutting, filling, importing, and 
exporting material to build the project to design. It takes into account the costs associated with each site and haul 
road and generating the most cost-effective method. 
You can then generate a a site mass haul report.  This report consicely reports the earthen material properties 
(shrink, swell), and generates a map showing cut and fill zones along with proposed haul roads.  It will also show 
cut zone statistics, fill zone requirements, and haul route statistics.  All of this is valuable information that can be 
utilized when bidding a project. 
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Learning Objectives 
• Create a cut/fill map that reflects the difference between original ground and design surfaces 

• Create a site mass haul analysis to see proposed routes between cut and fill zones 

• Add earthworks sites and incorporate them into the mass haul analysis 

• Add haul roads between the earthwork sites and zones to make the haul routes more realistic 

• Understand shrink/swell values and how that impacts the mass haul analysis 

• Generate and interpret a site mass haul report 

Site Mass Haul Definitions 
Mass Haul Analysis – an analysis of where and how earthen materials on a job site are cut from certain haul zones 
and moved to other fill zones. 
Cut/Fill Map –  a map that indicates areas on a surface to cut and fill to achieve a design. 
Waste Sites – are areas off design where unusable and/or excess material is dumped to reduce the cost of the 
mass haul or to remove it from the job site if a project is an export. 
Borrow Pits – are areas off design that provides for additional fill material when there is a deficit of earthen 
material on-site. 
Haul Roads – linestrings that define haul roads in Business Center - HCE for use in a mass haul analysis.  They are 
defined between haul zones on a job site or between an earthworks site and the job site for transportation of 
import or export. 
Native Material - the earthen material that is most representative of the original gorund surface that exists on-
site. 
Borrow Material – the earthen material to be obtained from earthwork sites or off-site borrow sites should there 
be a deficit in material on-site. 
Haul Zones – The more zones that are input the better analysis you will receive.  The mass haul analysis balances 
the zone first and then determines the best place to take excess to or best place to receive an import from to 
achieve balance in that zone. 

Haul Distance – the distance the material is hauled along the haul route to the zone. 
Dispersion Distance – the average distance to disperse the material from the end of the haul route around the 
zone. 
Unit Cost Per Volume – the cost to collect, move, and disperse one unit of volume of material the entire distance 
from the cut location to the fill location. 
Site Cost – the total cost to buy the total amount of material being borrowed from off-site. 
Transportation Cost – the cost to transport material from the start of the haul route in one zone, to the end of the 
haul route in another zone. 
Dispersion Cost – the cost to disperse material from the end of the haul route around the zone. 
Collection Distance – the average distance to collect material from around the zone and transport it to the start of 
the haul route. 
Collection Cost – the cost to collect material and move it to the start of the haul route. 
Transportation Distance – the distance material is moved from the start of the haul route to the end of the haul 
route. 
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Files Needed 
For the training exercises, each user should save the following files provided by your Certified Trainer onto their 
PC and note the location. 

• Site Mass Haul Training Data.vce 

• Solar Farm Training Data.jpg  

Getting Set-up to Perform a Site Mass Haul Analysis 
The Business Center - HCE project file Site Mass Haul Training Data.vce and Solar Farm Training Data.jpg 
accompanies this student training guide.  The .vce data consists of an original ground surface and a finish design 
surface, of a solar farm pad.  It is assumed that you are familiar with creating surfaces before starting this module.  
The Solar Farm Training Data.jpg is a Google Earth™ mapping service image that is saved as a JPEG directly form 
Google Earth.   This image encompasses the construction project and all of the borrow and waste sites that will be 
used in the mass haul analysis.  Importing Google Earth images as a background image in Business Center - HCE is 
extremely useful when performing mass haul analysis.  It makes creating haul roads and earthworks sites much 
easier since the borrow pits, waste sites, and haul roads are visible on the image. 
After completing this exercise you will be able to import a Google Earth image and georeference it to use when 
performing a site mass haul analysis. 

1. Open the Site Mass Haul Training Data.vce file. 
2. Ensure all layers are turned on in the View Filter 

Manager. 

 

3. Select   in the Lines and Images area under the 
Site Mass Haul tab. 

4. Left-click on the Solar Farm Training Data.jpg to 
highlight it. 

Note: You may have to use the   button to select the 
folder where the Solar Farm Training Data.jpg file is 
saved on your PC. 

5. Select  .  
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6. Select the Georeference Image  icon at the top of 
the Place Image Pane. 
Note:  There is not a scale bar or a known distance 
available on the image to allow the use of the place the 
image command.  There are pixels in the Google Earth 
image that can be correlated to the corners of the solar 
farm design.  This allows us to use the georeference 
image command to accurately scale and place the 
image.    

7. Select Solar Farm Training Data.jpg in the Image drop-
down list. 

8. Select  twice in the Georeference Image 
pane. 
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9. With the curser in the Pixel cell for point A, left-click the gravel road intersection indicated with the red 
arrow labeled Point 1. 

10. With the curser in the Location cell  for point A, left-click on the actual point 1 in the plan view. 

Note:  You will need to turn on the Points layer in the View Filter Manager to see Point 1.  It is in the NW 
corner of the solar farm pad. 

Note:  You can use the Snap command to select Point 1. 

11. Repeat sets 9 and 10 for Point B in the Georeference Image pane. 

Note:  Point B will associate the pixel indicated with the red arrow labeled point 2 with the actual point 2 in 
the plan view. 
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Creating Cut/Fill Maps 
A cut/fill map indicates areas on a surface to cut and fill to achieve a design.  Creating a cut/fill map is the first step 
in performing a site mass haul analysis.  The program needs to know this information before it can analyze and       
determine the most efficient method of moving material around the site. 

12. Select   in the Georeference Image pane. 

13. Select  in the Georeference Image pane. 

14. Select  in the Place Image pane. 

15. Select  in the Import pane. 

Note:  That completes the project set-up that is required to perform a site mass haul analysis.  Incorporating 
the image into this exercise will become very useful in later exercises.  You will create linestrings 
representing the haul roads by simply tracing the gravel roads in the image.  The roads will have accurate 
lengths due to the image being properly scaled. 

 

1. Select the Create Cut/Fill Map  icon in the Cut/Fill 
Map area under the Site Mass Haul tab. 
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2. Enter CFMap in the Name cell on the Create Cut/Fill 
Map pane. 

3. Select Original Ground in the Initial drop-down list 
under Surface. 

4. Select Solar Farm Design in the Final drop-down list 
under Surface. 

Initial surface = the starting state of the project site, 
typically is an original ground surface. 

Final surface = the finish design the user is concerned 
with generating a cut/fill map for. 

5. Ensure that both Shade map and Label grid are 
checked under Map Features. 

Shade map = display the cut and fill areas in graduated 
colors based on the current color mapping. 

Label grid = display values showing cut and fill values at 
specific locations on the difference model that’s created 
(Isopach). 

6. Select CFMap in the Layer drop-down list. 
7. Select Agency 0.10 in in the Text style drop-down list. 
8. Enter 100 in the Grid spacing cell.   

Note:  This directs the program to show a cut or fill value 
at 100’ intervals. 

9. Select Ticks in the Grid style drop-down list.  
10. Select 0.1 in the Decimal precision drop-down list. 

Note:  Depending on the application you can choose a 
more precise setting here, but since this is a rough 
grading cut and fill map we went with 0.1.   

11. Ensure that the box for Label Surface Elevations is not 
checked. 

Note:  If the Label Surface Elevation box is check, surface 
elevations will also be shown at each tick location.  
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12. Select  in the Create Cut/Fill Map pane. 

Note:  There is a new category created in the Project 
Explorer labeled Cut/Fill Maps. 

 

 

13. Expand the Cut/Fill Maps in the Project Explorer pane. 
14. Right-click on the CFMap in the Project Explorer and 

Select Add Legend. 
15. Enter CFMap Legend in the Title cell. 
16. Select CFMap in the Layer drop-down list. 
17. Select CFMap in the Surface or cut/fill map drop-down 

list. 
18. With the curser in the Location point cell, left-click on a 

location for the legend outside of the NW corner of the 
surface in the plan view. 

19. Select Agency 0.70in in the Title drop-down list and 
select Agency 0.50in in the Depth drop-down list under 
Text styles. 

 

20. Select  in the Add Legend pane. 
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Computing Region Volumes 
Use the Compute Region Volume commands to quickly calculate the cut and fill volumes, areas, centers of mass, 
and the difference between the volumes of a specific region within your job site.   
This command gives you a quick snapshot of earthwork requirements as you work through performing a site mass 
haul manually.  Results help determine how to balance volumes on a site.  It provides a quick way to start an area 
to balance, and then increase or decrease what is included until the cut volume balances the fill. 
A haul cost can be determined by measuring the distance from the center of mass of one area to the center of 
mass of another.  The Site Mass Haul Analysis is automated and provides this information as well.  Using the 
compute region volumes command allows you more control by viewing site volumes one region at a time. 

21. Left-click on the legend in the graphical view to select 
it.  

22. Right-click in the graphical view and select Properties. 
23. Left-click on the Display areas cell under Property and 

select Yes. 

Note:  The legend will change looks as soon as you select 
yes.  In the new legend the blue areas indicate fill and 
red areas indicate cut. 

Note:  The legend indicates that there is a total area of 
5,240,720sf that requires between 30’ – 0.2’ of cut. 

Note:  The legend also indicates there is a total area of 
1,519,738sf that requires between 0.2’ and 30’ of fill. 

24. Select   in the Properties pane. 
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1. Select  in the 
Cut/Fill Map area under the Site Mass Haul 
tab. 

2. Select CFMap in the Cut/Fill map drop-
down list. 

3. Select CutFillBoundaries in the Layer drop-
down list. 

4. Leave the Optional existing boundary cell 
empty. 

Note:  If using an existing line to represent 
the region of interest, it would be selected in 
the optional existing boundary cell.  For this 
exercise new boundaries will be created and 
that is why we are leaving this cell empty. 

5. Left-click on Expand under Boundary edit to 
select it. 

Expand = select this to initially create the volume boundary or to enlarge an existing boundary. 

Trim = select this to reduce the size of an existing volume boundary. 

6. Enter Region 1 in the Volume boundary name cell. 

7. Select Circle in the Filter type drop-down list. 
8. Enter 200 in the Radius cell. 
9. With the cursor in the Next Points cell,  left-click and hold outside the NW corner of the cut/fill map. 
10. With the left mouse button still pressed, track the perimeter of the region of interest.   

Note:  In the picture to the right, you can see the region of interest is about ¼ of the full Cut/Fill map.  The 
boundary line will auto-close to create a polygon and will automatically be tinted. 

Note:  The results will automatically be displayed in the Results area of the Compute Regions Volume pane.  
With all values selected for the report type you will get the following information: 

Cut Volume = total volume of cut in the region of interest. 
Cut Area = total area of cut in the region of interest. 
Center of Mass = the x,y,z coordinate of the center of mass of the cut. 
Fill Volume = total volume of fill in the region of interest. 
Fill Area = total area of fill in the region of interest. 

Center of Mass = the x,y,z coordinate of the center of mass of the fill. 
Difference = the volume difference between the cut and fill. 
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11. Left-click on Trim under Boudary edit to select it. 
12. With the curser in the Next Points cell, left-click and 

hold outside Region 1 and drag across the region. 

 

13. Release the left mouse button once outside the region. 

Note:  Region 1 is now trimmed based on the line that 
was just tracked across the region and the results in the 
Results area are updated. 
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14. Left-click on Expand under Boundary edit to select it. 
15. Enter Region 3 in the Volume boundary name cell. 
16. Enter 100 in the Radius cell. 

Note:  This will make it easier to draw your box around a 
smaller area with sharp turns. 

17. With the cursor in the Next Points cell,  left-click and 
hold outside the NW corner of the 3rd Fill zone from 
the west. 

Note:  This fill zone is almost in the center of the Cut/Fill 
map.  

Note:  Your fill volume should equal 64,697cy. 

 

18. Highlight all of the text above the double dased line for 
Region 3 in the Results area in the Compute Region 
Volumn pane. 

19. Hit CTRL+C on the keyboard to copy the text. 

20. Select the Create Text  icon in the Text area under 
the Drafting tab. 
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21. Select MHRegions in the Layer drop-down list. 
22. Select Agency 0.30 in the Text style drop-down list. 
23. Select Middle Center in the Justification drop-down 

list.  
24. Enter 40.00 in the Height cell and 90 in theRotation 

cell.  

Note:  These values determine the orientation of the text 
and the height of the text.  

25. Enter 2 in the Width factor cell. 

Note:  This will allow the newly created text stand out 
more. 

26. Ensure the Oblique angle is set to 0.  

Note:  This determines the slant of the text. 

27. Select Spline with no arrow in the Leader type drop-
down-list.  

28. Select the  icon next to the Text box cell and then 
hit CTRL+V  on the keyboard to paste the results 
copied earlier. 

29. Select  in the Text Editor window. 

 

30. With the curser in the Leader point cell, left-click in the 
upper part of Region 3 in the graphical view. 

Note:  This is the desired location of the leader arrow. 

31. With the curser in the Text insertion point cell, left-
click above Region 3 in the graphical view.  

Note:  You want to choose a location that places the text 
outside the surface but clearly legible.  

32. Select  in the Create Text pane.  

Note:  You can continue to create different regions and 
label them for use in the mass haul analysis until 
comfortable with the process.  Also, try trimming and 
extending the created regions until each region balances 
between cut and fill. 

33. Select  in the Compute Region Volume 
pane.  
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Create a Site Mass Haul Analysis 
The Site Mass Haul Analysis command assists in determining the most efficient distribution of on-site material 
from cut zones to fill zones.  The analysis will also assist in estimating earthwork costs to achieve a finish design 
from an existing ground surface. 
You will start by creating a less accurate mass haul analysis with auto-created haul routes.  This gives the estimator 
a general idea of the amount of cut and fill required to balance the site, as well as the amount of import or export 
required to complete the project. 
After the initial analysis is completed, we will then add a network of haul roads and earthwork sites with 
associated costs.  We will then refresh the analysis to determine the optimal road from each cut zone to an 
associated fill zone, as well as the most economical waste sites and borrow pits to utilize for the project. 
The key element in understanding the site mass haul analysis function is the concept of haul zones.  You will have 
to define haul zones, they are not auto-created by performing an analysis.  The more haul zones utilized the more 
precise the analysis will be.  When an analysis is performed each haul zone is balanced first.  If an excess or deficit 
exists then the program determines the most economical means to transport excess or import material to satisfy 
the deficit based on other haul zones balances, borrow and waste pit locations and costs, and transportation 
costs.   
After creating an initial mass haul analysis and then comparing it to subsequent and more detailed mass haul 
analysis the power of the mass haul analysis will be apparent. We will start by creating an initial site mass haul 
analysis allowing the software to define the haul routes. 

1. Select  in the Analysis area under the 
Site Mass Haul tab. 

2. Enter MHAnalysis in the Name cell under Mass Haul 
Analysis in the Create Site Mass Haul Analysis pane. 

3. Select CFMap in the Cut/Fill map drop-down list. 

Note:  This is the cut/fill map that will be used as the 
basis for the analysis. 

 

4. Select  in the Lines and Images area 
under the Site Mass Haul tab. 

Note:  We need to define the Haul Zones. They must be a 
closed polyline in order to be used as a haul zone. 

Note:  For the initial mass haul analysis, we will create 
four equal areas to analyze.  It is important that haul 
zones do not overlap, and if they do then the portion of 
the site inside the overlapping haul zones will be 
accounted for twice in the mass haul analysis. 
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5. Select the Measure   icon from the Quick Access 
Toolbar. 

6. With the Curser in the From cell, right-click in the 
graphical view and select Point Snap. 

7. Left-click on Point 1 in the Plan view. 
8. With the Curser in the To cell, right-click in the 

graphical view and select Point Snap. 
9. Left-click on Point 2 in the Plan view. 

10. Select  in the Measure Distance 
pane. 

Note:  Your distance between points is 5000’.  If we want 
to divide this up in to 4 separate zones, we need to 
divide 5000 by 4.  This means that the zones will be 
1250’ wide. 

Note:  The Northing Cordinate for Point 1 and 2 is 
31370, and will be used in the next steps.  

11. Select   in the Measure Distance pane. 
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12. Enter Haul Zone 1 in the Name cell. 
13. Select MHRegions in the Layer drop-down list. 
14. Enter 0 in the Elevation cell. 
15. Select Always in the Automatically close by connecting 

ends drop-down list. 
16. Left-click on Specify individual points under Method to 

Add Points to select it 
17. With the curser in the Next point cell, right-click in the 

graphical view and select Point Snap. 
18. Left-click on Point 1 in the Plan view. 
19. With the curser in the Next point cell, right-click in the 

graphical view and select Point Snap. 
20. Left-click on Point 4 in the Plan view. 
21. Change the Easting Cordinate in the Next point cell to 

40350. 

Note:  We the Easting coordinate in Point 4 was 39100 
and we added 1250 to it because we needed our next 
point to be 1250 to the right. 

22. Select   in the Create Polyline window. 
23. Change the Northing Cordinate in the Next point cell to 

31370. 

Note:  This is the Northing Cordinate from point 1 and 2 
that we noted earlier. 

24. Select   in the Create Polyline window. 

25. Select   in the Create Polyline window. 
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26. Select the Copy Objects  icon in the CAD Data 
area under the Data Prep tab. 

27. Left-click on the Polyline that you just created to select 
it. 

28. Select  in the Copy Objects pane. 
29. With the curser in the From cell, right-click in the 

graphical view and select Point Snap. 
30. Left-click on Point 1 in the Plan view. 
31. With the curser in the To cell, right-click in the 

graphical view and select End Snap. 
32. Left-click on the Right Upper corner of the Polyline that 

you created. 

Note:  If you get a list of items to choose from, make 
sure to choose the polyline that you created. 

33. Select  in the Move Objects pane. 

Note:  You should now see two polylines created and we 
are back at the Copy Objects pane. 

 

34. With the curser in the Objects to copy cell, hold down 
Ctrl on the Keyboard and left-click on the polylines to 
select both of them. 

35. Select  in the Copy Objects pane. 
36. With the curser in the From cell, right-click in the 

graphical view and select Point Snap. 
37. Left-click on Point 1 in the Plan view. 
38. With the curser in the To cell, right-click in the 

graphical view and select End Snap. 
39. Left-click on the Right Upper corner of the Polyline that 

you just moved. 

Note:  If you get a list of items to choose from, make 
sure to choose the polyline that you just moved. 

40. Select  in the Move Objects pane. 

Note:  You should now see all four polylines and we are 
back at the Copy Objects pane. 

41. Select  in the Copy Objects pane. 
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42. Select   under Haul Zones in the Create 
Site Mass Haul Analsis pane. 

 

43. With the curser in the Zone boundaries to add or 
remove cell, hold-down the Ctrl key on the keyboard 
and left-click on the four polylines to select them. 

44. Select in the Edit Haul Zone Boundaries 
pane. 

45. Select  in the Edit Haul Zone Boundaries 
pane. 
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46. Select Yes in the Auto-create path drop-down list. 

Note:  When set to yes Business Center - HCE creates 
haul roads as necessary from the center of mass of cut 
zones to the center of mass of fill zones, from cut zones 
to waste sites, and from borrow sites to fill zones. 

Note:  Once accurate haul roads are created this will be 
set to No to force Business Center - HCE to analyze the 
site using the actual haul roads between earthworks 
sites and between haul zones on-site. 

47. Enter 1 in the Haul cost cell. 

Note:  This represents the cost to haul 1 cy of loose 
material one mile on the haul road created. 

48. Enter 0.45 in the Dispersion cost cell.   

Note:  This resents the cost to spread 1 cy of material 
one mile.  Dispersion distance is the distance from the 
end of the haul route to where the material ultimately 
rests in the fill zone. 

49. Enter 0.65 in the Collection cost cell. 

Note:  This represents the cost to collect one cy of 
material from the cut zone and transport it one mile to 
the beginning of the haul road. 

50. Ensure that the box for Account for shrinkage and 
bulkage is unchecked. 

51. Enter 0.50 in the Borrow cost cell.   

Note:  This is the price to purchase and transport 1 of fill 
material from an off-site source the entire distance. 

52. Enter 0.35 in the Waste cost cell.   

Note:  This is the price to transport and dispose of 1 cy of 
excess cut material the entire distance to an off-site 
dump location. 

53. Select  in the Create Site Mass Haul 
Analysis pane. 
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Interpreting the Initial Mass Haul Analysis Results 
After the mass haul analysis has been completed there will be zones and balance lines created in the plan view 
and a Mass Haul Analysis is present in the project explorer. 
In this section we will investigate the different components of the mass haul analysis and discuss how to interpret 
these results. 

1. Expand Earthworks in the Project Explorer pane and 
then expand Mass Haul Analysis. 

2. Right-click on MHAnalysis, and select Properties. 

Note:  The Parameter’s of the analysis are the same as 
the values that were input when initially running the 
analysis.  Since a native and borrow material were not 
defined the bulkage and shrinkage factors default to 1. 

Off-Site borrow volume = the total volume of material 
needed to borrow from off-site. 
Off-site waste volume = the total volume of material 
needed to dump off-site. 
Site borrow volume = the total volume of material 
borrowed from earthworks sites. 
Site waste volume = the total volume of material 
dumped at earthworks sites. 
Note:  Since there were not any borrow or waste sites 
defined in this analysis these volumes are 0. 
Total cut volume = total cut volume of material across 
all-zones. 
Total fill volume = total fill volume of material across all 
zones. 
Total cost = the total cost to collect, transport and 
disperse material in the zones defined – also includes 
cost to borrow material from off-site or to dump waste 
material off-site. 

 

3. Left-click on the circular balance line called zone 1 to 
select it. 

Note:  The circular balance lines represent material that 
is cut and filled in the same zone. 
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Note:  Since there are not haul roads defined in this 
project yet the collection and dispersion distances are 
calculated as the center of mass of the cut to the center 
of mass of the fill.  There is also not a transportation 
distance given, which is available when a cut is being 
transported to a different zone to be used as fill. 

Note:  The properties of the balance lines are defined 
below: 
Source = the zone where the cut is coming from. 
Destination = the zone where the cut is being placed as 
fill. 
Volume = total volume of material being cut and placed 
as fill in the current balance line. 
Collection Distance = Average distance to collect 
material from around the zone and transport it to the 
start of the haul route. 
Dispersion Distance = Average distance to disperse the 
material from the end of the haul route to around the 
zone. 
Unit cost per volume = the cost to collect, move, and 
disperse one unit volume the entire distance.  This is 
based on the collection and dispersion costs that were 
input when creating the analysis. 
Collection Cost = the cost to collect material and move it 
to the start of the haul route. 
Dispersion Cost = the cost to disperse material from the 
end of the haul route to around the zone. 
Total Cost = the total cost to collect material from the 
source zone, transport it to the target zone, and disperse 
it around the target zone. 
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Creating Earthworks Sites and Haul Roads 
The next step is to add waste sites, borrow sites, and haul roads.  This is so a more accurate analysis can be 
completed taking into account material excess, deficits, and computing costs based on the distances of each 
earthworks site from the job site using the network of haul roads created. Since this project has an excess of 
material borrow sites do not need to be created, only waste sites. 

4. Left-click on the balance line going from zone 2 to off-
site to select it. 

Note:  Notice there is now an excess cost value given.  
Since there is more cut than fill in zone 2  and using the 
excess is not the most economical method of satisfying 
the deficit in zone 4, the software determines that this 
material needs to be dumped off-site. 

Excess Cost = The cost to transport material along the 
haul route and dump it off-site.   

Note:  You can continue to explore the different balance 
lines until it is clear how the material is going to be 
moved about the job site. 

5. Select  in the Properties pane. 

 

1. Select  in the Earthworks area under theSite 
Mass Haul tab. 

2. Select Waste Site in the Site type drop-down list. 

3. Enter Southern Dump in the Name cell. 
4. Select Earthworks in the Layer drop-down list. 
5. Enter 16228.352,59774.417 in the Location cell. 
6. Enter 2.50 in the Cost cell. 

7. Enter 1,000,000 in the Capacity cell. 

8. Select  in the Create Earthworks Site 
pane. 

Note:  A red dump truck icon will now be present in the 
plan view, but you will have to zoom out to see it. 
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9. Enter Northern Dump in the Name cell. 
10. Enter 40742.655,38608.375 in the Location cell. 
11. Enter 1 in the Cost cell. 

12. Enter 2,500,000 in the Capacity cell. 

13. Select  in the Create Earthworks Site 
pane. 

Note:  A second red dump truck icon will now be present 
in the plan view, but you will have to zoom out to see it. 

 

14. Select   in the Earthworks area 
under the Site Mass Haul tab. 

15. Enter Northern Dump Road in the Name cell. 
16. Select Earthworks in the Layer drop-down list. 

17. Select  in the Create Haul Road pane. 
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18. Enter 0 in the Elevation cell. 

Note:  The haul roads do not need an elevation. 

19. With the curser in the Coordinate cell, left-click on the 
northern dump truck in the plan view. 

20. Left-click on Point 1 in the plan view. 

21. Select   in the Edit Linestring pane. 

 

22. Select   in the Earthworks area 
under the Site Mass Haul tab. 

23. Enter Southern Dump Road in the Name cell. 
24. Select Earthworks in the Layer drop-down list. 

25. Select  in the Create Haul Road pane. 

26. Enter 0 in the Elevation cell. 
27. With the curser in the Coordinate cell, left-click on the 

southern dump truck in the plan view. 
28. Left-click on the road to trace it all the way around to 

Point 4 in the plan view. 

Note:  We are traceing the dirt roads visible in the image 
from the Northern Dump and Sourthern Dump to the job 
site.  

Note: It is important to trace routes that are similar to 
the ones that will be used during construction so that 
the analysis is accurate. 

29. Select   in the Edit Linestring pane. 

30. Select  in the Create Earthwork Site 
pane. 
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31. Left-click on one of the Northern Haul Road in the plan 
view to select it. 

32. Right-click in the graphical view and select Properties 
33. Enter .009 in the Cost cell. 
34. Left-click on the Southern Haul Road to select it. 
35. Enter .004 in the Cost cell. 

36. Select   in the Properties pane. 
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37. Select   in the Earthworks area 
under the Site Mass Haul tab. 

38. Enter Haul Road in the Name cell. 
39. Select Earthworks in the Layer drop-down list. 

40. Select  in the Create Haul Road pane. 

41. Enter 0 in the Elevation cell. 
42. With the curser in the Coordinate cell, left-click on the 

Point 1 in the plan view. 
43. Left-click in the Middle Right of the far left zone. 

Note:  See plan view image below to use as an example. 

44. Select the Create Linestring  icon at the top of the 
Edit Linestring pane. 

45. Repeat steps 40 through 44 to add individual haul 
roads as shown in the image. 

Note:  Good practice is to create the haul roads from the 
centroid of each zone to the centroid of adjacent zones. 
It is critical that a separate haul road is created when 
connecting multiple zones such as below.  If a haul road 
passes through a zone but the start or end point is not 
located in the zone then the haul road will not be used 
to transfer material to and from the zone unless there is 
a connecting haul road that starts or ends in that zone. 

 

 



Page | 185  
 

46. Repeat steps 40 through 44 to add individual haul roads as shown in the image below. 

 

47. Select  in the Analysis area under the Site Mass Haul tab. 

Note:  Not all of the Haul Roads are shown in the Mass Haul Editor. 
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48. Select  in the Earthworks area under the Site Mass Haul tab. 
49. With the curser in the Selection cell, hold-down Ctrl on the keyboard and left click on all of the Haul 

Roads we just completed.  

50. Select  in the Convert To Haul Road pane. 

51. Select  in the Convert To Haul Road pane. 

 

52. Enter 0.004 in the Haul cost for each of the Haul Roads we just created. 
53. Ensure all the roads have a checkmark in there Active cell. 

Note:  In the properties haul roads you can define wether it is bi-directional or a one way road.  If changed to 
one-way then the direction of the line determines the direction of transportation.  Leave all roads as 
bidirectional for this exercise. 
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54. Right-click on MHAnalysis in the Project Explorer pane 
and select Edit Site Haul Analysis.   

55. Select No in the Auto-create path drop-down list. 

Note:  This means that only the haul roads that we have 
created will be used in the analysis. 

56. Select  in the Edit Site Mass Haul 
Analysis pane. 

Note:  Notice that the excess material is being sent off-
site and not to the waste site that was created.   

 

57. Enter 10 in the Borrow cost cell and enter 10 in the 
Waste cost cell. 

Note:  This is so that we will force the analysis to use the 
waste sites because it is more economical to do so. 

58. Left-click in the box in front of Account for shrinkage 
and bulkage to add a checkmark.   

59. Select Earthen (Mass Earthworks) > On-Site Soil in the 
Native material drop-down list. 

60. Select Earthen (Mass Earthworks) > Off-Site Borrow 
Soil in the Borrow material cell. 

61. Select  in the Edit Site Mass Haul 
Analysis pane. 

 

62. Select the Material and Site Improvements Manager 

 icon in the Materials area under the Site Mass 
Haul tab. 

63. Expand the Materials and then Earthen (Mass 
Earthworks). 

64. Left-click on On-Site Soil to highlight it.   

Note:  We are assuming that we have a soils report and 
we know the on-site soil has a 8% shrinkage factor and a 
11% hauling bulkage factor.   

Note:  Since this construction project has a deficit of 
material there is no borrow, so no borrow material 
properties need to be entered. 

65. Select   in the Material and Site 
Improvement Manager window. 
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Running a Site Mass Haul Report 
After completing the site mass haul analysis a report can be generated that contains all the vital information in a 
clean and easy to read report. 

66. Select  in the Edit Site Mass Haul 
Analysis. 

67. Right-click on MHAnalysis in the Project Explorer pane 
and select Refresh Mass Haul Analysis.  

Note:  You can explore the balance lines and edit the 
haul road costs to understand how the software takes 
these changes into affect. 

 

1. Select the Site Mass Haul Report  icon in the 
Reports area under the Site Mass Haul ribbon tab. 

2. Select MHAnalysis in the Mass haul analysis cell. 
3. Select Plan View in the Snapshot cell. 

4. Select  in the Site Mass Haul Report 
pane. 
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Notes on the Analysis and Report: 
Moving earth within the same zone = when earth is moved within the same zone, the cost is calculated by the 
average distance to the center of mass with the zone multiplied by the defualt unit cost set with the auto-create 
setting. 
Moving earth from zone to zone = When moving from one zone to another, the cost includes the cost to gather 
and the cost to disperse as well as the distance from the center of mass of the first zone to the center of masss of 
the second zone multiplied by the unit cost. 
Importing material from off-site = the cost to import material is the given cost per volume plus the cost to 
disperse in the zone. 
Exporting material off-site =  the cost to export earth is the given cost per volume plus the cost to collect from 
the zone. 

Note:  Explore the different sections of the report to understand how the data is presented.  The data reported 
on is: 
• Material properties 
• Plan view of cut/fill zones and haul roads 
• User-input cost summary 
• Cut/Fill zone data – broken down by which zone material is being cut from and what zone the material is 

being placed as fill 
• Route Statistics 
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Corridor Mass Haul 

Welcome 
Welcome to the Trimble® Business Center – Heavy Construction Edition (HCE) corridor mass haul module.  The 
corridor mass haul module in Business Center - HCE incorporates tools and commands that enables you to 
determine the most efficient distribution of earthen materials from cut zones to fill zones along a corridor.   
This guide was developed by Trimble Navigation’s Global Services Training and Support staff to support classroom 
instruction delivered by a Trimble Certified Trainer.  The Trimble Certified Trainer will use this guide to lead you 
through the Site Mass Haul module using real world exercises.  Please use this guide in conjunction with the 
Business Center - HCE help files and other product resources available. 

Overview 
Business Center – HCE is a powerful tool that allows you to import surveyed original ground surfaces and analyze a 
corridor design against it to tell you how the material and how it can be moved most economically. It is also 
dynamic in the sense that the analysis is updated and changes as the design of the corridor changes. 
The haul ranges of different equipment types are entered by the user and these are considered to give you insight 
into what resources should be used and where along the corridor to move the material in the most economical 
manner.  In addition, the shrink and swell material properties can be accounted for in the analysis. 
Engineering considerations such as the existing material strata, haul roads available for use, haulage barriers 
(rivers), borrow pits, waste sites, and the type and number of machines can all be input into Business Center - HCE. 
Cost considerations are then able to be associated with the different resources at your disposal and a mass haul 
analysis can be computed, and will create a plan that optimizes material movement based on distance and cost 
parameters. 

Learning Objectives 
• Run an initial corridor mass haul analysis to determine the most efficient way to redistribute earthen material 

from cut zones to fill zones along a corridor. 

• Define barriers at stations along an alignment beyond which earthen material cannot be moved 

• Open a Mass Haul Diagram and be able to graphically analyze the mass haul. 

• Create and convert haul roads to be used as routes for vehicles moving materials 

• Create borrow pits and waste sites to accommodate material excess and deficits. 

• Force specified quantities of usable material to be accepted at one or more points along the corridor. 
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• Force the removal of specified quantities of material at one or more points along the corridor. 

• Modify the network of haul roads to better manage the flow of cut and fill volumes. 

• Create haul ranges for multiple machine types that will be used to move material 

• After creating a mass haul analysis, automatically apply haul ranges to every balanced section. 

• Recalculate the mass haul analysis to understand how changes affect the mass haul analysis. 

• Report on the analysis; both on the source and destination of earthwork volumes, and on the properties of the 
corridor’s balance lines. 

Corridor Mass Haul Commands Defined 
Georeference Image – geodetically position raster images in the plan view by correlating specific pixels with 
known coordinates.  This allows you to use arial photograhps and scanned job site designs as positionally accurate 
backgrounds in your Business Center - HCE project. 
Create Corridor Analysis – computes the most efficient way to redistribute earthen material from cut zones to fill 
zones along a corridor. 
Mass Haul Diagram – use this command to create a diagram showing the accumulated cut and fill volumes along a 
corridors alignment, balance lines and the direction the material needs to be moved, a graph showing 
instantaneous cut/fill, and cross haul at each station along a corridor’s alignment.  The view gives a complete 
picture of mass haul and earthworks with access to specific mass haul and volume/cost information and analysis. 
Mass Haul Editor – use this command to quickly edit volumes and costs associated with mass haul import and 
export locations, earthwork sites, and haul roads. 
MSI Manager – create and manage libraries of materials used to define the existing strata and corridor materials.  
Input attributes such as shrink and swell, and a percentage of material that meets specifications to be re-used as 
fill.  The mass haul analysis takes these considerations into account. 
Create Import – force a specified quantity of useable and unuseable material to be accepted at a particular station 
along an alignment. 
Create Export – force the removal of a specified quantity of useable material at a particular station or range of 
stations along an alignment.  Export values specify exact quantities of material that MUST be removed at the 
specified location. 
Create Barrier – define stations along an alignment beyond which material cannot be moved.  Barriers represent a 
forced balance point for all hauled material in both directions.  Acting as a start and finish points where the 
earthworks must balance through the use of imports, exports, and earthworks sites. 
Create Earthworks Site – define the locations, capacities, and associated costs of waste sites and borrow pits to be 
used in the mass haul analysis. 
Create Haul Road – create linestrings that define haul roads between zones on project, or between earthworks 
sites and a corridor construction project. 
Create Haul Range – specify the maximum distance that earthmoving vehicles (or resources used in tandem such 
as excavator and haul truck) can economically move material along the corridor.  These ranges enable economical 
estimation to allow the efficient planning of earthwork machine usage. 
At Grade Point – this is the manual method to apply haul ranges at selected grade points along the alignment.  
Balancing manually gives control over the order in which the material is moved along the alignment. 
Auto-Balance – this command automatically applies haul ranges at all grade points along the alignment; based on 
the distance and volume parameters of the cut and fill zones, and the haul ranges entered.  This method 



Page | 192  
 

automatically determines grade points and fits the resources to move the material based on the entered haul 
ranges. 

Clear Balances – remove all balance lines created, wether automatically or manually created. 
Corridor Mass Haul Report – reports on source and destination earthwork volumes for a corridor mass haul 
analysis.  This report is a textual representation of the Mass Haul Diagram. 
Balance Line Report – reports on the properties of a corridor mass haul’s balance line.   

Files Needed 
For the training exercises, each user should save the following files provided by your Certified Trainer onto their 
PC and placed in the Project Management folder. 

• Project Planning and Scheduling.vce 

• Project Planning and Scheduling.zip or Project Planning and Scheduling folder 

Note:  You can find your Project Management folder by opening Business Center – HCE and going to the File 
tab.  Select Options in the File tab and a Options window will open.  Left-click on File Locations to select it and 
note the Project Management folder location.  You can use Windows Explorer to navigate to this folder and 
place the Project Planning and Scheduling.vce and Project Planning and Scheduling folder inside this folder.  If 
you have the .zip file you will need to extract it and then place the folder. 

Running an Initial Corridor Mass Haul Analyis 
In order to to perform a corridor mass haul analysis you must import an original ground into your Business Center 
- HCE project file, and either import or create an alignment and corridor design in Business Center - HCE.  As these 
workflows have been covered in previous modules they are already a part of the Project Planning and 
Scheduling.vce. 

1. Open the Project Planning and Scheduling.vce project. 

Note:  Once opened a georeferenced arial photograph 
along with a corridor design and cut/fill map will be 
visible in the plan view.  You will also see a network of 
2D linework. 

 

2. Select   in the Analysis area under the 
Corridor Mass Haul tab. 
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3. Enter MH Analysis in the Name cell. 
4. Select Main Rd from the Corridor drop-down list. 

Note:  If multiple corridors are included in a project, only 
one can be analyzed at a time. 

5. Enter 25 in the Sampling interval cell.  

Note:  This defines the distance along the alignment that 
the Average End Area method of determining volumes 
will be applied.    

6. Select Yes from the Respect earthwork site capacities 
drop-down list.   

Note:  When capacities are associated with borrow pits 
and waste sites, they are respected when choosing yes. 

7. Select  in the Create Corridor Mass Haul 
Analaysis pane.   

Note:  The corridor mass haul analysis is created and its 
icon appears under the Main Rd. corridor in the Project 
Explorer. 

 

8. Expand the Corridors in the Project Explorer and left-
click on Main Rd to highlight it. 

9. Select   in the Analysis area 
under the Corridor Mass Haul tab. 

Note:  This will create a graphical representation of cut 
and fill volumes along the corridor. 
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How to interpret the diagram: 
Vertical axis - values represents volume. 

Horizontal axis - values represents stationing along the alignment. 
Note:  The mass ordinates are represented by the colored lines in the diagram. 

Red line - is the cumulative cut along the alignment.  By definition of it being cumulative the line is ever 
increasing or flat along stations of fill.  It’s easy to see graphically that the cut volume increases sharply 
between 2+450 to 2+850.   
Blue line - is the cumulative fill along the alignment.  By definition of it being cumulative the line is ever 
increasing or flat along stations of cut.   
Green line - is the Usable Material.  A surplus of usable material exists when the line is above the 0 axis and 
a deficit exists when the line is below the 0 axis.  The amount of surplus or deficit can be determined by 
referencing the vertical axis at any specific station. 
Orange line -  represents the Unusable Material.    This indicates the the amount of unusable cut material 
being carried, increases very gradually along the corridor.  Whatever unusable material cannot be taken to a 
waste site is hauled to the closest start or finish point. 

Note:  Warnings are also indicated on the Mass Haul Diagram. 
Warning - is represented by the red flag icon indicates  an imbalance as a result of a surplus or deficit of 
material occurring at the end of the corridor or at any barrier.  Examining the properties for any warning 
gives details about the actual volume (compacted) of surplus or deficit. 
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10. Hit F11 on the keyboard to open the Properties pane 
and left-click on a line in the Mass Haul Diagram. 

Note:  You can see in the Properties pane information on 
the selected line. 

Note:  In the status bar the stationing and volume are 
indicated at the current location of the cursor. 

Note:  You can move the cursor along each line in the 
mass haul diagram and review the volumes at different 
stationing. 

 

11. Select Explore Object  icon in the Quick Access 
Toolbar. 

12. With the curser in the Object cell, left-click on the Clay 
(Useable) ordinate in the mass haul diagram. 

Note:  You an hover over the lines to see which one is 
the Clay (Useable) before left-clicking on it. 

13. Enter 7000 in the Sation cell. 

Note:  You can either enter a specific station of intrest or 
select a location along the alignment in the plan view to 
select a Station.  

Instantaneous Cut Volume - This is the volume of 
material to be cut in a particular station range.  The 
station range is defined by the sampling interval that 
was input when creating the initial mass haul analysis. 
Instantaneous Fill Volume – This is the volume of 
material to be filled in a particular station range.  The 
station range is determined by the sampling interval 
that was input. 
Cross Haul Volume – the amount of material being 
moved from a cut down an alignment to a fill. 
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14. Left-click in the box next to Instantaneous in the Mass Haul Diagram. 

Note:  You can now see a graph showing the instantaneous cut, fill, and cross haul at each station along a 
corridor’s alignment.  

Note:  This view shows the instantaneous cut and fill across each sampled section.  The sampled sections are 
determined by the value entered when initally running a mass haul analysis.  This view also shows the cross 
haul distance.  Cross haul is defined as the amount of material from a cut zone being moved down an 
alignment and used in a fill zone in a corridor mass haul. 
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Considering Material Properties and Defining the Original Ground Strata 
Often times a soils report will be available that contains vital material characteristic information such as the shrink 
and swell values.  These values need to be captured in Business Center – HCE, so that the volume calculations can 
take these factors into account to give accurate values of excesses and deficits on projects. 
In addition these reports will often contain core sample data, also known as bore hole data.  This data defines the 
thickness of the different materials that will be encountered during the construction project.  This data needs to 
be captured by Business Center - HCE as well; so that the volumes of usable and unusable cut encountered can be 
determined accurately, and be placed as fill or as an export accordingly. 

In this section it we will learn how to input this data into Business Center - HCE. 

15. Left-click in the box next to Profile view in the Mass Haul Diagram.  

Note:  A profile view shows  the vertical alignment at the same horizontal scale as the Corridor Mass Haul 
Diagram. 

 

Note:  The initial mass haul analysis has now been completed and it is simple to see that there is a deficit of 
usable material on this project.   There is a river that is impassable and must be accounted for in the Mass 
Haul Analysis.  There is multiple borrow pits and waste sites that need to be added to the project to ensure 
the project is being constructed in the most efficient manner.  Also there is bore hole data that needs to be 
entered so that the strata of the existing ground can be defined giving managers a clearer picture of the 
amount of work this project is going to require.  After the Mass Haul Analysis is optimized by inputting all 
these engineering considerations then haul ranges will be applied to determine what machines should be 
working at what locations along the corridor. 
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1. Close the Mass Haul Diagram. 
2. Select the Material and Site Improvement Manager  

 icon in the Material area under the Corridor 
Mass Haul tab.  

3. Expand Materials and then Earthen in the Material and 
Site Improvement Manager window. 

4. Left-click on Clay to highlight it. 
5. Enter 7 in the Shrinkage (%) cell. 

Note:  7% shrinkage means that 1 CM of in situ cut will 
equal 0.93 CM of once placed as fill and compacted.   

6. Select  and enter 80 in the Percent 
usable for fill in the Soils Properties window. 

Note:  80% usable means that for every 100 CM of clay 
cut, only 80 CM meets specifications to be reused as fill 
on-site.  The other 20 CM must be exported. 

7. Select   in the Soil Properties window. 

 

8. Left-click on Rock to highlight it. 
9. Enter 0 in both the Shrinkage (%) cell and the Hauling 

Bulkage (%) cell. 

Note:  There currently are not any specific Rock 
Properties that can be set in the software so the icon is 
greyed out. 
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10. Left-click on Sandy Fine Clay to highlight it. 
11. Enter 3 in the Shrinkage (%) cell and enter 7 in the 

Hauling bulkage (%) cell. 
12. Select Soil Properties and change the percent usable 

for fill to 90%. 

13. Select  and enter 90 in the Percent 
usable for fill in the Soils Properties window. 

14. Select   in the Soil Properties window. 

15. Select  in the Material and Site 
Improvement Manager window. 

 

16. Select  in the Strata area under the 
Corridor tab. 

Note:  This command is how the different layers of 
strata defined from core samples are entered into the 
project. 

17. Select Original ground in the Original ground drop-
down.  

Note:  The uppermost material encountered on-site is 
Topsoil, then Sandy Fine Clay, then Clay, and lastly Rock. 

Note:  If you need to add more or change their order you 
can. 

18. Select   in the Define Corridor Strata. 
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19. Select  in the Strata area under the 
Corridor tab. 

20. Enter BH1 in the Name cell. 
21. Enter 0+200 in the Station cell. 
22. Enter -25 in the Offset distance cell. 
23. Select  <<New layer>> in the Layer cell. 
24. Enter Boring Log Data in the Name cell and select 

. 

25. Select  in the Create 
Corridor Boring Log pane. 

Note:  A window appears allowing us to enter 
thicknesses for each layer of stratum.  This information 
all comes from a soils geotechnical report. 

26. Enter .2 in the Earthen: Topsoil Thickness cell. 
27. Enter 1.3 in the Earthen: Sandy Fine Clay Thickness cell. 

Note:  Notice the depth column is updated by combining 
all the thicknesses of the current material and those 
found above it. 

28. Enter 2.5 in the Earthen: Clay Thickness cell.   

Note:  The depth of the last material “rock in this case”, 
is automaticallty figured and is projected down from 
there.   

29. Select   in the Corridor Boring Log Strata 
Settings window. 

30. Select   in the Create Corridor Boring Log 
pane. 
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31. Enter BH2 in the Name cell.   
32. Enter 5+620 in the Station cell. 
33. Enter -5 in the Offset distance cell. 

34. Select Boring Log Data in the Layer drop-down list. 

35. Select  in the Create 
Corridor Boring Log pane. 

36. Enter .3 in the Earthen: Topsoil Thickness cell. 
37. Enter 3 in the Earthen: Sandy Fine Clay Thickness cell. 
38. Enter 2 in the Earthen: Clay Thickness cell.   

39. Select   in the Corridor Boring Log Strata 
Settings window. 

40. Select   in the Create Corridor Boring Log 
pane. 
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41. Enter BH3 in the Name cell.   
42. Enter 10+640 in the Station cell. 
43. Enter 20 in the Offset distance cell. 

44. Select Boring Log Data in the Layer drop-down list. 

45. Select  in the Create 
Corridor Boring Log pane. 

46. Enter .25 in the Earthen: Topsoil Thickness cell. 
47. Enter 2 in the Earthen: Sandy Fine Clay Thickness cell. 
48. Enter 3.5 in the Earthen: Clay Thickness cell.   

49. Select   in the Corridor Boring Log Strata 
Settings window. 

50. Select   in the Create Corridor Boring Log 
pane.  
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51. Expand Corridors and Main RD in the Project Explorer 
pane. 

Note:  The Mass Haul Analysis icon has changed.  This 
new icon indicates that mass haul objects have been 
edited that affect the analysis and that it needs to be 
refreshed. 

Note:  It is good practice to make all the necessary edits 
to the objects that make up the mass haul analysis and 
then refresh it.  Depending on the complexity of the 
analysis and sampling distance specified it can take time 
to complete the analysis. 

52. Right-click on the MH Analysis and select Refresh Mass 
Haul Analysis.   

Note:  The MH Analysis icon in the Project Explorer has 
now changed its color to orange and there is not a flag. 

 

 

53. Right-click on 0+000.00 STD Corridor Template and 
select Edit. 

54. Use the Slider at the bottom of the Corridor Template 
view to slide down the corridor. 

Note:  Notice the different layers of strata are now 
shown beneath the Original Ground surface.  
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Creating Barriers 
Often times when constructing a linear project the entire length of the project can not be considered as one.  It 
must be broken into multiple segments and each must balance due to rivers, environment restrictions, or bridges 
that are impassible. Creating a barrier in the mass haul analysis is how these situations are represents a location 
along the alignment of a corridor construction job site beyond which vehicles performing mass earthwork hauling 
operations cannot physically pass. 
Mass haul barriers represent a forced waste site for all hauled material in both directions, essentially acting as 
local start and finish points. 

55. Left-click on Main Rd in Project Explorer to highlight it. 

56. Select   in the Analysis are under the Corridor Mass Haul tab.   

Note:  There are more ordinate lines in the diagram than before.  Each material defined in the stratum is 
represented by it’s own line.  This allows managers to track each material type, both the usable and 
unusable quanties at any station along the alignment. 
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1. Select   in the Earthworks area under 
the Corridor Mass Haul tab.  

2. Enter River in the Name cell in the Create Mass Haul 
Barrier pane. 

3. Select MH Analysis in the Mass haul analysis drop-
down list.  

4. With the cursor in the Station cell, left-click in the plan 
view where the blue line representing the river 
intersects the corridor. 

Note:  You will need to zoom in and pan to the location 
where the river crosse the road.  A line will extend from 
the curser and hook to the corridor, left click when this 
line is right over the blue river line.  It is at station 7+310 
approximately. 

5. Select No in the Can circumvent drop-down list. 

6. Select  in the Create Mass Haul Barrier 
pane. 

7. Select   in the Create Mass Haul Barrier 
pane. 

 

8. Right-click on the MH Analysis in the Project Explorer and select Refresh Mass Haul Analysis.   

Note:  Notice the river that is now represented in the diagram and the red flag associated with it.  This is 
because there is a surplus of material at the station of the river that has not been dealt with yet.  Thus we 
need to create a waste site and in conjunction an export if desired.  Since there is a surplus of unusable 
material a waste site is mandatory.  Unusable material cannot be compensated for with an export because 
of it’s nature of being unusable.   
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Create Earthworks Sites 
The Create Earthworks command is used in Business Center - HCE to geographically define borrow pits and waste 
sites that can be used in the mass haul analysis to balance the site. 
Borrow sites are quarries that provide additional fill if there happens to be a deficit of material on the job site.  
Materials from borrow pits can be moved in either direction along the corridor's alignments, depending on where 
it is required. The borrow material is placed at the point where the haul road connects to the corridor. All material 
at a corridor mass haul borrow site is considered usable. This means that the percentage usable defined for the 
borrow material in the Material and Site Improvement Manager is not used. 
Waste sites are locations that unusable material and excess usable material can be taken if there is an excess of 
material on a job site.  All of the waste material (accumulated unusable and excess usable) is collected at the point 
where the haul road connects to the corridor. 
The use of borrow and waste sites is optimized based on the cost of material at the earthworks site and the cost of 
hauling material on the haul roads that connect the earthworks site to the corridor.  The cost of using haul roads is 
based on a unit/distance rate, so the software takes into account the costs associated with longer hauling 
distances to optimize the use of earthworks sites. 

1. Select  in the Earthworks area 
under theCorridor Mass Haul tab. 

2. Select Borrow Pit under the Site type drop-down list. 
3. Enter Jackson’s Quarry in the Name cell. 
4. Select Earthworks from the Layer drop-down list. 
5. With the curser in the Location cell, left-click just inside 

the boundary for Jackson’s Quarry in the NW corner of 
the site near the haul road.  

Note:  You can hover over the haul roads and boundaries 
to see there names.  Jackson’s Quarry is a yellow 
boundary in the NW corner and is connected by a green 
haul road. 

Note:  In the  computations folder located in the project 
settings, there is an option for mass haul settings.  Open 
this and note the site connection tolerance.  This is the 
distance that an earthworks site must be to the end of a 
haul road in order to be utilized in a mass haul analysis. 

6. Leave the cost per unit of material at $0.00. 

7. Enter 50,000  in the Capacity cell.   

Note:  This is the maximum amount of material 
available to borrow at this location. 

8. Select  in the Create Earthworks Site 
pane. 

Note:  There is a aqua colored excavator icon that 
denotes the borrow pit in the plan view. 
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9. Select Borrow Pit under the Site type drop-down list. 
10. Enter Northern Quarry in the Name cell. 
11. Select Earthworks from the Layer drop-down list. 
12. With the curser in the Location cell, left-click just inside 

the boundary for Northern Quarry in the NE corner of 
the site near the haul road.  

Note:  You can hover over the haul roads and boundaries 
to see there names.  Northern Quarry is a yellow 
boundary in the NE corner and is connected by a green 
haul road. 

13. Leave the cost per unit of material at $0.00. 
14. Enter 150,000  in the Capacity cell.   

15. Select  in the Create Earthworks Site 
pane. 

Note:  There is a aqua colored excavator icon that 
denotes the borrow pit in the plan view.  

16. Select Waste Site under the Site type drop-down list. 

17. Enter Southern Dump in the Name cell. 
18. Select Earthworks from the Layer drop-down list. 
19. With the curser in the Location cell, left-click just inside 

the boundary for Southern Dump in the SW corner of 
the site near the haul road.  

Note:  You can hover over the haul roads and boundaries 
to see there names.  Southern Dump is a yellow 
boundary in the SW corner and is connected by a green 
haul road. 

20. Leave the cost per unit of material at $0.00. 
21. Enter 400,000  in the Capacity cell.   

22. Select  in the Create Earthworks Site 
pane. 

Note:  There is a red colored dump truck icon that 
denotes the waste site in the plan view.  
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23. Select Borrow Pit under the Site type drop-down list. 
24. Enter Johnson’s Farm in the Name cell. 
25. Select Earthworks from the Layer drop-down list. 
26. With the curser in the Location cell, left-click just inside 

the boundary for Johnson’s Farm in the center of the 
site near the haul road.  

Note:  You can hover over the haul roads and boundaries 
to see there names.  Johnson’s Farm is a yellow 
boundary in the center of the site and is connected by a 
green haul road. 

27. Leave the cost per unit of material at $0.00. 
28. Enter 200,000  in the Capacity cell.   

29. Select  in the Create Earthworks Site 
pane. 

Note:  There is a aqua colored excavator icon that 
denotes the borrow pit in the plan view. 

30. Select  in the Create Earthworks Site 
pane. 

 

31. Turn off the Georeferenced Images in the View Filter Manager.   

Note:  The project plan view should look similar to below with three borrow pits and one waste site. 
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Creating Haul Roads 
As the Business Center - HCE project currently sits none of the earthworks sites created would be used in the mass 
haul analysis.  Without haul roads connecting the waste site or borrow pit to the corridor, the earthworks sites will 
not be used.   
Use the Create Haul Road  or Convert to Haul Road command to create linestings that define haul roads between 
earthwork sites, and a job site or a corridor.  You can also use them to circumvent a barrier or provide an alternate 
haul route in a corridor mass haul analysis.  In this project all the green lines denote haul roads, so the Convert to 
Haul Road command will be utilized. 
Haul roads have unique properties such as cost and directionality, this enables them to be used in a mass haul 
analysis. To view and edit these properties, you can use the properties pane or the mass haul editor. 

1. Select   in the Earthworks area 
under the Corridor Mass Haul tab. 

2. With the cursor in the Selection cell, hold-down the 
Ctrl key on the keyboard and left-click on all the green 
lines in the plan view.   

Note:  There should be a total of eight lines selected. 

3. Select  in the Convert to Haul Road pane. 

Note:  All eight linestrings are now haul roads and can 
be utilized in mass haul analysis. 

4. Select  in the Convert to Haul Road pane. 
 

5. Expand the Earthworks and also the Haul Roads in the 
Project Explorer. 

Note:  The names of all the linestrings are what the haul 
roads are now named. 

Note:  That the network of haul roads crosses the 
corridor in two locations.  These two stations are the 
entry and exit points for material being borrowed or 
wasted. 
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6. Expand Corridors and Main Rd in the Project Explorer. 
7. Right-click on MH Analysis and select Refresh Mass 

Haul Analysis. 

Note:  In the plan view there are two of the haul roads 
have changed to the color red and have arrows at the 
ends.   

8. Left-click on the red line Waste: Southern Dump to 
select it. 

Note:  There are two Waste: Southern Dump listed, just 
choose the second one.  There is one for going to each 
location that crosses the corridor. 

9. Right-click in the graphical view and select Properties. 

Note:  You can gain insight into how much material is 
being transported to the waste site and the distance it is 
being transported. 

Note:  You can explore the mass haul objects in the plan 
view by left-clicking on them with the Properties pane 
open. 

 

10. Select   in the Analysis area under the Corridor Mass Haul tab, if it is not already 
open. 

Note:  Notice the Southern Dump waste site is shown twice in the diagram and the Johnson’s Farm quarry is 
shown once.  The location on the diagram is determined by the stationing along the alignment that the 
material exits or is brought to the site. 

Note:  That the flags at the river barrier and at the end of the corridor are now gone, because the surplus 
and deficit of material from the previous analysis is able to be transported through the network of haul 
roads from borrow sites and to waste sites. 
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Creating Imports and Exports 
Use the Create Mass Haul Import command to force a specific volume of usable and unusable material to be 
accepted at a particular station along a corridor's alignment. You can also specify usable and unusable volumes to 
be considered in the corridor mass haul analysis. 
Import values specify exact quantities of material that must be supplied at a particular point.  The mass haul 
analysis does not consider the source of the imported material and just accepts that it will be supplied at a specific 
location along the alignment.  This import material can then be distributed along the alignment over a specified 
distance. All import earthworks must be used and the excess import is hauled to locations until it is used. 
One example for forcing an import is as follows.  Our organization has another construction project 5 miles away 
that has an 50,000 CM excess of material.  Since this current project has a deficit it makes sense to force an import 
of that material here as opposed to paying to waste the material from that project and also paying to purchase 
material for this project. 
Use the Create Mass Haul Export command to force the removal of a specified quantity of usable material at a 
particular station along a corridor's alignment. Export values specify exact quantities of material that must be 
removed at a particular point.  All export earthworks specified at a particular location must be used and a deficit 
caused by export needs to be compensated for by the system. 
Creating an export is how stockpiling material is specified in the mass haul analysis.  If the capacity of waste sites 
was not enough to handle the excess material of a site then an export would have to be created as well to balance 
the site. 
For this next exercise we have a deal with farmer Pyziak to get 35,000 CM of material for free because he is 
digging a lake.  So we need to create an import to account for this material in the mass haul analysis. 

1. Select  in the Earthworks area under 
the Corridor Mass Haul tab. 

2. Enter Pyziak’s Lake Clay in the Name cell. 
3. Select MH Analysis in the Mass haul analysis drop-

down list. 
4. Enter 6+725 in the Station cell. 

Note:  This is the stationing that the import will be 
dropped at. 

5. Enter 35,000 in the Usable quantity cell. 
6. Leave the Unusable quantity at 0. 

7. Select  in the Create Mass Haul Import 
pane. 

Note:  A green dot is placed at the stationing along the 
alignment where the import was created.  
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Note:  We will now assume that we need to stockpile 
20,000 CM of material to be used on a future levy 
project.   

8. Select   in the Earthworks area under 
the Corridor Mass Hual tab. 

9. Enter Future Levy Stockpile in the Name cell.  

10. Enter 7+735 in the Station cell.  
11. Enter 20,000 in the Quantity cell. 

12. Select  in the Create Mass Haul Import 
pane. 

Note:  In the plan view there is a red dot indicating an 
export has been created at this stationing. 

 

13. Expand Corridors and Main Rd in the Project Explorer. 

14. Right-click on MH Analysis and select Refresh Mass Haul Analysis. 

15. Select   in the Analysis area under the Corridor Mass Haul tab, if it is not already 
open. 

16. Pan and zoom into the Clay (Usable) line near the Pyziak Lake Clay stationing in the diagram. 
17. Left-click on the Clay (Usable) to select it. 

Note:  If you are unsure of which line is the Clay (Usable), you can left-click on the line to select it with the 
Properties pane open to see what it is labeled. 

Note:  The volume increases by 35,000 CM at this station because of the import.  The reason the material is 
deemed as Clay that is being imported, is because that is the specified borrow material in the corridor 
properties.  If the borrow material was switched to Sandy Fine Clay, then this ordinate would increase by 
35,000 CM at this station. 

 



Page | 213  
 

Creating Haul Ranges for Machines 
Before you can  use tools to balance the earthwork materials in the mass haul analysis, the Create Haul Range 
command needs to be executed to specify the maximum distance that each machine type available for the project 
can be used to economically move material.  Use haul ranges to define the vehicles available for the project and 
the distance that material can be hauled efficiently in these vehicles before additional costs are incurred (free haul 
distance).  Haul ranges are used when a mass haul analysis is balanced.  You can add additional vehicles (haul 
ranges) to your project to reduce the amount of over haul. 
Free Haul – The amount of material that can be moved economically in a corridor mass haul balancing process.  
Ideally 100% of material is in the free haul range. 
Over Haul – The amount of material that will incur additional costs to move in a corridor mass haul balancing 
process.  If incurred in a mass haul analysis this is an indicator to utilize resources with a greater haul range. 

Cross Haul – The amount of material cut being moved across an alignment and used as fill in a corridor mass haul. 

18. Pan and zoom into the Sandy Fine Clay (Usable) line near the Future Levy Stockpile stationing in the 
diagram. 

19. Left-click on the Sandy Fine Clay (Usable) to select it. 

Note:  If you are unsure of which line is the Clay (Usable), you can left-click on the line to select it with the 
Properties pane open to see what it is labeled. 

Note:  At this stationing the volume decreases by 20,000 CM , going from -28,000 CM to -48,000 CM due to 
the export created at this station.   The material is Sandy Fine Clay because at this location along the 
alignment, the cut is within this portion of the original ground strata.  

Note:  You might be asking, how can material that does not exist be exported?  Remember this question and 
it will be addressed once we run a balance line report. 
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1. Select  in the Balancing area under the Corridor 
Mass Haul tab. 

2. Enter Dozer in the Name cell. 
3. Enter 70 in the Limit cell. 

Note:  The maximum distance limit for this dozer is 70M. 

4. Select Alignment Only in the Type drop-down list. 

General –  Use this haul range type if you do not want to 
limit how the earthmoving equipment (haul range) is 
used. 

Alignment Only – this haul range type limits the 
machine to only being used to move material between 
cut and fill zones along the alignment.  This prevents a 
machine from using a haul road. 

Alignment to Offsite –  Use this haul range type to 
balance material that is cut from the alignment and 
exported offsite. 

Offsite to Alignment –   Use this haul range type to 
balance against material that is imported from offsite 
and used as fill in the alignment. 

5. Select  in the Create Haul Range pane. 

 

6. Enter Scraper in the Name cell. 

7. Enter 500 in the Limit cell. 
8. Select Alignment Only in the Type drop-down list. 

9. Select  in the Create Haul Range pane. 
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Automatically Balancing Mass Haul Earthworks 
Now that haul ranges are defined for the equipment available on the project, the Auto-Balance Mass Haul 
command is used to apply the haul ranges to the balanced sections. 

10. Enter  Excavator/Off-Road Truck in the Name cell. 
11. Enter 4000 in the Limit cell. 
12. Select General from the Type Drop-down list. 

13. Select  in the Create Haul Range pane. 

 

14. Enter Excavator/Tractor Trailer in the Name cell. 

15. Enter 10,000 in the Limit cell. 
16. Select General from the Type Drop-down list. 

17. Select  in the Create Haul Range pane. 

18. Select  in the Create Haul Range pane. 
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1. Expand Corridors and Main Rd in the Project 
Explorer. 

2. Left-click on MH Analysis to select it. 

3. Select  in the Balancing area 
under the Corridor Mass Haul tab. 

Note:  No input is required for this command, the 
command determines the vehicles required to 
move material between balance points.  In the 
Mass haul Diagram, a balance point is the point 
where the usable material ordinate crosses the 
zero volume line.  At this point along the aligment 
the amount of cut equals the amount of fill.  Haul 
ranges are used in the balancing process to 
determine the amount of material that is moved 
economically “free haul” and the amount of material that will incur additional costs to move “over haul”.  

Note:  The haul range with the smallest limit is used first providing the Haul range type is suitable. For more 
information on suitable haul range types see Create a Haul Range. When the haul range limit is reached the 
next smallest suitable haul range is used. The process continues until all material is balanced or the largest 
Haul range limit has been reached. The remaining material is overhaul.  

Note:  If overhaul exists, existing earthmoving vehicles can be used to balance the remaining material at a 
higher cost; different earthmoving vehicles that can economically haul larger distances can be added to the 
project or additional borrow and waste sites can be added to reduce the distance material needs to be 
moved along the alignment. 

Note:  Only haul ranges with types alignment to offsite, offsite to alignment or general can be used to 
balance against vertical lines caused by import, export, borrow, waste or haul. 
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Balancing Mass Haul Earthworks at a Station 
Use the Balance Mass Haul at Grade Point command to specify a grade point on an alignment at which you want 
material balanced and haul ranges applied.   

4. Pan and zoom in the Mass Haul Diagram tell you see 
28: Excavator/Off-Road Truck. 

5. Left-click on Balance Line 28:Excavator/Off-Road Truck 
to select it. 

6. Right-click in the graphical view and select Properties. 

Cut Range – the station range where the scraper is 
cutting material. 

Fill Range – the station range where the scraper is filling 
material.  In this balance line the material is moving 
down alignment, this is also indicated with an arrow on 
the balance line in the mass haul diagram. 

Distance – the average distance the material is being 
hauled from cut to fill is given here. 

Volume Information – details cut and fill volume totals, 
and import material used in this zone.  It also details 
that this resource is the most economical way to 
contribute to the export we placed for the Future Levy 
Stockpile.  

Materials – details showing volumes of each material is 
given here. 

7. Select   in the Balancing area under 
the Corridor Mass Haul tab. 

Note:  This will delete the auto-balance that was just 
applied, so that we can do a manual balance in the next 
excersice.  
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Applying Costs and Editing Mass Haul Objects 
The mass haul cost for usable material is determined by the area between the usable line and the 0 line in the 
Mass Haul Diagram multiplied by the per cubic meter per unit distance volume cost (the same is true for unusable 
material). For details on how corridor mass haul cost calculation are made, see the help topic called Run a Corridor 

1. Select  in the Balancing area under 
the  Corridor Mass Haul tab. 

2. Select MH Analysis in the Mass haul analysis drop-
down list. 

3. With the curser in the Grade point cell, left-click in the 
mass haul diagram on any of the grade points.   

Note:  Balances are created at the maximum volume of 
surplus material or the maximum volume of deficit of 
material that is closest to the station specified between 
two balance points. They are denoted by red and blue 
dots. 

Red - Bottom of a fill zone 

Blue - Top of a cut zone 

Note:  If manually entering a station, the nearest grade 
point will be utilized if the station entered is not a grade 
point. 

4. Select  in the Balance Mass Haul at 
Grade Point pane. 

 

5. Repeat steps 3 and 4 to add a few Grade Points to see what happens in the Mass Haul Diagram.   

Note:  Balance the mass haul in the order that you plan to haul material on site. Mass haul volumes are 
dependent on the order in which you balance each section.  If a project planner wants to start at the river 
and work away from this point, pick the grade point near the river and work towards the begin stationing. 
You will then notice in the mass haul diagram that the balance line arrows are moving away from the river, 
thus showing the direction of material haulage. 

6. Select   in the Balancing area under the Corridor Mass Haul tab. 

7. Select  in the Balancing area under the Corridor Mass Haul tab. 

Note:  We will use the auto balance for the rest of the exercises. 
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Mass Haul Report. Although you can set costs as you create each mass haul object, let's examine and set costs for 
all of the various objects that affect the total cost now. 

1. Right-click on MH Analysis in the Project Explorer pane 
and select Properties. 

Note:  The Cost($/CM/KM) specifies the price of cutting, 
pushing/hauling,filling,and compacting each unit of 
earthen materials one distance unit along the corridor.   

2. Enter 5 in the Cost($/CM/KM) cell. 
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3. Select   in the Analysis area under the Corridor Mass Haul tab. 

Note:  A pane with all the mass haul objects appears with costing. 

Borrow Pit Costs = the price of purchasing each unit of borrow material. 

Waste Pit  Costs = the price of dumping each unit of waste material. 

Haul Road Costs = the price to move each unit of material one distance unit along the haul road.  The cost is 
multiplied by the length of the haul road to calculate the price to move each unit of material to the 
construction project.  The software then chooses which borrow pit or waste site to use.  It weighs the price 
to haul the material plus the price to purchase or waste the material, and opts for the most efficient 
method. 

4. Enter .75  in the Site cost cell for the Southern Dump. 

Note:  The cost is cheap because they want to build up a low region so they can build on the site. 

5. Enter 2.5 in the Site cost cell  for Johnson’s Farm. 
6. Enter 4.0 in the Site cost cell for the Northern Quarry. 
7. Enter 3.0 in the Site cost cell for Jackson’s Quarry. 
8. Enter 0.002 in the Haul cost cell for all haul roads. 

Note:  If for one reason or another a mass haul object is not to be available for use in the analysis anymore 
simply left-click in the Active box to remove the checkmark. 

Note:  If more accurate estimates are available for the quantities available at earthworks sites, simply edit 
the volume here as well. 

 

9. Expand Corridors and Main Rd in the Project Explorer. 

10. Right-click on MH Analysis and select Refresh Mass Haul Analysis. 
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Archiving a Corridor Mass Haul Analysis 
Use the Archive Corridor Mass Haul command to manually archive a corridor mass haul analysis. When a mass 
haul plan is published to VisionLink, the corridor mass haul analysis is automatically archived.   Archiving preserves 
the current corridor mass haul details and restricts the mass haul analysis to viewing only. 

Running a Corridor Mass Haul Report 

1. Expand Corridors and Main Rd in the Project Explorer. 
2. Left-click on MH Analysis to selct it. 

3. Select    in the Archive area under the 
Corridor Mass Haul tab.  

Note:  In the project explorer there will be a MH Analyis 
[Date/Time] created that is now read-only. 

 

 

1. Select the Corridor Mass Haul Report  icon in the 
Reports area under the Corridor Mass Haul tab. 

2. Select MH Analysis in the Mass haul analysis drop-
down list. 

Note:  If you still have MH Analysis highlighted from the 
step before, you will not see this screen.  The Report will 
automatically come up for the highlighted Mass Haul 
Analysis. 

3. Select  in the Corridor Mass Haul Report 
pane.  
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Running a Corridor Balance Line Report 
Run a Balance Line Report to capture the properties and details of a corridor mass haul’s balance line.  I 
recommend having the topic in the help section titled Understanding Balancing in a Corridor Mass Haul as a 
reference until comfortable with the terminology. 

4.  Review the results in the Corridor Mass Haul Report. 

• The source section shows volumes of cut materials at station intervals along the corridor’s alignment. 

• The destination section shows volumes of material used for fill at station intervals. 

• The haul cost is the price of hauling the specified volume of material from the earthworks site to the 
corridor – or vice versa. 

• The site cost is the price of material being used from the borrow site or being dumped at the waste site. 

• The total cost is the combined price of haul plus site cost. 
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1. Select the Balance Line Report  icon in the Report 
area under the Corridor Mass Haul tab. 

2. Select MH Analysis in the Mass haul analysis drop-
down list. 

3. Select  in the Balance Line Report pane. 
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Drilling 

Welcome 
Welcome to the Trimble® Business Center – Heavy Construction Edition (HCE) Drill Plan module.  The Drill Plan 
module in Business Center - HCE incorporates tools and commands to prepare drill plans for drilling machines that 
are running Trimble® DPS900 Drilling and Piling System (“DPS900”).   
This guide was developed by Trimble Navigation’s Global Services Training and Support staff to support classroom 
instruction delivered by a Trimble Certified Trainer.  The Trimble Certified Trainer will use this guide to lead you 
through the Drill Plan module using real world exercises.  Please use this guide in conjunction with the Business 
Center- HCE help files and other product resources available. 

Overview 
Drill planning in Business Center - HCE enables you to create a variety of drill plans to send to DPS900, a Trimble 
drilling and piling system for road construction and pit mining. The drill plan helps the DPS900 machine operator 
navigate to holes (nearest, previous, next, or selected), and then guides him in drilling the holes at the planned 
orientation, inclination, and depth. 
The commands available in the Drill Plan module can be divided into three categories: Drill Plans, Data Export, and 
Drill Plan Reporting. 
We will start by ecamining the various automatic methods of creating a drill plan.  Then a point file will be 
imported and a drill plan can be manually created from this data.  After the drill plan is created it can be exported 
to a machine running DPS900.  After the drilling has been carried out a drill plan quality file can be imported back 
into Business Center - HCE and a drill hole quality report can then be generated. 

Learning Objectives 
• Create an automatic drill plan using a boundary 

• Create an automatic drill plan using a corridor 

• Create an automatic drill plan using a grid 

• Create an automatic drill plan using a reference line 

• Add a new drill hole to a drill plan 

• Import point data containing drill plan designs 

• Create a manual drill plan from imported data 

• Export data to DPS900 
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• Generate a drill hole quality report 

Drill Plan Definitions 
Create a Drill Plan Based on a Boundary - Use the Create Drill Plan command to create a gridded drill plan (drill 
hole pattern) within a boundary. Split holes are created (facing perpendicularly inward) along the boundary line 
and blast holes are created within the bounded area. The grid's columns are fixed, but the row spacing can use 
fixed or dynamic spacing (which adjusts the width between holes to avoid adding extra holes near or outside of 
the boundary). This drill plan type allows you to drill blast holes to a design surface or to a single benching 
elevation. 
Create a Drill Plan Based on a Corridor - Use the Create Drill Plan command to create a gridded drill plan of blast 
holes along a corridor design. This type of drill plan can be constrained between a start and end station, and by a 
boundary. Corridor drill plans also support benching, which allows you to create successive ledges by drilling split 
holes one vertical level at a time.  One set of drill holes is created for each bench.  
Create a Drill Plan Based on a Grid - Use the Create Drill Plan command to create a drill plan based on an origin, 
design surface, rock surface, and a uniform spacing (rows and columns) of blast holes. This type of drill plan can be 
constrained by a boundary. 
Create a Drill Plan Based on a Reference Line - Use the Create Drill Plan command to create a gridded drill plan of 
blast holes (and optionally split holes) along and offset from a reference line. This type of drill plan can be 
constrained between a start and end station, and by a boundary. 
Create a Drill Plan Manually - Use the Create Manual Drill Plan command to create an empty drill plan to which 
you can add drill holes in preparation for sending the plan to a drilling machine running DPS900. In addition, you 
can create a Manual drill plan by importing a drill plan in an IREDES file, which you can then modify.  
Add a Drill Hole to a Drill Plan - Use the Add Drill Hole to Drill Plan command to add one or more drill holes to an 
existing drill plan of any type. You can specify coordinates for each drill hole or you can create drill holes at the 
locations of existing objects, such as points. If you import a drill plan in an IREDES file, you can also add new drill 
holes to it. 
Export - Export the drill plan as a Project Link file (.vcl) for use on a drilling machine running DPS900. You may also 
want to export a separate .vcl file (to be placed in the Design folder) containing reference linework of site 
features. A calibration (.dc) file may also need to be exported for the calibration of control. 
Run a Drill Hole Quality Report - Use the Drill Hole Quality Report command to see a summary and details on 
pairs of drill holes; the holes in a drill plan (planned holes) as compared to their corresponding as-drilled holes. 
Each as-drilled hole that is reported on is qualified as passing, failing, or requiring action (based on the tolerances 
in Project Settings). The Drill Hole Quality Report is generated as a Microsoft® Excel spreadsheet. 

Files Needed 
For the training exercises, each user should save the following files provided by your Certified Trainer onto their 
PC and note the location. 
• Drill Plan.csv 
• P,N,E,ELV Drill Plan Coordinates.csv 

• Manual Drill Plan.vcl 
• Manual Drill Plan.quality.xml  

Creating Automatic Drill Plans 
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After completing this section you will be able to: 

• Create different types of drill plans in Business Center - HCE 

• Add individual drill holes to a drill plan 
There are four automatic ways to create a drill plan in Business Center - HCE. These are boundary, corridor, grid, 
and line. The types of plans created will be shown in more detail in the individual sections. 

Boundary Plan  

1. Open the Drill Plan.vce file. 

2. Select  in the Drill Plans area under the Drill Plan 
tab. 

 

3. Select Boundary in the Drill Plan Type drop-down list. 
4. Enter Boundary Drill Plan in the Name cell. 
5. Select  Boundary – Drill Plan BDY in the Default layer 

for holes drop-down list. 
6. Select Design Surface in the Design surface drop-down 

list. 
7. Select Rock Surface in the Rock surface drop-down list. 
8. With the curser in the Boundary cell, left-click on the 

Red boundary line in the graphical view to select it. 
9. Select Grid (fixed hole spacing) in the Grid type drop-

down list. 
10. With the cuser in the Origin point cell, left-click in the 

center of your boundary in the graphicial view. 
11. Enter 90 into the Orientation (column) cell. 

Note:  You can also use the curser in the graphical view 
to set the Orientation (column) angle. 
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12. Select  in the Create Drill Plan pane. 

Note:  The edit settings dialog allows you to define the 
settings for the drill plan. This guide will not go into 
these settings in detail, as they are specific to each 
projects’ requirements. Full details for all of these 
settings can also be found in the Business Center - HCE 
help files.  

13. Enter 30 in the Hole length (display only) cell. 

14. Enter 5 in the Minimum hole length cell. 

15. Enter .5 in the Maximum distance above rock cell.  

16. Select the Blast Holes tab in the Edit Drill Plan Settings 
window. 

Note:  The Blast Holes tab allows you to define the 
parameters of the blast holes. This includes diameter, 
orientation, inclination, duplicate tolerance, burden, 
spacing and edge tolerance. 

17. Enter 4 in the Hole diameter (Inch) cell. 
18. Enter 1 in the Duplicate design point tolerance cell. 
19. Enter 20 in the Distance cell under Row Spacing 

(Burden). 

20. Enter 15 in the Column spacing cell. 
21. Enter 2.5 in the Extra hole edge tolerance cell. 

 

22. Select the Split Holes tab in the Edit Drill Plan Settings 
window. 

Note:  The Split Holes tab allows you to define the 
parameters of the split holes. This includes diameter, 
inclination, duplicate tolerance and spacing. 

23. Enter 1 in the Duplicate design point tolerance cell. 
24. Enter 10 in the Maximum hole spacing cell. 
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25. Select the Subdrilling tab in the Edit Drill Plan Settings 
window. 

Note:  The Subdrilling tab allows you to define the 
Subdrilling parameters. These include settings to define 
how the subdrilling is calculated, and settings for the 
blast and split hole constants. 

26. Left-click in the box in front of Include length 
percentage to add a checkmark. 

27. Left-click in the box in front of Include split hole 
constant to add a checkmark. 

28. Enter -2 in the Split hole constant: (usually negative) 
cell. 

 

29. Select the Quality tab in the Edit Drill Plan Settings 
window. 

Note:  The Quality tab allows you to define the 
tolerances for the diameter and end points of the drill 
holes. 

30. Select Distance in the Method drop-down list under 
Blast Hole End Point Tolerance. 

31. Enter .5 in the 3D distance cell under Blast Hole End 
Point Tolerance. 

32. Enter .5 in the 3D distance cell under Split Hole End 
Point Tolerance.  
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33. Select the Estimation tab in the Edit Drill Plan Settings 
window. 

Note:  The Estimation tab allows you to define time, cost 
and cost factor for the drilling job. The cost factor is the 
amount of down time between the actual drilling. 

34. Enter 90 in the Blast hole rate: (ft/h) cell under 
Average Penetration Rate. 

35. Enter 120 in the Split hole rate: (ft/h) cell under 
Average Penetration Rate. 

36. Enter 225 in the Cost per hour ($) cell under Cost. 
37. Enter 1.15 in the Cost factor cell under Cost. 

38. Select  in the Edit Drill Plan Settings 
window. 

 

39. Select   in the Create Drill Plan pane. 

Note:  A box similar to the one shown on the right will 
appear. Your values may be slightly different depending 
on where you clicked for the origin point. 

 

40. Select  in the Information window. 
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41. Select    in the View area under the Drill 
Plan tab. 

Note:  You could also select the  icon in the Quick 
Access Toolbar to create a 3D View. 

Note:  The boundary contains both cut and fill areas. In 
the fill areas no drill plan is created.  The split holes are 
shown in red and the blast holes are shown in blue. You 
can see that the angles of the holes correspond to those 
chosen in the settings. 

 

42. Turn off the Rock Surface in the View Filter Manager 
and zoom in on a group of holes. 

Note:  You can see that where the minimum hole depth 
is met, the split holes end slightly above the design 
surface.  

Note:  The blast holes end beneath the design surface. 
This is because of the settings chosen when creating the 
drill plan.  

Note:  The small orange marks on the drill holes show 
where the drill hole intersects the rock surface.  

43. Expand the Drill Plans in the Project Explorer pane. 
44. Right-click on Boundary Drill Plan in the Project 

Explorer pane and select Properties. 

Note:  You can review the properties for the whoe Drill 
Plan. 
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45. Left-click on any hole in the Plan view. 

Note:  You can now see the properties of the selected 
hole. 

Note:  Depending on the distance between the rock 
surface, the design surface, and the minimum hole 
length setting; the software will extend drill holes so 
that they meet the minimum length specified. If the hole 
is extended it will be shown in the properties. If you do 
not want this to happen set the minimum length to 0in 
the settings tab. 

 

 

46. Left-click on Boundary Drill Plan in the Project Explorer 
pane to select it and select  in the Drill 
Plans area under the Drill Plan tab. 

Note: You can also right-click on the Boundary Drill Plan 
in the Project Explorer pane and select Edit. 

Note:  This reopens the create drill plan dialog from 
earlier and you can change any settings. 

 

47. Enter 480 in the Bench eleavtion cell in the Edit Drill 
Plan pane. 
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Grid Plan 

48. Select   in the Edit Drill Plan pane. 

Note:  A box similar to the one shown on the right will 
appear. Your values may be slightly different depending 
on where you clicked for the origin point. 

 

49. In the 3D view, Pan and Zoom around the site. 

Note:  A bench has been created at the 480.00 elevation. 

Note:  You can check the properties of the drill holes to 
see that the Design Point Elevations all now end above 
480 which is the bench height. 

50. Select Save Project As under the File tab. 

51. Name the file and select Save. 
52. Select Close under the File tab.  

1. Open the Drill Plan.vce file. 

2. Select  in the Drill Plans area under the Drill Plan 
tab. 
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3. Select Grid from the Drill Plan Type drop-down list. 
4. Enter Grid Drill Plan in the Name cell under Properties. 
5. Select <<New Layer>> from the Default layer for holes 

drop-down list. 
6. Enter Grid Drill Plan in the Layer name cell. 

7. Select  in the New Layer window. 
8. Select Design Surface from the Design surface drop-

down list. 
9. Select  Rock Surface from the Rock surface drop-down 

list. 
10. Ensure that the Boundary cell is blank. 

 

11. With the curser in the Origin point cell under Grid, left-
click in the plan near the same point as shown in the 
picture to the right. 

12. Enter 30 in the Orientation cell under Grid. 

13. Select  in the Create Drill Plan pane. 

 

14. Enter 40 in the Hole length (display only) cell. 

15. Enter 10 in the Minimum hole length cell. 

16. Enter .0 in the Maximum distance above rock cell. 

 



Page | 234  
 

17. Select the Blast Holes tab in the Edit Drill Plan Settings 
window. 

Note:  The Blast Holes tab allows you to define the 
parameters of the blast holes. This includes diameter, 
orientation, inclination, duplicate tolerance, burden, 
spacing, and edge tolerance. 

18. Enter 30 in the Hole orientation cell. 
19. Enter 1 in the Duplicate design point tolerance cell. 
20. Enter 20 in the Distance cell under Row Spacing 

(Burden). 
21. Enter 15 in the Column spacing cell. 
22. Enter 8 in the Rows behind cell. 

23. Enter 5 in the Holes to the left cell. 
24. Enter 10 in the Holes to the right cell. 

 

25. Select the Subdrilling tab in the Edit Drill Plan Settings 
window. 

Note:  The Subdrilling tab allows you to define the 
Subdrilling parameters. These include settings to define 
how the subdrilling is calculated and settings for the 
blast and split hole constants. 

26. Left-click in the box in front of Include factor to row 
spacing (burden) to add a checkmark. 

27. Enter .15 in the Factor of row spacing (burden) cell. 

 

28. Select the Quality tab in the Edit Drill Plan Settings 
window. 

Note:  The Quality tab allows you to define the 
tolerances for the diameter and end points of the drill 
holes. 

29. Select Distance in the Method drop-down list under 
Blast Hole End Point Tolerance. 

30. Enter 1 in the 3D distance cell under Blast Hole End 
Point Tolerance. 

31. Enter 1 in the 3D distance cell under Split Hole End 
Point Tolerance.  
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32. Select the Estimation tab in the Edit Drill Plan Settings 
window. 

Note:  The Estimation tab allows you to define time, cost 
and cost factor for the drilling job. The cost factor is the 
amount of down time between the actual drilling. 

33. Enter 75 in the Blast hole rate: (ft/h) cell under 
Average Penetration Rate. 

34. Enter 120 in the Split hole rate: (ft/h) cell under 
Average Penetration Rate. 

35. Enter 275 in the Cost per hour ($) cell under Cost. 
36. Enter 1.2 in the Cost factor cell under Cost. 

37. Select  in the Edit Drill Plan Settings 
window. 

 

38. Select   in the Create Drill Plan pane. 

Note:  A box similar to the one shown on the right will 
appear. Your values may be slightly different depending 
on where you clicked for the origin point. 

 

39. Select  in the Information window. 
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Corridor Plan 

40. Select    in the View area under the Drill 
Plan tab. 

Note:  You could also select the  icon in the Quick 
Access Toolbar to create a 3D View. 

Note:  You can check the properties of the drill holes like 
we did earlier in the module. 

41. Select Save Project As under the File tab. 
42. Name the file and select Save. 
43. Select Close under the File tab. 

 

1. Open the Drill Plan.vce file. 
2. Turn off all Layers and Surfaces in the View Filter 

Manager except Road Cut Fill Map for Rock surface and 
Road Surface surface. 
Note:  You can clearly see were drilling is required from 
the Road Cut Fill Map For Rock surface. 

 

3. Select  in the Drill Plans area under the Drill Plan 
tab. 
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4. Select Corridor from the Drill Plan Type drop-down list. 
5. Enter Road Drill Plan in the Name cell under 

Properties. 
6. Select <<New Layer>> from the Default layer for holes 

drop-down list. 
7. Enter Road Drill Plan in the Layer name cell. 

8. Select  in the New Layer window. 

9. Select Road Surface from the Corridor drop-down list. 
10. Select Rock Surface from the Rock surface drop-down 

list. 
11. Leave the Begin and End stations on the default 

settings. 
12. Ensure that the box in front of Build Benches is 

unchecked. 

13. Select  in the Create Drill Plan pane. 

 

14. Enter 25 in the Hole length (display only) cell. 

15. Enter 5 in the Minimum hole length cell. 

16. Enter .0 in the Maximum distance above rock cell. 
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17. Select the Blast Holes tab in the Edit Drill Plan Settings 
window. 

Note:  The Blast Holes tab allows you to define the 
parameters of the blast holes. This includes diameter, 
orientation, inclination, duplicate tolerance, burden, 
spacing and edge tolerance. 

18. Enter 4 in the Hole diameter (Inch) cell. 
19. Enter 1 in the Duplicate design point tolerance cell. 
20. Enter 20 in the Distance cell under Row Spacing 

(Burden). 
21. Enter 15 in the Maximum hole spacing cell. 
22. Enter 2.5 in the Extra hole edge tolerance cell. 

 

23. Select the Split Holes tab in the Edit Drill Plan Settings 
window. 

Note:  The Split Holes tab allows you to define the 
parameters of the split holes. This includes diameter, 
inclination, duplicate tolerance, and spacing. 

24. Enter 1 in the Duplicate design point tolerance cell. 
25. Enter 10 in the Station spacing cell. 

 

26. Select the Subdrilling tab in the Edit Drill Plan Settings 
window. 

Note:  The Subdrilling tab allows you to define the 
Subdrilling parameters. These include settings to define 
how the subdrilling is calculated, and settings for the 
blast and split hole constants. 

27. Left-click in the box in front of Include length 
percentate to add a checkmark. 

28. Enter 5 in the Length percentage cell. 
29. Left-click in the box in front of Include split hole 

constant to add a checkmark. 
30. Enter -2 in the Split hole constant (usually negative) 

cell. 
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31. Select the Quality tab in the Edit Drill Plan Settings 
window. 

Note:  The Quality tab allows you to define the 
tolerances for the diameter and end points of the drill 
holes. 

32. Select Distance in the Method drop-down list under 
Blast Hole End Point Tolerance. 

33. Enter .5 in the 3D distance cell under Blast Hole End 
Point Tolerance. 

34. Enter .5 in the 3D distance cell under Split Hole End 
Point Tolerance.  

35. Select the Estimation tab in the Edit Drill Plan Settings 
window. 

Note:  The Estimation tab allows you to define time, 
cost, and cost factor for the drilling job. The cost factor 
is the amount of down time between the actual drilling. 

36. Enter 90 in the Blast hole rate: (ft/h) cell under 
Average Penetration Rate. 

37. Enter 120 in the Split hole rate: (ft/h) cell under 
Average Penetration Rate. 

38. Enter 250 in the Cost per hour ($) cell under Cost. 

39. Enter 1.2 in the Cost factor cell under Cost. 

40. Select  in the Edit Drill Plan Settings 
window. 

 

41. Select   in the Create Drill Plan pane. 

Note:  A box similar to the one shown on the right will 
appear. 
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Reference Line Plan  

42. Select  in the Information window. 

 

43. Select    in the View area under the Drill 
Plan tab. 

Note:  You could also select the  icon in the Quick 
Access Toolbar to create a 3D View. 

Note:  You can check the properties of the drill holes like 
we did earlier in the module. 

 

44. Expand Drill Plans in the Project Explorer pane. 

45. Right-click on Road Drill Plan and select Properties. 
46. Select No in the Show drill hole ID labels under Show in 

View, in the Properties pane. 
47. Select No in the Show blast holes under Show in View, 

in the Properties pane. 
48. Select Save Project As under the File tab. 
49. Name the file and select Save. 

50. Select Close under the File tab. 
 

1. Open the Drill Plan.vce file. 
2. Turn off all Layers and Surfaces in the View Filter 

Manager except for Reference Line layer and Design 
Surface. 

3. Select  in the Drill Plans area under the Drill Plan 
tab.  
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4. Select Reference line in the Drill Plan Type drop-down 
list.  

5. Enter Reference Line Drill Plan in the Name cell. 
6. Select Reference Line in the Default layer for holes 

drop-down list. 
7. Select Design Surface in the Design surface drop-down 

list. 
8. Select Rock Surface in the Rock surface drop-down list. 
9. With the curser in the Reference line cell, left-click on 

the Linestring: Reference Line. 

 

10. With the curser in the Bounday cell, left-click on the 
Boundary: Ref Boundary. 

Note:  If you left-click on the upper part of the Boundary 
like the step before, you will have to choose the 
Boundary: Ref Boundary.  If you left-click anywhere else 
on the boundary, it will just be entered into the cell. 

11. Leave the Begin and End stations on their default 
settings. 

12. Select   in the Create Drill Plan pane. 

 

13. Enter 35 in the Hole length (display only) cell. 

14. Enter 8 in the Minimum hole length cell. 

15. Enter 0 in the Maximum distance above rock cell. 
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16. Select the Blast Holes tab in the Edit Drill Plan Settings 
window. 

Note:  The Blast Holes tab allows you to define the 
parameters of the blast holes. This includes diameter, 
orientation, inclination, duplicate tolerance, burden, 
spacing and edge tolerance. 

17. Enter 4 in the Hole diameter (Inch) cell. 
18. Enter 0 in the Hole inclination cell. 
19. Enter 1 in the Duplicate design point tolerance cell. 
20. Enter 20 in the Distance cell under Row Spacing 

(Burden). 
21. Enter 15 in the Spacing along lines cell. 

22. Enter 0 in the Offset lines to the left cell. 
23. Enter 150 in the Offset lines to the right cell. 
24. Enter 1 in the Segment end point tolerance cell. 

 

25. Select the Split Holes tab in the Edit Drill Plan Settings 
window. 

Note:  The Split Holes tab allows you to define the 
parameters of the split holes. This includes diameter, 
inclination, duplicate tolerance, and spacing. 

26. Left-click on the box next to Build split holes to add a 
checkmark. 

27. Ensure that the box next to Use blast hole setting 
under Hole inclination is unchecked. 

28. Enter 10 in the Hole inclination cell. 
29. Enter 1 in the Duplicate design point tolerance cell. 
30. Enter 10 in the Spacing along lines cell. 
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31. Select the Subdrilling tab in the Edit Drill Plan Settings 
window. 

Note:  The Subdrilling tab allows you to define the 
Subdrilling parameters. These include settings to define 
how the subdrilling is calculated, and settings for the 
blast and split hole constants. 

32. Left-click in the box in front of Include split hole 
constant to add a checkmark. 

33. Enter 10 in the Length percentage cell. 
34. Left-click in the box in front of Include split hole 

constant to add a checkmark. 
35. Enter -5 in the Split hole constant (usually negative) 

cell. 

 

36. Select the Quality tab in the Edit Drill Plan Settings 
window. 

Note:  The Quality tab allows you to define the 
tolerances for the diameter and end points of the drill 
holes. 

37. Select Distance in the Method drop-down list under 
Blast Hole End Point Tolerance. 

38. Enter 1 in the 3D distance cell under Blast Hole End 
Point Tolerance. 

39. Enter 1 in the 3D distance cell under Split Hole End 
Point Tolerance.  

40. Select the Estimation tab in the Edit Drill Plan Settings 
window. 

Note:  The Estimation tab allows you to define time, 
cost, and cost factor for the drilling job. The cost factor 
is the amount of down time between the actual drilling. 

41. Enter 90 in the Blast hole rate: (ft/h) cell under 
Average Penetration Rate. 

42. Enter 125 in the Split hole rate: (ft/h) cell under 
Average Penetration Rate. 

43. Enter 250 in the Cost per hour ($) cell under Cost. 
44. Enter 1.25 in the Cost factor cell under Cost. 

45. Select  in the Edit Drill Plan Settings 
window. 
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46. Select   in the Create Drill Plan pane. 
Note:  A box similar to the one shown on the right will 
appear. 

 

47. Select    in the View area under the Drill 
Plan tab. 

Note:  You could also select the  icon in the Quick 
Access Toolbar to create a 3D View. 

Note:  You can see how the split holes were created 
along the reference line, with the blast holes then 
extending to the boundary. 

 

48. Select   in the Drill Plans 
area under the Drill Plan tab. 
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49. Select Reference Line Drill Plan in the Drill plan drop-
down list. 

50. Select Blast in the Hole type drop-down list. 
51. Enter New Holes in the Name cell. 
52. Leave the Display length, Hole diameter (Inch), 

Orientation, and Inclination at their default values. 

Note:  The length hole diameter, orientation, and 
inclination for the drill holes are automatically 
populated by the defaults specified in the settings. 

53. Left-click on Select objects under Method to Add Holes 
to select it. 

Note:  This option bases drill holes on existing points. 
The drill hole's end points will be based on the point's 
coordinates.  

54. With the curser in the Objects cell, left-click on the 
point in the bottom left corner of the boundary in the 
Plan View. 

Note: Each object you pick must have an elevation for 
the drill hole to be created properly. 

55. Select  in the Add Drill Hole to Drill Plan 
pane. 

Note:  The new drill hole named 1 will be visible. If it is 
not, right click on the drill plan in the Project Exporer 
and select Rebuild Drill Plan. 

 

 

56. Select Save Project As under the File tab. 
57. Name the file and select Save. 
58. Select Close under the File tab. 
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Import, create, export, and comparison 
After completing this section, you will be able to: 

• Import a text file containing design hole information 

• Create a manual drill plan 

• Export a drill plan to DPS900 

• Import the as-drilled data from DPS900 

• Generate a drill hole quality report 
This workflow will demonstrate how to import, create, export and compare drill plan data. The 
import/export/comparison tools can also be used with any of the automatic drill plans created in the first section.  

Importing text data 

1. Open Business Center - HCE and start a new project. 

2. Select the template for US Survey Foot. 

3. Select the  icon in the Data area under the Project 
Tab. 

 

4. Left-click on P,N,E,ELV Drill Plan Coordinates.csv in the 
Import pane to highlight it. 

5. Select  in the Import pane. 

Note:  You could also drag and drop the file into the 
graphical view to import the file. 

Note:  The Import Format Editor box will appear because 
this is standard text data. 
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6. Left-click on P,N,E, elev, Code (Unknown) to highlight 
it.  

Note:  The preview area will show how the data will be 
read. 

7. Select  in the Import Format Editor 
window. 

 

8. Left-click on Deliminated next to Type to select it. 

9. Select  in the Import Format Editor 
window. 

 

10. Left-click on the box next to Import as grid only points, 
which can be moved or elevated, but do not transform 
with coordinate system changes to add a checkmark. 

11. Select   in the Import Format Editor 
window. 
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Creating a manual drill plan  

12. Select   in the Save Changes window. 

Note:  This will allow the definition change. 

 

13. Select  in the Project Definition window. 

Note:  There should now be a grid of points visible in the 
graphics window. 

14. Select   in the Import pane. 

15. Left-click on a point to select it. 
16. Right-click in the graphical view and select Properties 

Note: Notice that the elevation is 100.00. 

 

1. Select   in the Drill Plans area under the 
Drill Plan tab.  



Page | 249  
 

2. Enter Manual Drill Plan in the Name cell. 
3. Select Drill Plans in the Defaul Layer for holes drop-

down list. 
4. Select <None> in the Rock surface drop-down list. 

Note: For this example we will assume that this design is 
40ft below the previous bench.  

5. Select   in the Create Manual Drill Plan 
pane. 

 

6. Enter 40 in the Hole length (display only) cell. 

7. Enter 10 in the Minimum hole length cell. 
8. Enter 0 in the Maximum distance above rock cell. 

 

9. Select the Blast Holes tab in the Edit Drill Plan Settings 
window. 

Note:  The Blast Holes tab allows you to define the 
parameters of the blast holes. This includes diameter, 
orientation, inclination, duplicate tolerance, burden, 
spacing and edge tolerance. 

10. Enter 4 in the Hole diameter (Inch) cell. 
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11. Select the Split Holes tab in the Edit Drill Plan Settings 
window. 

Note:  The Split Holes tab allows you to define the 
parameters of the split holes. This includes diameter, 
inclination, duplicate tolerance, and spacing. 

12. Enter 1 in the Duplicate design point tolerance cell. 

 

13. Select the Subdrilling tab in the Edit Drill Plan Settings 
window. 

Note:  The Subdrilling tab allows you to define the 
Subdrilling parameters. These include settings to define 
how the subdrilling is calculated, and settings for the 
blast and split hole constants. 

14. Left-click in the box in front of Include blast hole 
constant to add a checkmark. 

15. Enter 2 in the Blast hole constant cell. 
16. Left-click in the box in front of Include split hole 

constant to add a checkmark. 
17. Enter -1 in the Split hole constant (usually negative) 

cell. 

 

18. Select the Quality tab in the Edit Drill Plan Settings 
window. 

Note:  The Quality tab allows you to define the 
tolerances for the diameter and end points of the drill 
holes. 

19. Enter 1 in the 3D distance cell under Blast Hole End 
Point Tolerance. 

20. Enter 1 in the 3D distance cell under Split Hole End 
Point Tolerance. 
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21. Select the Estimation tab in the Edit Drill Plan Settings 
window. 

Note:  The Estimation tab allows you to define time, 
cost, and cost factor for the drilling job. The cost factor 
is the amount of down time between the actual drilling. 

22. Enter 75 in the Blast hole rate: (ft/h) cell under 
Average Penetration Rate. 

23. Enter 100 in the Split hole rate: (ft/h) cell under 
Average Penetration Rate. 

24. Enter 275 in the Cost per hour ($) cell under Cost. 
25. Enter 1.2 in the Cost factor cell under Cost. 

26. Select  in the Edit Drill Plan Settings 
window.  

27. Select   in the Create Manual Drill Plan 
pane. 

 

28. Enter Drill Hole in the Name cell. 
29. Left-click on Select Objects under Method to Add Holes 

to select it. 
30. With the curser in the Objects cell, select all the points 

in the plan view. 

Note:  You can select all the points by drawing a box 
around them. 

31. Select  in the Add Drill Hole to Drill Plan 
pane. 

Note: The manual drill plans are created in two stages.  
The first stage is creating the empty “placeholder” for 
the drill plan, and then the opjects are added to the drill 
plan.  

Note:  Notice that the hole settings entered in the 
previous section have been carried though to this dialog.  

32. Select  in the Add Drill Hole to Drill Plan 
pane. 
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33. Select    in the View area under the Drill 
Plan tab. 

Note:  You could also select the  icon in the Quick 
Access Toolbar to create a 3D View. 

 

 

34. In the 3D view rotate the view until the drill holes look 
like this. 

35. Select the top row of holes. 

Note:  You can do this by dragging a box around them. 

36. Right-click in the graphical view and select properties. 

Note:  You will notice that the drill hole properties are 
not visible. 

 

37. Left-click the drop down next to All (10) and select Drill 
Hole.  

38. Select Split in the Hole type drop-down list. 

39. Select  in the Properties pane. 
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Exporting a drill plan to DPS900  

40. Pan and zoom in the 3D view. 

Note:  See how the row of split holes now end 7ft above 
the blast holes. 

Note: The reason they appear to extend upwards more 
is that there is no rock surface to intersect with and the 
display length has been set to 40ft. 

 
 

 

1. Expand Drill Plans in the Project Explore pane and left-
click on Manaual Drill Plan to highlight it. 

2. Select    in the Data area under the Drill Plan tab. 
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Carrying out a quality report  

3. Left-click on the Construction tab in the Export pane. 
4. Left-click on DPS Drill Plan Exporter to highlight it. 
5. Select Manual Drill Plan in the Drill Plan drop-down 

list. 
6. Ensure the box to Export all planned holes is checked. 

7. Enter Manual Drill Plan in the File Name cell.  

Note:  Selecting the   icon lets you choose which 
folder to save to. 

8. Select   in the Export pane. 

9. Select Save Project As under the File tab. 

10. Name the file and select Save. 
11. Select Close under the File tab. 
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1. Open Business Center - HCE and start a new project.   
2. Select the template for US Survey Foot. 

3. Select the  icon in the Data area under the Project 
Tab. 

Note: You can also select the Import  icon from the 
Quick Access Toolbar. 

4. Left-click on the Manual Drill Plan.vcl  file to highlight it 

and select . 

Note: You may have to use the   button to select the 
folder where the Manual Drill Plan.vcl file is saved on 
your PC. 

Note:  This is the drill plan that was exported in the 
previous exercise. 

5. Left-click on the Manual Drill Plan.quality.xml  file to 

highlight it and select . 

Note: You may have to use the   button to select the 
folder where the Manual Drill Plan.quality.xml file is 
saved on your PC. 

Note:  This is the as drilled data, which is created in by 
the DPS900. 

6. Select   in the Import pane. 

 

7. Select    in the View area under the Drill 
Plan tab. 

Note:  You could also select the  icon in the Quick 
Access Toolbar to create a 3D View. 

Note:  The design data is shown in dark blue and the as 
drilled is shown in light blue by default. To change these 
colors go to the Project Tab and click on Project Settings. 
The drill plan color settings can be found under 
Computations and Drill Plan. 

Note: This is also where the default settings for each drill 
plan can be changed. 
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8. Select  in the Drill Plan Reports area 
under the Drill Plan tab.  

9. Select Manaul Drill Plan in the Drill plan drop-down 
list. 

10. Select All holes in the As-drilled holes to include drop-
down list. 

 

11. Select  in the Drill Hole Quality Report 
pane.  

Note:  This will generate a Microsoft Excel report. 
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12. Left-click on the Hole Data tab. 
Note:  This will show the information for the individual holes.  It also includes the Pass/Fail based on the drill 
plans quality settings, the planned hole information, the as drilled hole information, the delta values 
between the two, and the error vector. 
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Piling  

Welcome 
Welcome to the Trimble® Business Center – Heavy Construction Edition (HCE) Pile Plan module.  The Pile Plan 
module in Business Center - HCE incorporates tools and commands to prepare pile plans for piling machines that 
are running Trimble® DPS900 Drilling and Piling System (“DPS900”).  .   
This guide was developed by Trimble Navigation’s Global Services Training and Support staff to support classroom 
instruction delivered by a Trimble Certified Trainer.  The Trimble Certified Trainer will use this guide to lead you 
through the Pile Plan module using real world exercises.  Please use this guide in conjunction with the Business 
Center- HCE help files and other product resources available. 

Overview 
Pile planning in Business Center - HCE enables you to create a variety of pile plans to send to DPS900, a Trimble 
drilling and piling system for road construction and pit mining. The pile plan helps the DPS900 machine operator 
navigate to piles (nearest, previous, next, or selected), and then guides him in piling the holes at the planned 
orientation, inclination, and depth. 
The commands available in the Pile Plan module can be divided into three categories: Pile Plans, Data Export, and 
Pile Reporting. 
You will start by defining a pile type, and a pile plan will be created from imported point data.  The pile plan will 
then be edited and exported to a machine running DPS900.  After the piling has been carried out a pile plan 
quality file can be imported back into Business Center – HCE, and a piling quality report can then be generated. 

Learning Objectives 
• Create a pile type 

• Create a pile plan  

• Create a single pile to add to the pile plan 

• Create piles from imported points to add to the pile plan 

• Edit the names of created piles 

• Export the data to DPS900 

• Generate a piling quality report 

Pile Plan Definitions 
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Manage Pile Types - Use the Manage Pile Types command to create, edit, and delete various types of piles. These 
types can then be applied to specific piles when you create pile plans.  
Create a Pile Plan - Use the Create Pile Plan command to create an empty pile plan to which you can add piles in 
preparation for sending the plan to a piling machine running DPS900. The pile plan shows the DPS operator what 
type of pile to load, and where and how to embed it. 
Create a Pile - After you have created pile types and a pile plan, use the Create Pile command to create individual 
piles for the plan.  
Create Piles at Points - Use the Create Piles at Points command to quickly create piles at the locations of imported 
points. 
Rename Piles - Use the Change Pile ID command to change the names of individual piles based on text labels. 
Export Pile Plan Files - Use the DPS Pile Plan exporter (.vcl) to create a pile plan file for use on piling machines 
running DPS900.  
Import Pile Plan Results Files - Import pile plan results files (.xml) to bring as-built pile data in from a piling 
machine running DPS900 in the field. Then you can run a Blow Count Report and/or a Piling Quality Report. 
Run a Blow Count Report - Use the Blow Count Report command to report on the number of hammer blows 
(blow count) that were required to embed each as-built pile (in a pile plan) to its required embedment. Knowing 
the blow count for each embedded pile is crucial for assuring the quality of the as-built piles. 
Run a Piling Quality Report - Use the Piling Quality Report command to see a summary and details on pairs of 
piles.  The holes in a pile plan are compared to their corresponding as-built piles. Each as-built pile that is reported 
is qualified as passing, failing, or requiring action (based on the tolerances in Project Settings). The Piling Quality 
Report is generated as a Microsoft® Excel spreadsheet.  
Rebuild a Pile Plan - Use the Rebuild Pile Plan command to update a pile plan after it has been changed in the field 
(e.g., you have deleted piles, such as a spliced pile) or if you imported as-built pile results prior to importing a pile 
plan. 

Files Needed 
For the training exercises, each user should save the following files provided by your Certified Trainer onto their 
PC and note the location. 

• Pile Plan.csv 

• As Built Piles.zip or As Built Piles “folder”  

Creating a Pile Type 
This project is an example of a solar farm piling job and the types of piles you can create are based on parameters 
for these cross-sectional shapes:  
 Cylinder 
 Sheet 
 H 
 I 
 Square 
 Rectangle 
 Custom (solid) 
 Custom (hollow/open) 
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1. Open Business Center - HCE and start a new project.   

2. Select the template for US Survey Foot. 

3. Select   in the Piling Plans area under the Pile 
Plan tab.  

 

4. Select  in the Manage Pile Types pane. 
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5. Enter H Pile in the Name cell. 
6. Enter 13.450’ in the Pile length cell. 
7. Enter Steel in the Material name cell. 
8. Select Elevation from the Piling method drop-down 

list. 

Note:  The available piling types are:  

Friction - Select this if the pile type is to be embedded 
where there is no rock strata to stop the pile from 
deeper embedment. 'Friction piles' are counted in the 
Blow Count Report. 

End-point - Select this if the pile type is to be embedded 
where there is rock strata that will stop the pile from 
deeper embedment. 

Elevation - Select this if the pile type is to be embedded 
until it reaches a certain depth (such as in solar farm 
where panels are to be attached to the top of the piles 
at a consistent elevation). Only 'elevation piles' use the 
3D positional tolerance specified in Project Settings > 
Computations > Piling and reported in the Piling Quality 
Report. 

9. Enter 5’ in the Expected length cell under Embedment. 
10. Enter 2’ in the Minimum length cell under Embedment. 

Note:  The diagram on the right shows what 
measurements Business Center is looking for in the edit 
pile type dialog, where: 

1. Pile length 

2. Expected embedment length 

3. Valid embedment 

4. Minimum embedment length 

5. Cut-off length 
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11. Select H from the Cross-section type drop-down list. 

Note:  The shape section allows you to define the cross 
sectional parameters of the pile type. More details on 
how these are defined for more complex pile types can 
be found in the Business Center – HCE help files. 

12. Enter 5.8 in the Width (Inch) cell under Shape. 
13. Enter 3.8 in the Height (Inch) cell under Shape. 
14. Leave the Target blows cell and Interval distance cell at 

defaults under Blow Count Requirements. 

Note:  In this exercise we are using elevation piles and 
the Blow Count Requirements information is not used.  

15. Enter 600 in the Pile penetration rate (ft/h) cell under 
Estimation Factors. 

16. Enter 25 in the Charge out rate ($/ft) cell under 
Estimation Factors. 

17. Enter 75 in the Machine cost ($/h) cell under 
Estimation Factors. 

18. Enter 5 in the Fuel cost ($/h) cell under Estimation 
Factors. 

19. Enter 30 in the Operator cost ($/h) cell under 
Estimation Factors. 

20. Enter .02 in the Navigation time per pile (h) cell under 
Estimation Factors. 

21. Enter 1.2 in the Efficiency factor cell under Estimation 
Factors. 

Note:  The Estimation Factors parameters are used to 
set up estimating for the site. Here you can set the rates, 
times, and costs for the piling job. There is also an 
efficiency factor, which is used to account for machine 
downtime.  

Note: The estimation factors shown here give a rough 
indication of costs to demonstrate how Business Center 
– HCE calculates estimations and are not necessarily 
representative of real world values. 

22. Select  in the Edit Pile Type pane. 

23. Select  in the Manage Pile Types pane. 
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Creating a Pile Plan 
In this exercise, we will create an empty pile plan to contain our piles, which we will create in the second part of 
this exercise. 

Creating piles from points 
Now we will add piles to the pile plan 

1. Select  in the Piling Plans area under the Pile Plan 
tab. 

 

2. Enter Pile Plan in the Plan name cell. 
3. Select <<New Layer>> in the Layer drop-down list. 
4. Enter Pile Plan in the Layer name cell in the New Layer 

window. 

5. Select  in the New Layer window. 
6. Leave the Inclimation tolerance cell, 2D positional 

tolerance cell, and the 3D positional tolerance cell at 
defaults under Quality Tolerances. 

7. Select  in the Create Pile Plan pane. 

 

1. Select  in the Data area under the Project tab. 

2. Left-click on the Pile Plan.csv file to highlight it select. 

Note: You may have to use the   button to select the 
folder where the Office Park.pdf file is saved on your PC. 

3. Select  in the Import pane. 
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4. Left-click on the P,N,E,elev, code (unknown) to select it 
under Definition Name in the Import Format Editor 
window. 

5. Select  in the Import Format Editor 
window. 

 

6. Enter 0 in both the False northing cell and the False 
easting cells in the Project Definition window. 

7. Select   in the Projection Definition 
window. 

8. Select   in the Import pane. 

 

9. Select  in the Piling Plans area under the Pile Plan 
tab.  

10. Select Pile Plan in the Pile plan cell. 

Note:  If you want to add a manufacturer ID or 
comment, these can be added.  

11. Enter 90 in the Axial rotation (spin) cell. 

Note:  This specifies the angle to which the pile should 
be turned on its vertical axis. Positive rotation is 
clockwise and 0 is due east. For the pile's inclination, 
specify an Orientation angle and an Inclination angle. 

12. Ensure that there is not a checkmark in the box in front 
of the Use Pre-bore Definition. 
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13. Select all the imported points. 

Note:  This can be done by either doing a window select 
or by clicking on the options and choosing select all.  

14. Select H Pile from the Pile type drop-down list. 
15. Select Do not create a pile under Duplicate Point 

Names. 
16. Select Do not create a pile under Missing Cut-off 

Elevation. 

17. Select  in the Create Piles at Points pane. 

 

18. Select  in the Create Piles at Points pane. 

Note:  The upper left pile has not been created. This is 
because that point had no elevation and was skipped 
due to the settings we chose in the create piles from 
points dialog. In the next exercise we will add this pile 
manually. 
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Creating individual piles 

Exporting to DPS900 
At this stage in the tutorial you have created a pile type, created a pile plan placeholder, imported points, created 
piles at these points, and manually created the missing pile. 

1. Select   in the Piling Plans area under the Pile Plan 
tab. 
 

 

2. Enter 90 in the Axial rotation (spin) cell under Pile 
Orientation. 

Note:  You will notice that the first part of the dialog 
looks the same as for the Create Piles at Points 
command. 

3. Enter 9437 in the Pile ID cell. 

Note:  In this example, we do not have CAD text to use 
to automatically label the Pile ID, so we had to type 
9437 into the Pile ID cell. 

4. With the curser in the Origin cell under Location, left-
click on the point without a pile in the upper left 
corner of the pile plan.  

5. Enter 202.610 in the Cut-off elevation cell under 
Location. 

6. Select   in the Create Pile pane. 

Note: These values came from the original .csv which 
was altered to demonstrate the manual pile creation 
tool. The elevation and pile ID would normally need to 
be found from plans. 

7. Select   in the Create Pile pane. 
 

1. Select    in the View area under the Pile 
Plan tab. 

Note:  You could also select the  icon in the Quick 
Access Toolbar to create a 3D View. 

Note:  You can zoom, pan, and rotate to view the 
created piles.  
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2. Select   in the Data area under the Pile Plan tab. 
3. Select the Construction tab under File Format. 

4. Left-click on DPS Pile Plan exporter to highlight it. 
5. Select Pile Plan in the Pile plan drop-down list. 
6. Ensure that there is a Checkmark in the box for Export 

all planned piles. 

Note:  If you only wanted to export some of the piles, 
you would uncheck this box and select the piles 
manually in the graphics window. 

7. Enter Pile Plan in the File Name cell. 

8. Select  in the Export pane. 

Note:  This will bring up a Save As window. 

9. Select the location you would like to save the file and 

select  . 

Note:  You can save it to your folder with the training 
data for the Piling Chapter. 

10. Select  in the Export pane, to export the 
pile plan to DPS900. 

11. Select File and select Save Project As. 
12. Name your file and select save. 
13. Select File and select Close. 
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Compare As Built 
For this exercise, we will import the as built piling data from DPS900 to compare it to our pile plan. 

1. Open Business Center - HCE and start a new project.   
2. Select the template for US Survey Foot. 

3. Select  in the Data area under the Project tab.  
4. Highlight the Pile Plan.vcl file created in the previous 

exercise and select . 

Note: You may have to use the   button to select the 
folder where the Office Park.pdf file is saved on your PC  

Note:  You can also import the file by dragging and 
dropping it into the graphics window. 

5. Select  in the Import pane. 

6. Select  in the Import pane. 

 

7. Using Windows Explorer open the folder called As Built 
Piles. 

Note:  This is one of the provided files.  If it was provided 
in a .zip format you will have to extract the file first. 

Note:  In this folder is the as built information for each of 
the 72 piles stored as .xml files. 

8. Use the Windows hotkey Ctrl+A to select all the .xml 
files. 

9. Drag and drop the select files into the Business Center 
– HCE graphical view. 

Note:  The import bar will flash for each file that is 
imported. Once the import is complete, the as built 
piling data will be overlaid onto the pile plan. 
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10. Select    in the View area under the Pile 
Plan tab. 

Note:  You could also select the  icon in the Quick 
Access Toolbar to create a 3D View. 

11. Zoom and Pan into some of the piles to visually inspect 
them. 

 

12. Select   in the Report area under the Pile Plan 
tab. 

 

13. Leave the Reference baseline cell blank. 
14. Ensure that both Restrict to selected piles and Override 

project settings do not have checkmarks in their boxes.  

15. Select   in the Piling Quality Report pane. 

Note:  This will generate a Microsoft Excel based report 
and will launch Excel where it will be possible to view the 
report.  

Note:  The report has tabs for Summary, Estimation 
Properties, Pile Types, and Quality Metrics.  

 
 

16. Select the Quality Metrics tab in Excel. 

Note:  The Pass and Fails are color coded to easily see. 

Note: In this tutorial we have used elevation piling data, 
so we cannot run a Blow Count Report. However, in a 
project with .xml data from a friction piling job the 
procedure for running the Blow Count Report is the 
same as for the Piling quality Report. More information 
on the Blow Count Report can be found in the Business 
Center help files. 

 



CERTIFICATION SERVICES 
GLOBAL SERVICES 

This document is for informational purposes only and is not a legally binding agreement or offer.  
Trimble makes no warranties and assumes no obligations or liabilities hereunder. 

Trimble Navigation Limited, Global Services Business Area, 10368 Westmoor Drive, Westminster, CO 80021, USA 

© 2016, Trimble Navigation Limited. All rights reserved. Trimble, the Globe & Triangle logo are trademarks of Trimble Navigation Limited, registered in the 
United States and in other countries. All other trademarks are the property of their respective owners. 

 

www.trimble.com   Page 1 

 

Business Center-HCE v3.22 User Exam 
Congratulations!  You have successfully completed the Business Center-HCE class. To test your class knowledge, 
enroll into the Business Center-HCE v3.22 User Exam on Learn.Trimble.com today! 

Steps to Enroll 
Go to LEARN.TRIMBLE.COM and log in: 

 
 
Click ‘Create an account’, then after creating and verifying your new account, log in: 

 
 
Select your Trimble Relationship as ‘Customer’ and check at a minimum the ‘Civil and Site Construction and 
Engineering Customer’ Industry to complete your account: 

http://www.trimble.com/
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Enter the provided subscription code and CONFIRM for a quick enrollment:  acBEoFT1a9L 

 

 
 

To Start the Exam 
Click on the Business Center-HCE v3.22 User Exam to start: 
Note: If exam does not appear at first, refresh the page 

 
 
You will have 90 minutes to take the exam and can review your answers once completed.  Good luck! 

http://www.trimble.com/
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